


■■ editorial

Who cares about Moore’s Law anymore? Members of the GigaHertz
club are hard pressed to justify an upgrade based on processor speed
alone. Gaming you say? Already you can get on your desktop,

enough muscle to render the movie Toy Story in real-time—a task that took the
original creators weeks of hard, painstaking work. What game can do better
than movie quality? There will always be some applications to squeeze the last
bit of processing power they can get. But are there any for you? The switch
from 8 to 16-bit, and 16 to 32-bit happened so quickly, you simply couldn’t
buy future proof hardware. There are still no takers for the 64-bit Itanium.

Things couldn’t be better for the computer industry. 
Raw power does not cut it any more. Computers must sell on how well the

software they support can serve your needs. After the straight charge to speed,
it is now time to refocus on where else computers can go, and what else they
can do. 

Down this road lies tremendous opportunity. What could you do with a
computer that runs solely on ambient light? How about tiny computers with
human-size interface devices? How about computers as cheap as ballpoint
pens? All of this is happening already. The path to growth is not a straight
climb up the charts of processor speeds, but the breadth of variety in applica-
tions and availability.

The drive to lower costs for great hardware is clearly successful. The aver-
age cost for a decent PC has fallen from Rs 40,000 to near the Rs 20,000 mark.
A ‘computer for the masses’ must cost less than Rs 5,000. We are getting there.

The transition from the mind-set of big, powerful hardware to computers
that are ‘good enough’, go everywhere you need them and do things you want,
is an inflection point manufacturers must cross. Those that do, will win big.
The recent launch of multiple new low-power processors proves that some
companies are sitting up and paying attention. 

The confluence of ‘good enough’ processing with low cost, compact com-
puting in recent times brought us the PDA and the portable MP3 player. It’s not
risking much to predict the next big thing will not be the launch of a new
processor, or a fancy new graphics card-it will be something that brings a new
level of convenience at an affordable price point. 

In the meanwhile, let us rejoice in the relentless progress of power.

Sumod_hajela@jasubhai.com

“The transition
from the mind-set
of big, powerful
hardware to
computers that
are ‘good enough’,
go everywhere
you need them
and do things you
want, is an
inflection point
manufacturers
must cross.”

A Shift in Power

Sumod Hajela
Assistant Editor
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BackUp MyPC 4.85
Size: 8.04 MB Type: Trial
Mindware\Software\System

Casino Inc
Size:  114 MB Type: Trial 
Playware\Arena\Games

Frzzic’s Revenge
Size: 5.56 MB Type: Trial 
Playware \Arena\Funzone\

3D Ground Zero
Size: 7.53 MB Type: Free
Playware \Arena\Funzone\

Optimal Desktop Pro 2.106
Size 7.67 MB Type: Trial
Mindware\Software\Home

Pro Race Driver
Size: 92.5 MB Type: Trial 
Playware\Arena\Games 

602Pro PC SUITE 2001
Size: 16.2 MB Type: Trial
Mindware\Software\Office

SoftwareShield System 1.6.4
Size: 4.40 MB Type: Trial
Mindware\Software\ DeveloperTools

Steganos Internet Privacy 2.12
Size: 5.22 MB Type: Free
Mindware\Software\Internet

VCDEasy 1.1.5
Size: 9.6  MB Type: Free
Mindware\Software\Multimedia

ViaPrint Professional 4.0
Size: 7.16 MB Type: Trial
Mindware\Software\Office

HIGHLIGHTS

Rainbow Six 3:
Raven Shield Single Player
Command an elite, multinational squad
of special operatives against a hidden 
terrorist foe. Rainbow, the secretive
counter-terrorist organisation races
against time to
stop terror and
unravel a mystery.
In locations
around the world,
from London to
the Caribbean
Islands, lead Team Rainbow in a desper-
ate effort to battle a madman and foil his
doomsday plot. Boasting of top of the
line graphics technology provided by the
next-generation Unreal engine. Get ready
to storm your way through 15 tough sin-
gle-player missions that include the dis-
covery of a cache of biological weapons
and stopping an armed gang from terror-
izing a London bank.

Size: 223 MB Type: Trial
Playware\Arena\Games

StudioLine Photo Edition
Basic 1.1.5
Use StudioLine Photo Edition Basic to
manage up to 200 images in its ingenious
archive. StudioLine Photo Edition sup-
ports all popular file formats, and lets you
share picture thumbnails by e-mail.
StudioLine allows you to edit images with

several built-in fil-
ters and print
images in preset
standard sizes and
also lets you create
uploadable Web
galleries on a built-
in template.

Size: 26.29  MB
Type: Free
Mindware\Software\Multimedia

Ulead VideoStudio 7
Ulead VideoStudio is a full-featured 
program with a broad range of tools. It
allows you to capture
DVD-ready MPEG video
from DV/D8/Hi8 cam-
corders, VCRs, PC cam-
eras, and TV tuner
cards. You have the
option to split captured
video scenes into sepa-
rate files. Ulead’s real-time editing features
include built-in scene to scene transitions,
30 customizable filters, and motion 
paths for animating text, as well as voice
narration and adding in custom music!

Here is another bonus: we have 
also included the Ulead VideoStudio 7’s 
official video tutorials on the CD!

Size: 76 MB Type: Trial
Mindware\Software\Multimedia

ON THE CD

8

The Resolve section on
the Digit Mindware CD
brings you some very
interesting reading with
Whitepapers, Tips and
Tricks and FAQs. The
Whitepapers section
brings you a selection of
whitepapers on a subject
of interest along with a short description of
each whitepaper. This month we feature
five whitepapers on Quantum Computing,

and the various disciplines
within the field. 
This month, the Tips and
Tricks section contains 
several tips to get your
home network running
smoothly. In tune with 
the cell phones test, the
FAQs section deals with the

commonly asked questions on cell phones. 
This is one section you just have to
browse—it’s all about food for thought!

KNOW YOUR CD

MUST TRY SOFTWARE

MINDWARE\RESOLVE
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You get to choose what goes on Digit Interactive. 
This month you have chosen:

Nascar 2003 
Size: 119 MB
Playware

MyAlbum
1.94 MB 
Mindware 

Want to subscribe to Digit? Or is it 
time to renew your subscription? You
can now subscribe online! 

To Stop A Thief 
Content companies
struggle to safeguard
their content even as
crackers find new
methods of defeating
them. In the end, it’s the
consumer who pays for
products that don’t work

WEB SPECIAL SUBSCRIBE

WEB SPECIAL

taste technology at www.thinkdigit.com

BY DEMAND
gt rdy fr MMS  
It’s more than what you
have seen on a pixellated
monochrome screen—
here comes the colourful
world of MMS, full of
pictures, audio and
video…all on your mobile
device and handheld! 

▼▼
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Intersil Corporation, design-
er and manufacturer of high

performance analog and wire-
less networking solutions,
announced a new WLAN
software solution that
improves 802.11g throughput
by over 300 per cent. “PRISM
Nitro provides up to 50 per
cent greater throughput per-
formance in homogenous
802.11g networks,” said Larry
Ciaccia, vice president and
general manager for Intersil's
Wireless Networking Products
Group. This makes it an ideal
solution for applications, such
as CD-quality audio and DVD-
quality video streaming.

Initial testing indicated up
to a 3x performance improve-
ment in 'worst-case' wireless
networking systems. Such sys-
tems would be made up of
predominantly 802.11b
clients and access points with
just a few 802.11g nodes.

The technology is a
firmware upgrade that will 
be distributed through a driv-
er suite.
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Philips iPronto Digital
Home Controller

■ What is it?
The iPronto is designed 
to control your home 
entertainment systems,
lighting, climate control and
more, through one common
interface. 

■ How does it work?
It comes with an Intel
PXA250 XScale embedded
processor, runs Linux and
has a 6.4-inch touch screen
LCD interface. The Tao Java
Virtual Machine provides a
secure environment for exe-
cuting applications. It also
comes with an infrared
interface for traditional
remote controllers, and
implements Wi-Fi  (802.11b)
connectivity and even an
Ethernet port. If that's not
enough, there is also a USB
port as well as an MMC/SD
card slot for connecting to
other devices.

■ What does it do?
The interactive user interface
lets you view electronic
program guides, select
media sources as well as surf
the Net and access e-mail.
The device has a built in
microphone and speakers
that should let you listen to
MP3s streamed over the
Internet. With a readily
upgradeable internal soft-
ware suite, the device can
work with just about every-
thing in the near future, 
from interfacing with digital
cameras to automotive 
applications.

hypethesis

■ Phoenix, the open source browser rechristened Firebird to avoid a trademark dispute ■  ABTO figures show Reliance Info close to mobile million

Making things better

The shares of Apple Com-
puter fell by

almost 9 per cent
after the Los Angeles
Times reported that
the company is con-
sidering buying the
world’s largest record
company, Universal
Music Group. Uni-
versal is pegged to
garner at least 6 bil-
lion dollars, accord-
ing to analysts. Such an out-
flow of cash from the coffers of
Apple, and the fact that they
are likely to test uncertain

waters, led to the tumble of
share prices.

Digital entertain-
ment forms the pivot
to Apple’s strategy, as
they introduce digi-
tal lifestyle products,
such as the popular
iPod that stores
thousands of songs.

Apple CEO Steve
Jobs said, “Apple has
never made any offer to

invest in or acquire a major
music company. We will abide
by Apple’s policy of not com-
menting on rumours.”

Scientists at Microsoft’s
research labs are busy cook-

ing up new tech-
niques that will
make data easier to
handle. Fast paced
technology and
the Internet are
leaving vast repos-
itories of unused
data in their wake.
Researchers have
come up with search
tools, better Web search
techniques and user
interfaces that will
make finding rele-
vant information easier.

A prototype application
called Stuff I’ve Seen, is built
to store all the data that has
appeared on a computer ter-
minal. Another one called
Ask MSR lets you pose ques-
tions in a natural form such
as, “What are the symptoms
of SARS?”.

All this is aimed at offering
the user an alternative to the

hierarchical means with
which data is currently

stored. New techniques
try to make accessing

your data much easier. To
find your holiday snaps,

you could search for
images with a trop-
ical background,
instead of using
filenames.

The company
is also working on

new types of
user inter-

faces. In GWindows, one can
scroll through files or move
windows though a combina-
tion of voice commands and
hand gestures. Motion track-
ing technology will eliminate
the need for special gloves. A
wrist-twisting motion could
one day adjust the volume on
your favourite media player.

Rumours bite into Apple

Sans wires 
and faster

Over 950 mil-
lion messages 
are sent over NTT-
DoCo
Mo’s mobile e-mail
service daily. Close to
80% are 
unsolicited

snapshot

Steve Jobs, CEO,
Apple Computer 

Source: NTT-DoCoMo

ILLUSTRATIONS: Farzana Cooper

➜
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Flaws in media
players 
Two popular media players,
the RealOne player and
QuickTime player have seri-
ous security flaws that put
millions of users at risk. 
The security hole, in RealNet-
work’s media players, can be
caused by a specifically cor-
rupted PNG (Portable Net-
work Graphics) file. A suc-
cessful exploit could let a
hacker execute arbitrary code
on a user’s machine. Updates
for the players are available
at www.real.com.
The Apple QuickTime media
player has an unrelated secu-
rity flaw. If users happen to
load a specially created
exploit URL, remote hackers
could execute arbitrary code
on their machines. Apple has
recommended that all users
upgrade to version 6.1, avail-
able at http://www.apple.
com/quicktime/download/

IRC Backdoor
There is a new Backdoor Tro-
jan in town called Backdoor.
Sdbot.H. Once infected, it
allows a hacker to remote
control a computer by using
Internet Relay Chat (IRC).
The existence of the file
I3Explorer.exe is an indica-
tion of a possible infection.
The Trojan auto-updates
itself, adds several entries to
the system Registry and
infects the System directory
files. All versions of Windows
are at risk of getting infected
with it. It can spread through
IRC and e-mail. Users are
strongly advised to update
their anti-virus definitions
and block suspicious attach-
ments. Symantec has provid-
ed an advisory page at
http://www.symantec.com/av
center/venc/data/backdoor.sd
bot.h.html

redalert

■ The early reports about SARS came from Internet discussions ■  Electronic Arts to promote Nvidia products

Sina.com, a popular Web site
in China, has joined about

200 Internet portals to form a
search engine alliance that
seeks to challenge global giants
such as Google. The search
engine is developed by the
China Internet Information
Centre and a Chinese firm
called Sinobet. It links to a
database of more than 30,000
mainland portals.

Of late, China has been
blocking access to popular sites

such as Google and
AltaVista, which has
led to the demand
for reliable search
engines. Sina hopes
that more than
60 per cent of
users will use its
search engine,
compared with 10
per cent now. The search
engine is free for Internet
surfers, but firms need to pay
to be linked to the database.

The alliance denied being part
of a government
move to replace
Google, even as
it hoped to
achieve a 20 per
cent market
share in the
m a i n l a n d  

this year. A representative said 
the timing of Google’s access
problems and the launch 
of the search alliance was 
a coincidence.

Apopulace jittery over the
SARS (Severe Acute Respi-

ratory Syndrome) outbreak in
Hong Kong can find some
solace in an unlikely source. A
mobile operator has launched
a location-sensitive service
that will alert subscribers near
buildings struck by the dead-
ly flu virus. Those opting for
the service will have their
phones tracked, and will be

told by SMS which buildings
within a kilometer of their
location have had SARS  cases
occur. The managing director
of Sunday Communications,
the company offering the
service, claims that sub-
scribers can get the peace of
mind needed to resume their
everyday lives.

Users can dial a number to
access the information posted

by the Department of Health
and then choose to subscribe
to the SARS location alerts.

Sunday will also donate
mobile services to SARS
patients. The company is one
of six mobile operators 
fighting for a slice of the cel-
lular pie in a competitive
market with one the highest
mobile penetration rates in
the world.

Dial-a-flu

statattack India matters

SAP, Germany-based soft-
ware company reportedly

plans to spend $120 million
over the next 3 years on grow-
ing its business in India. This
bands the company along
with several high-profile tech-
nology companies that plan
to, or already have, 
set up operations here. 
The company plans to direct
the funds primarily toward
marketing and sales initia-
tives, with the intention of
tripling business in India over
the next three years. SAP has
a software development cen-
tre that employs more than
500 people. The company is
in the process of moving 
to a 15-acre campus 
that can house up 
to 1,000 people.
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Big portal in bigger China

Source: Palisade Systems

Source: Pew Internet & American Life Project
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The infamous Iraqi infor-
mation minister,

Muhammed Saeed al-Sahaf
has carved a niche in the
hearts of many an Internet
surfer. A Web
site called We
Love the Iraqi
Information
Minister, has
become an
Internet phe-
n o m e n o n .
O n e - l i n e r s
uttered by al-
Sahhaf, such
as “My feelings—as usual—we
will slaughter them all”, “I
speak better English than this
villain Bush”, and delectable
spins such as “The authority
of the civil defence, issued a
warning to the civilian popu-

lation not to pick up any of
those pencils because they are
booby traps, ...they have start-
ed throwing those pencils, but
they are not pencils, they are

booby traps to
kill the chil-
dren”, have
guaranteed a
place in histo-
ry for the Min-
ister. Within
one hour of
the launch of
the Web site, it
was getting

1,000 visits per second
(www.welovetheiraqiminis-
ter.com). This number grew to
4,000 per second within days
of the launch, forcing the
team to move to a bigger serv-
er to cope with the traffic.

heroes

P2P 
In a further clampdown of
P2P networks on university
campuses across the U.S, the
RIAA has just filed lawsuits
against four university
students for setting up P2P
networks across three college
campuses. The RIAA is
pressing for damages that
could come to $150,000 per
infringed song. Since late
last year, the RIAA has been
targeting university based
file swaping networks in an
effort to curb copyright
violations.

SONICblue
Faced with bankruptcy after
the agreement with Japan’s
D&M Holdings fell through,
SONICblue, the maker of
acclaimed products such as
the ReplayTV and Rio MP3
players is now going to be
auctioned off by a
bankruptcy court.

zeroes

A star is born

Samsung Electronics
expects its new MP3 play-

er—the Yepp YP-55—to grab
the domestic Korean
youth market. The
new products are
available with
either 128 MB or
256 MB built in
onboard memory.
Though very small,
they feature SRS
Lab’s WOW, MP3
encoding, FM radio
and sound record-
ing capability. In a
strategic tie-up with
SRS, this is the first
flash memory MP3
player that supports
WOW, which offers
greatly enhanced
bass tones and 3D
sound. SRS Lab’s WOW
surround sound simulator,
processes stereo channels to
give the sound a more
immersive, 3D feel.

The direct MP3 encoding

allows music from various
sources—CD players, cassette
tape players or FM radio—to

be directly stored as MP3
files, without having

to connect the MP3
player with a per-
sonal computer.
The player can
operate on a single
AAA battery for up
to 15 hours; the FM
radio can select 20 
different channels,
and an auto-search
function is includ-
ed. The YP-55 is
expected to retail
for $ 172 for the
128 MB version and
$ 205 for the 
256 MB version.

The Korean market
for flash MP3 players is

estimated to be around
400,000 units in 2003, and
Samsung Electronics expects
to grab at least a 50 per cent
market share.

Yepp, it’s cool

■ 12 Taiwanese companies pool silicon know-how to boost the country's chip competitiveness 

BSNL
The Kolkata telephone service
system—Bharat Sanchar
Nigam Limited (BSNL)—has
just started an ‘Always On’
Internet access system
through their extensive phone
network. Christened as the
Direct Internet Access Service
(DIAS), this service offers a
128 Kbps connection at rela-
tively affordable rates.

Online Banking Cus-
tomers
Customers have never had it
so good, with banks offering
sops when customers choose
to pay their bills online,
instead of writing checks. Cus-
tomers who choose to clear
bills through the Internet
stand to win massive rebates
and bonuses such as entering
the sweepstakes to win sports
utility vehicles.

Iraqi information minister

Muhammed Saeed al-Sahaf

In an effort to let local
propaganda trickle

through to the Chinese peo-
ple, the US. government’s
Voice of America broadcasts
has commissioned creation
of software that will let peo-
ple circumvent the firewalls
thrown up by the Chinese
government. The software
enables PC users running
Microsoft’s Windows XP or
2000 operating systems to
tunnel through firewalls. 

The idea behind the soft-
ware is to allow evasion of
firewalls through a third-
party computer. The soft-
ware, which uses Secure
Sockets Layer (SSL), lets the
person who installs it, set up
a miniature Web site
through which a firewall-
restricted surfer can access
the rest of the Web.

In addition to circum-
venting firewalls, the soft-
ware also creates anonymity
by covering the Web surfer’s
tracks and leaving no record
of what sites he or she visit-
ed beyond the miniature
Web site.

However, such software
can also be used by under-
aged kids and other sections
of society to gain access 
to information that is 
otherwise restricted. 

The Great fire-
wall of China

By 2008, the 

market for mobile

adult-orient-
ed services
may add up to 

$1 billion

snapshot

Source: NTT-DoCoMo/Strategy
Analytics
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IBM is preparing a slimmer
alternative to Microsoft's

ubiquitous Office suite. It is
planned as a set of applications
that will run on corporate Web
servers. The business produc-
tivity applications comprise of
word-processing, spreadsheet
and e-mail software. IBM said
its applications are not intend-
ed to go head to head with the
advanced features of Office but
are aimed at those that do not
require the advanced features
that Microsoft’s products offer.
They hope that the low-cost
associated with their office
suite, will attract corporations.

According to company offi-
cials, there will always be 10 to
15 per cent of people who need
the full mail, spreadsheet and
document-writing capabilities,
while the other 85 per cent do
not wish to pay huge fees for
features they don’t need.

The applications, due in
the second quarter of this year,
are for companies that need to
do simple e-mail, text-editing
and spreadsheet work. The

applications will not be sold
alone, IBM will bundle them
with its WebSphere portal
server software.

Developed in the compa-
ny's Lotus division, the appli-
cations are part of IBM's
NextGen strategy for revamp-
ing its Lotus products. The first
product of the NextGen plan
was a lightweight e-mail client
called IBM Lotus Workplace
Messaging, aimed at people
who use e-mail on a limited
basis. The forthcoming office
applications will also have the
Workplace label, according to
IBM executives.

The Big Blue Office suite

Afresh line of price cuts is
expected from the stables

of Intel. The prices of 533 MHz
FSB Pentium 4 processors will
be cut by to 30 per cent on 11
May, ahead of the introduc-
tion of 800 MHz FSB equiva-
lents ten days later, the com-
pany has told its distributors. 

The new pricing structure,
according to the Web site, X-
bit Labs, will see the 2.8 GHz
P4 fall in price from $ 375 to 
$ 262—a fall of 30 per cent.

The 2.6 GHz falls to $ 193 from
$ 241 and the 2.4 GHz from 
$ 193 to $ 163. The 3.06 GHz
P4 will stay at $ 401.

The move is aimed at
knocking the prices of these
chips down to less than the
introductory price of 800 MHz
parts. The new comers are
expected on 21st May, the
report claims, with the 2.8
GHz P4C coming in at $ 278,
the 2.6 GHz P4C at $ 218 and
the 2.4 GHz P4C at $ 178. 

The 'C' indicates 800 MHz bus
support, the parts also support
HyperThreading. All this paves
the way for the arrival of the
3.2 GHz P4C at the end of the
quarter for $ 637, says X-bit
Labs.

In addition, Intel will cut
the prices of its Celeron range
on 27 April. The parts affected
are the 1.8 GHz to 2.4 GHz
chips, falling by up to 23.9 per
cent. The 1.7 GHz processor
will remain at $ 54.

Plextor has announced a
new CD-ReWritable drive

that can squeeze 40 per
cent more data into stan-
dard blank discs. The
PlexWriter Premium can
pack 980 MB of data into
a 700 MB disc and 1.2 GB
into an 880 MB disc,
according to the CD gear
maker. It does so using the
GigaRec option in the bun-
dled PlexTools Professional
software, working with the
drive’s hardware. 

The increased use of space
is achieved by burning

up to 40 per cent
smaller pits into
the surface of a
blank disc, thus
granting more
real estate. Such a

special nature of the
pits might not allow
a standard drive’s
laser to read the

media properly. The Pre-
mium line will ship as a stan-
dard internal IDE drive and as

an external USB 2.0 unit. They
will feature 52X read and write-
once speeds, and a 32X speed
for rewritable media. 

For some time now,
enthusiasts have been able to
make use of between 10 
percent and 20 per cent more
data than the rated capacity of 
a disc by overburning, or
writindata onto portions of a
discs normally left untouched. 
However, such discs often can-
not be read by normal
CDROM drives.

Nokia introduced a new
kind of MMS device for

the Americas market, the
Nokia Observation Camera.
The dual-band Camera is
expected to be available during

the third quarter of 2003. After
being mounted in a covered
area and connected to a power
source, the Nokia Observation
Camera can be pointed at any
area that needs to be moni-
tored. It can be set to send
images automatically to an
MMS-enabled handset or an 
e-mail address at pre-deter-
mined intervals, when motion
is detected, when a change in
temperature is noted or when
an SMS query is sent directly
to the device. It can also can
report ambient temperature
via SMS or open a voice chan-
nel for live audio monitoring.

Watch me

■ Dell Computer wrestles the top rank in worldwide PC shipments from Hewlett-Packard ■ Intel selects Bangalore for Centrino design team ■ New DIT plan

Data squeeze

57% of U.S
companies
already support

wireless
networks and 

another 22% will

implement it within

the next year.

Source: Jupiter Research 

snapshot

Price cuts, up ahead
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Researchers at Purdue Uni-
versity have designed a

‘pumpless’ cooling system
that removes six times more
heat than existing miniature
cooling systems. Researchers
thought that bubbles in the
liquid coolant might block the
circulation of the liquid
through the tiny micro-chan-

nels. Instead, they discovered
that the liquid flowing
through the channels actual-
ly forms smaller bubbles that
easily pass through them.
What’s more, decreasing the
diameter of the micro-chan-
nels actually increased the
cooling efficiency. The most
interesting effect is that the

liquid circulates in a self-sus-
taining flow in a closed loop
that carries heat away from a
computer chip, that does not
need a pump. Computers of
tomorrow are expected to
generate as much as 300 Watts
per square centimeter, this
may be the solution to our
cooling needs.

“Red Hat’s main
focus has been and
will continue to be
the enterprise.
We’ve had great
success in migrating
enterprise cus-
tomers from propri-
etary UNIX”
Matt Wilson, Manager, 
Base Operating Systems, 
at Red Hat, Inc. Red Hat has
just publically thrown open
its FTP servers that host Red
Hat Linux 9, the latest in 
its stable of the legendary
Linux OS.

“We expect to apply
Cell to a wide range
of applications relat-
ed to broadband
networks, including
digital consumer
electronics and
mobile terminals,”
Takeshi Nakagawa, senior
Vice President, Toshiba. Cell
is the new processor with 
a multi-core architecture
that will power the
PlayStation 3. Toshiba is a
partner in the development
of Cell and is looking at
using the chip in next-gen-
eration  consumer devices

According to an IDC report,
China is still some years

away from threatening India’s
position as the software out-
sourcing powerhouse of Asia.
“Although there are substantial
outsourcing projects in the
United States every year,
China’s IT companies
are weaker than India
in IT project manage-
ment,” said Nicholas
Yong, a market analyst
with IDC Asia/Pacific.
China’s software com-
panies also don’t have the sales
channels in the United States
that Indian companies do
according to IDG. Other fac-
tors, that give India an edge,

include its use of English and
the quality of its product. 

China may be in second
place now, but its IT market is
still the strongest-growing in
the world, and it is also strong
in both the export and con-
sumption of software, said the

report. While the US may be
India’s big market, Japanese 
IT firms are the biggest 
consumers of China-made soft-
ware, according to IDC.

Outsourcing giants

IPR Systems, the Sydney-
based creator of digital

rights enforcement technolo-
gy, has beaten Microsoft to
the coveted crown of protect-
ing content consumed by the
next generation multimedia
mobile phones.

IPR Systems’ Open Digital
Rights Language (ODRL) ver-
sion 1.1 has been adopted by
cell phone manufacturers
such as Nokia, Samsung and
Sony Ericsson. ODRL gives
content creators the power to
determine exactly how their

material is used. According to
sources, IPR’s four engineers
built the Digital Restrictions
Management (DRM) lan-
guage in about two years,
before the first version was
commercially adopted by
Nokia and others. 

ODRL is an open standard
provided free to developers
and phone makers in an
attempt to spur wide adoption.
The company’s business man-
ager said that it makes money
by providing systems that best
take advantage of the standard.

3G rights-management

Liquid cooled systems
tomorrow’stechnology

quoteworthy

points to end of the road for Media Lab Asia ■ Pirated versions of Madonna’s latest album replace the content of the Material Girl’s Web site

The Liberty Alliance, a
global consortium formed

to develop online identity
standards has unveiled drafts
of its Phase 2 specifications—
a step that it considers vital in
creating a commonly accept-
ed and more trusted way of
building and managing iden-
tity-based Web services. 

“The opportunity for Web
services is enormous, and
innovation in this space will
drive the future of e-com-
merce,” said Michael Barrett,
president of Liberty Alliance.
“However, in the meantime,

there are business and tech-
nology barriers impeding this
innovation and progress.
These barriers include the
complexity of identity man-
agement—a critical compo-
nent in Web services—as well
as the lack of technical stan-
dards and the inability for
identity management prod-
ucts and services to work
together.” The alliance seeks
to lower these barriers. 

Drafts of security and pri-
vacy implementation guide-
lines as well as a ‘Privacy and
Security Best Practices’ docu-
ment were also introduced
today with the Phase 2 draft
specifications. These docu-
ments highlight global priva-
cy laws and fair information
practices, as well as provide
implementation guidance
for organisations using 
the Liberty Alliance specifica-
tions to build identity-based
services.

Liberty 
moves 
forward
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Unlawful use
Hi,
Two months back, I installed Adobe Photoshop 7.0 (a 30-
day evaluation version) on my system which has Windows
XP, with no Internet connection.After the trial period the software stopped working, so
I re-installed the software using the Digit Mindware CD.
Even then, I was unable to use it. I tried installing the same
on a friend’s PC with the same outcome: The software
expired after 30 days and I was unable to use it anymore. I
think that some data pertaining to the expiry date is saved
in some part of the computer system. Kindly tell me where
such data is stored on the hard disk and how to use the
unregistered version of any software like this.John
Via e-mail

Dear John,
Software companies provide trial software to allow you to make

an informed buying decision, especially since the software

could cost more than you would be willing to pay for.

It is not legal to use the trial software for more than the

allowed period of time. Finding and removing the stored data

to allow the software to run beyond the 30-day period is as

bad as cracking the program itself to prevent it from looking at

the data. We cannot help you do this.

Playable games wantedDear Sir,
Funzone was started to cater to people with older low-end
machines as also to give some games which children could enjoy.
I’ve noticed that almost all the games featured in Funzone are
now trial versions and also require the latest software drivers, etc
to play. Could you revert to featuring few low-end, freeware
games that small children in age group 5 to 7 years find easy to
play? This way they will be interested in computers, and they too
would gain from Digit.
Jaggi
Via e-mail

Dear Jaggi,
You are right about the intent of the section and we have indeed drift-
ed a little from that mission. However, it is also a fact that though the
games may be suited for younger audiences, or may have low hard-
ware requirements, they will require driver updates. This is because
when developers write new games, they use the latest software avail-
able. Beyond a point, we would have to resort to carrying software of
historic interest to avoid driver updates. But rest assured, we will try
to minimise any such inconveniences to you in the near future.

Hear the have-nots

Hi,
Looks like you guys are competing with the world’s most popular

software company, Microsoft! Every time MS releases an operating

system, the demand for resources also goes up. So do the specifica-

tions of the Digit CD:

In October 2000: Windows 95/98, Internet Explorer 4.0/5.0+,

Pentium 100 MHz, 16 MB of RAM. In April 2003: Win9x, Internet

Explorer 5.0 upwards, Pentium 233 MHz, 64 MB of RAM. Do you guys

think such resources are needed for just displaying the user interface? 

Think of the lower-end systems that will have a problem and will

not be able to get a clear idea as to what is stored inside the CD. OK,

they can use the good old Windows Explorer to view the files, but

many will not think of that! 

I think a simple HTML interface (as you included in early 2001

CDs) will suffice, not Flash and Dreamweaver.

Karthik

Via e-mail

Dear Karthik,
We move behind the times. The CD hardware and software require-
ments are all for products released 5 years ago. IE5 was available in 1998, as
was the Pentium II processor. In three years, we moved the processor
requirement up by only one generation, and to a speed 1/5th of the entry
level desktops now available.

It is unreasonable to deprive the vast majority of our readers with decent
hardware, of an interesting, lively experience. That said, we must also point
out that there is no reason why the interface cannot function perfectly well
on a Pentium 100 MHz. We deliberately avoid using the heavy, animation-rich
Macromedia Director interface in favour of HTML and Flash that any machine
running Windows 95 should be able to handle.

Q. Which anti-virus software do you use?  

Your vote counts

30.6 %
Norton

43 %
McAfee

This month’s question:
Question: What would you like to see on the Mindware

CD? Choice of Answers (for Web site only)

! Business Software ! Utilities ! White papers / E-books

Log on to www.thinkdigit.com and vote

Commentary on education

Hello,

Your article on computer education was

both timely and judicious. I’d like to add

my two cents to that piece: Although

these institutes have the latest software

versions, most of them are pirated. The

institute provides a skills-oriented rather

than a certificate-centric curriculum, so

the use of original or pirated software just  does-

n’t make a difference. Also the only difference

between the faculty and the student is that the former joined

the course a couple months before the latter, and is a few mod-

ules ahead. Coupled with the ambiguous and unregulated 

quality of the institutes themselves, you have a case where 

a student wants to

gain a ‘valid com-

puter education’,

but has no idea

what to do if and

when he receives

the certificate.

Natraj Jayaraman

Via e-mail

MAY 2003

Dear Natraj,
That’s a good summary of what is wrong with
our unorganised computer education system.
That’s why we need standards to be main-
tained by a government agency. In computer
education though, that may be jumping from
the frying pan into the fire. Our standards
based B.E. syllabi are so far behind the times;
it is amazing and gratifying, to see students
do well despite them.

AVG

20.3 %
PC Cillin

6 %

Clearly we need to carry regular updates for the Norton and McAfee
anti-virus solutions
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Contest Trouble

Hi,
I took part in your Contest Carnival. The

magazine announced the results on 

the ZDNet India Web site, but I can only

see the results of the January Alladin 

contest. When, and where will you

folks show the contest carnival results?

Vaibhav Dubey

Via e-mail

Hi Vinit,
In the April 2003 issue, for
the scanner test on page
62, the picture of Umax
Astraslim 600 is named as a
Canon piece.

Dhawal Bhandari

Sir,
On page 76 of the April
2003  issue, the specifica-
tions of the Samsung
combo drive have been
mixed up with those of a
USB stick drive: 128 MB
capacity, USB Power Sup-
ply, etc.

Satish

The correct specifications for
the Samsung combo drive 
are 8 MB onboard buffer,
Weight: 770 grams, DVD-R,
DVD-RW, DVD-ROM, DVD-
Video  compatible.

Notice any goof-ups? Write to
goof@jasubhai.com

Goof Ups

An unfair contest?Dear Sir,
Although I am not a subscriber to Digit, I havenever missed a copy since Istarted reading it. I haveparticipated in all thecontests. Medal tally—nil. I would like to knowthe criteria of selection.1. Is it necessary to bea subscriber to win,like the results

repeatedly seem to
suggest?  
2. I am drawn to
believe, or at least theresults seem to point outthat you favour the metropolitan cities and arebiased against remote states such as mine,Meghalaya. I do hope it is not deliberate, becausewe really feel neglected.I hope you will not let me down and will clar-ify my doubts.

David
Via e-mail

Send your letters marked ‘Readers Letters’ to the Digit office: 
D-222/2, MIDC, TTC Industrial Estate, Om Sagar Building, Nerul, Navi Mumbai 400 706, 

Phone: 022-7629191/9200  Fax: 022-7629224 
E-mail: readersletters@jasubhai.com 

Short Bytes
Pret-a-Porter
Hi Vinit,
I want to thank the whole
of the Digit team for the
‘Wear your attitude’ section
in the April Test drive. I
had all the resources,
except the iron-on-transfer
paper, which I finally got
my hands on. Now I’m the
only guy in Muzaffarpur
wearing T-shirts with every-
one, from Kate Winslet
Cate Archer, and from Lara
Dutta to Lara Croft on it.

Anubhav
Via e-mail

A backup in time
Dear Vinit
The November 2002 article,
Lifesavers, was fantastic and
timely. I beleive that the fre-
quency of backups is directly
linked with the level of
importance of the data lost.
I backup every day, some-
times after every session.

Kirit Shah
Via www.thinkdigit.com

Cell phones please
Hi there!

I am writing this e-mail to congratulate

you people for the wonderful March and

April issues of Digit. The editorials were as

usual, good. In March the GTA 3 review

was really well done. I read the review and

went out and bought myself a copy and

was not disappointed. I look forward to

such good reviews in the future as well. 

Also the article about robotics was good. 

In April, the article about Quantum

Computing was really good and interest-

ing. Please include related articles in

future editions of Digit as well. Being a

subscriber, I was pleasantly surprised to

get the April issue on the 31st of March

itself. Keep up the good work. 

I think that now is the right time to

carry out a full test on cell phones: GSM

and CDMA as there is a wide variety to

choose from including phones with

colour screens. It would really help make

a buying decision easier. Also upcoming

technologies such as 3G warrant some

mention in your magazine. 

Vivel Balvir Singh

Via e-mail

Hi,
I have been longing for an issue of your

magazine which will carry the most

detailed review on cell phones ever car-

ried out in India. Just like your June 2002

issue, this one should feature almost every

phone in the market along with a small

summary of each cell phone and not just

the best of them. Please fulfil my desire

and I shall admire you people for the rest

of my life.

Jack Klon
Via e-mail

Dear Jack and Vivek,
We hope this issue is a sufficient answer to 
your needs.

Dear David,
We appreciate your loyalty, but we can only
wish Lady Luck favours you in future con-
tests. You see, our hands are tied when it
comes to selection of winners—no humans
are allowed near the selection procedure.
All entrants have to register for contests, and
no additional favours are made for sub-
scribers. For all contests that involve scor-
ing, a database program tallies the scores
and builds up a shortlist of candidates. If that
list is bigger than the number of prizes, or
the contest involves a lucky draw, the pro-
gram picks the required number at random. 
All we get to see is the final list. Now if you
can come up with a way to direct the ran-
dom selection, we will try our best to send a
prize your way.

MAY 2003

Dear Vaibhav,
The results on the site are indeed the Contest Carnival results.
The Carnival consisted of a large number of independent con-
tests, including the Alladin contest, and every other contest list-
ed on that page. The design of the page did not make that clear
earlier, but after we received your e-mail and those from a few
others, we have updated the page to clearly state that it shows
the Digit Contest Carnival results.

All winners will be notified and their prizes shipped auto-
matically to the addresses registered with us.

ILLU
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Today, we take Internet access for
granted. Many of us need Net access
as much as we need phones, or even

more. I personally check e-mail several
times a day. One of my friends, a pioneer in
computing, wakes up after 3 hours of sleep,
checks his mail and then goes back to sleep.
We get a little nervous when we haven’t
checked mail for over a day. 

Business travelers have always been wor-
ried about connectivity, especially on long
flights. Sometimes events require split sec-
ond decisions. For example, stockbrokers or
fund managers, feel the need to be reachable
during market hours, to receive information
and react to it. But, once a flight takes off,
you can’t do any of this.

Until recently, there wasn’t an option,
even if you carried your cell phone or lap-
top. Due to technological developments
and the competitive nature of the travel
industry, you can now get varying degrees
of Internet access on flights and cruises.

For over two years, certain cruise lines
in the Caribbean have been providing Net
access at a cost of $1 per minute. Many com-
panies are wiring up entire ships, with Eth-
ernet access in every cabin. Norwegian
Cruise Lines has a ship called Norwegian Sky
which offers this facility.

On-flight Internet is the number one
demand by business travellers, and is slow-
ly becoming a reality, with two main play-
ers offering viable options.

Connexion, by Boeing offers broad-
bandbased connectivity. For this, an airline
has to tie up with Connexion and aircrafts
are retrofitted with two Ku band antennae—
one for downlink, and one for uplink. The
antennae electronically scan for satellites,
which they connect to overhead servers and
Wi-Fi antennas. The result is an operational
satellite network with a 5 Mbps downlink
and a 256 Kbps uplink. Current antennae
do not function north of 75 degrees lati-
tude, which is a problem being tackled by
Mitsubishi Electronics.

Current test systems send data at 

128 Kbps and receive at 3 Mbps, with pro-
duction models estimated to have a 1 Mbps
send and 20 Mbps receive capability. 

Currently, trials of this service are under-
way with Lufthansa and British Airways on
certain Boeing 747-400 aircrafts. Lufthansa
calls it FlyNet, and is available on the Frank-
furt to Dulles flight, while British Airways
offers it on its Heathrow to JFK flight.
Lufthansa is offering FlyNet free during the
test period for Business, First class and some
Economy class seats, but plan to charge $ 30
afterwards. British Airways, is offering this
service only in Business and First class, and
charges $ 30 during trial.

Tenzing Communications Inc, a Seattle-
based company is another player with a dif-
ferent approach to the connectivity prob-
lem, and is far ahead in terms of deploy-
ment. Airbus, a Boeing competitor, is a
strategic investor in Tenzing. Tenzing serv-
ice offers only filtered e-mail connectivity.
It partners with various smaller ISPs on the
ground to give you seamless connectivity,
even North of 75 degree latitude. You can
connect your laptop and access POP3
accounts and select Web mail providers,
such as Hotmail, or use entertainment
screens in front of every seat to send SMSs
to any mobile phone. It’s already deployed
on 40 out of 80 Cathay Pacific planes. This
facility is also available on Virgin Atlantic
flights, with a low cost per user of $ 10.

Tenzing expects it to be viable if 3 per
cent of passengers use this service. Their
approach is to use existing infrastructure-
airline communication antennae and enter-
tainment screens-to provide basic e-mail
access, as research proved that e-mail is
given more importance than Web access by
travelers. This system can also be upgraded
to support broadband access, as and when
the market demands it. This is cheaper, as
airlines don’t have to retrofit new antennas
or lose revenue due to installation time. 

Boeing expects to equip 250 aircrafts
with this service in the next 2 years, and
4,000 in the next 7 years.

TThhee  NNeexxtt  ttiimmee  yyoouu  FFllyy,,  TThhee
IInntteerrnneett  wwiillll  FFllyy  ttoooo....

Many of
us need Net
access as
much as we
need
phones...We
are always a
little nervous
when we
haven’t
checked mail
for over a day

”
“
VIPUL SHAH 

Vipul Shah is chartered accountant, and writes/consults on Internet, e-commerce, banking, finance technolo-
gies. He can be reached at vipuls@yahoo.com



If you were to buy a display today,
it will most likely be a CRT moni-
tor or an LCD panel. Both these
technologies have been with us for

decades, and they certainly beat tele-
type terminals hands down. But they
are bulky, get in the way, require too
much care and often demand that we
adjust to the display rather than adjust
the display to us. It is about time we
step beyond the limitations of the

bulky CRT and the fragile LCD. 
There are many interesting display

technologies vying for a space on your
wall, desk and pocket. Some of these
will add a new dimension to your
visual experience; while others will
just plain look better. But each one of
these will significantly change the
way you look at displays, making pos-
sible everything, from outdoor read-
able e-books to wall-size 3D views.

Real dimensions
We live and think in three dimen-
sions, yet our information representa-
tion is, at its best, only 2.5 dimen-
sions—a 3D model printed on paper or
rotated in real-time on a 2D monitor.
3D displays have been around for a
while, but they require the viewer to
wear special spectacles. Because of the
distance between the eyes, each eye
sees a slightly different view—or per-
spective—of any object you look at.
The two views are ‘combined’ by the

26
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CRT monitors and LCD panels are passé. The new dawn of display technologies is all about 
three-dimensional images and foldable displays

A window to the

Future
A window to the

Future

GRAPHIC DESIGN: Atul Deshmukh
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obtain a 3D view. 3D spectacles try to
achieve this same effect from one flat
image source. Polarising spectacles have
lenses that filters out images projected in
one colour. The left lens may allow only a
red image and the right one may allow
only a blue image. Combining these two
generates a greyscale three-dimensional
view. Active spectacles have a shutter over
each lens that alternately open and shut
in coordination with an alternating image
on screen, to generate a flicker-prone
image. This is often available as an acces-
sory to your video card, but rarely used
because it’s quite a headache for very
unimpressive performance.

However, things have been improv-
ing. There is a new 3D display in town
and it uses a toy technology to give a
believable field of depth, requiring no
equipment to be worn by the viewer.
StereoGraphics is already selling such dis-
plays as SynthaGram monitors.
Applications for SynthaGrams need to be
developed using a special Software
Development Kit provided by the compa-
ny. Philips Research has prototype moni-
tors that show almost three-dimensional
images, from any normal application.
They use special algorithms to interpret
and enhance depth in 2D images. 

The technology used to create these
auto-stereoscopic displays is called
Lenticular Display, and is a sophisticated
form of something that has fascinated us
all as children. In any stationary shop,
you can find rulers that have a ribbed
plastic surface on one side, applied over
two images. Depending upon your angle
of view, one image or the other is
revealed. This effect has been known and
used for nearly a century, but only recent-
ly has it been refined enough to be used
in 3D displays. The lenses are angled to
project two slightly different images,
simultaneously. The angle on the lenses is
such that one image is visible to the left
eye while the other is visible to the right
eye. The juxtaposition of these two
images gives a 3D appearance to the com-
bined view.  

The computer display is formed with
a combination of an LCD screen with a
lenticular screen. The display is driven by
any video card that has dual independent
monitor support. The lenticular screen is
a sheet with small lenses arrayed edge to
edge in precise alignment with pixels on
the underlying display. The display driver
lights up appropriate pixels to push out
two images at once to the viewer. Of

course, because of the
nature of the display, as
you move your point of
view around the display,
the two images may not
be visible separately. To
compensate for this,
SynthaGram monitors
have nine viewing zones,
i.e. areas where your
angle of view is optimal
for the images to appear
in 3D. Elsewhere you will
see a flat image much
like a regular display.

Applications for such 3D displays are
many, ranging from presentation of sci-
entific and research data, to business
intelligence to playing DOOM 4 in realis-
tic horror. But the most interesting oppor-
tunities with such displays is not just the
specific niche applications, but the possi-
bility of a real, usable three-dimensional
interface that literally adds another
dimension to computing. 

OLED and beyond
The LCD is king when it comes to sharp,
flat and thin screen displays, but there are
challengers to the throne, none more like-
ly to succeed than OLED screens. DuPont
recently launched its version of OLED as
the Olight division. Kodak has been work-
ing on this technology for over a decade

after its researchers came up with the 
earliest breakthroughs, and such compa-
nies as Universal Display are busy collect-
ing portfolios of patents for licensing to
manufacturers. 

Organic Light Emitting Diodes
(OLED) are composed of complex organic
compounds sandwiched between two
electrically conducting materials. When a
small current is applied to the conductors,
the organic compound emits light. This
effect is called electro luminescence.
OLED construction is similar to an LCD in
that it is a multilayer display. Active
matrix OLEDs use transistors to control
the light level of individual pixels in an
OLED just like an LCD display. However,
unlike an LCD, an OLED display does not
necessarily have a top layer of glass.

Lenticular displays use rows of tiny lenses to project a differ-
ent image at each eye

A prototype Philips monitor
showing pseudo-3D images
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An LCD display has a backlight that is
always on at full brightness and the liquid
crystal is used as a polarising layer, to con-
trol the amount of light allowed to pass
through. OLEDs on the other hand gen-
erate their own light and do not require a
separate backlight layer. No backlight
means one big layer eliminated from the
flat panel display. Just this fact makes
OLEDs economically attractive. Also,
since the OLED only uses electricity in
proportion to the amount of light to be
generated, it saves on power. According to
a Kodak technical paper, the elimination
of the backlight and one sheet of glass
combined with the thinner layers
required for the organic emitter substance
contribute to a much thinner display. An
LCD active matrix display would be about
6 mm thick, while a comparable OLED
active matrix display would only measure
1.6 mm thick. 

But the goodness doesn’t stop there.
OLED displays have a much greater con-
trast range than LCDs, and approach the
limits of the sensitivity of the human eye.
This means that we can expect to see
sharp, rich colours far superior to other
conventional displays. Because there is no
polarising layer in OLEDs, the viewing
angle is far greater than LCDs. The polar-
ising layer limits the angular range of
light emission from the backlight. For
example, picture a light in the back of a
box. When you open the lid, you can see
the light only from the range permitted
by the box lid. However, the OLEDs
themselves emit light right from the sur-
face, like a light source on the lid itself.

Lighter, brighter and low-power
requirements make OLEDs better suited
to mobile applications. At the current
state of technology, mass production of
displays greater than 4 inches **(is this
right?)** is unfeasible, though under lab-
oratory conditions large screen displays

have been made. Already there are proto-
type displays available for licensing from
some of the pioneers, and Kodak has gone
ahead and put their display into produc-
tion. The recently launched EasyShare
LS633 digital camera uses an OLED 
display for the camera interface instead 
of an LCD.

Current fabrication technology lim-
its OLEDs to glass substrates, but
research is on for manufacturing OLEDs
on flexible plastic backplanes as well.
This means that the display can be bent,
folded or rolled up and yet function per-
fectly. Better still, transparent OLEDs can
be applied to windows or the windshield
of a car to give a Heads-Up Display
(HUD), similar to the ones used in fight-
er jets. Universal Display recently
received a grant from the U.S military to
continue research on laying down OLED
displays on flexible metal
foil. The applications are
clear—a large, bright, low-
power display that can be
conveniently pocketed for
mobility. On colour PDAs,
the major battery drain is
the huge backlit screen.
With OLEDs consuming
potentially half the power,
you can expect significant-
ly lighter devices that stay
lit longer.

There are technical with
OLEDs that are yet to be
resolved. The most impor-
tant one is that of the lifes-
pan of the device.
Researchers are facing trou-
ble with blue light emitting
materials. Kodak claims to
have achieved a 10,000
hour lifetime for its blue
organic materials, while hit-
ting 40,000 hours for red

and green. For mobile applications where
the screen is only used intermittently
through the life of the device, these are
approaching adequate figures, but for
desktop PC applications, or for use in flat
screen televisions, these lifetime figures
have to be boosted much more.

In the early production models, the
power consumption is comparable to
LCDs, but this is expected to be lowered
in later generations.

OLED displays are at a stage where
they are just beginning to move into prac-
tical applications and there is tremendous
interest in future developments possible
with this technology.

Electronic paper
The first graphic device we look at is
paper—a simple and cheap technology
that has served us well for several hun-

An OLED is a sandwich of organic molecules between two
conductors, pasted on a glass or plastic backplane

The E-Ink reader a step in the direction of electronic paper

The EasyShare uses an OLED display instead of the conventional LCD



dred years. To achieve a device with the
familiarity of paper, blended with the
convenience of digital technology is the
ultimate goal for portable display 
systems. Look around you right now,
and see the amount of paper we still
consume, including this magazine 
you are holding. Most of it could very
well be viewed as electronic paper, a
device that reads, looks and feels like
paper, but shows you Web pages or MS
Word documents or the pages of an
electronic book.

There are two key criteria that any
electronic paper display must satisfy—
have the readability and portability of
paper, and consume very low or no power
when in use. That’s right, no power when
it is being read or looked at!

E-Ink has been making waves for a
while and they have now reached some
level of success in creating high resolu-
tion displays. E-Ink’s technology is quite
simple in terms of the science behind it.
The challenges are in fabrication of the
ink layer itself. An E-Ink display consists
of a thin film containing millions of tiny
microcapsules layered over an electrical
circuit. One half of the microcapsule
contains negatively charged black pig-

ment and the other half
contains positively charged
white pigment. When a
positive charge is applied
below the capsule, it
attracts the black pigment
down and the white pig-
ment is pushed up. The
spot above the microcap-
sule now looks white.
When a reverse charge is
applied, the black pigments
would be pushed up, while
the white ones will be
attracted down. When the
charge is removed, the pig-

ment particles stay in whatever location
they are. This means that once a display
has been updated, it takes zero power to
keep it that way. Contrast this with your
CRT monitor that is refreshed more than
70 times every second, or an LCD that is
a constant power drain because of the
backlight. 

LCD, OLED or CRT displays are trans-
missive, i.e., they emit light. An E-Ink dis-
play is reflective-it does not producing
any light of its own, but relies on ambient
light for readability, just like paper. The
reflectivity of E-Ink
materials is quite
comparable to that
of paper across a
wide viewing angle.
This means that not
only is an E-Ink dis-
play readable inside
a building, it gets
brighter when you
step outside in the
sun, unlike LCD dis-
plays that become
unreadable.

E-Ink has tied
up with Philips to
manufacture com-

plete displays. They provide the ink
layer, while Philips provides the active
matrix backplane and control electron-
ics. Philips recently announced a new
fabrication technique for the transistors
of the active matrix backplane that
works on a plastic sheet. This means that
E-Ink displays are available as flexible
sheets for a number of applications.

Future watch
There are a slew of exciting new display
technologies on the horizon and all of
them are optimised for different applica-
tions. We will, in all probability, have all
three kinds of displays in our offices and
homes, as and when they become afford-
able. Pervasive displays are very likely to
be the leading edge of pervasive comput-
ing in our environments. Displays have
to be accessible so that computers can be
hidden away, in a dark cabinet some-
where in the home or office. With thin,
light and conveniently foldable displays,
we will truly have access to information
and entertainment anywhere we chose.
Add a lenticular sheet on top and it can
all be real!

SUMOD HAJELA
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Cholesteric LCD displays are new form of display that brings major
new areas of application within the reach of LCD technology. Regular
LCD systems regulate the output of light from a backlight, much like a
fader switch. Cholesteric displays reflect light from a sidelight instead,
and the display control is by varying their levels of reflectivity. To top it
off, they are bi-stable, i.e., they can remain in either on, or off state
without any power required to maintain it. Kent Display systems is a
leading technology patent holder, and they have licensed it to about
half a dozen manufacturers. Both Philips and Samsung SDI have
demonstrated their own Cholesteric LCD displays. Samsung expects
to be selling the foldable version for E-Book reader applications.

LCD Fights Back

The structure of an E-Ink layer
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Sony Ericsson Z1010  
Calling all gamers
Sony Ericsson’s first 3G phone, will make you
scream with delight, with it’s streaming audio and
video, video calling, music and entertainment and
multi-player gaming. 
Web site: www.sonyericsson.com

Garmin iQue 3600  
This is where you are
Garmin has put out an sharp PDA here, and it's topped off with
attractive features for those on the move. The powerful 200 MHz
processor and Palm OS 5, ensure a power packed experience. It
boasts Garmin GPS and mapping software, MP3 player, in-built
32 MB memory, an extended battery life, excellent graphics and
audio and tons of applications. You are sure not to lose your way
with this baby.
Web site: www.gamin.com

▲ ▲

Here’s where to splurge your life savings

▲ ▲
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Sony Vaio PCG-Z1A
Thin is in
Based on Intel’s latest Centrino technology, this
ultra-slim, ultra-light portable computer is also
loaded to the gills with mouth-watering peripherals.
It crams in Intel's latest 802.11b wireless
technology, a CD-RW and DVD drive, a free
128 MB MagicGate memory stick,
double capacity Li-Ion battery
and a port replicator for
expansion.
Web site: 
www.vaio.net

Kiss DVD DP-450
DivX Rulez ;-)
Finally, someone decided to bring out a DVD player that also plays MPEG-4 and DivX;-). 
Kiss Technologies is the first company in the world to do this. The DP-450 can play everything
found on a CD—VCD, SVCD, CD, MP3, CD-RW, DVD-RW. It supports DVD/MPEG-4/Divx version
4 and higher, and also has a JPEG picture CD viewer, Progressive Scan video out, slow motion,
parental lock and a Dolby Digital output.
Web site: www.kiss-technology.com

Canon EOS-1Ds 
A Digital shutterbug’s delight

Canon’s EOS-1Ds is a 11.1 megapixel
digital camera. With its high sensitivity,

and resolution, single plate CMOS 
sensor, 11.4 MB storage size and tons of 

power-packed functions, this camera 
leaves you agape with awe.

Web site: www.canoneos.com

TDK XS-iV S80 
Sounds like paradise
These drop dead gorgeous
speakers from TDK have an
impressive output of 80 watts
and a frequency range of 
60 to 20,000 Hz. The woofer is a 
high-powered forced pipe
design, and the subwoofer,
satellite system employs NXT’s
SurfaceSound technology, pro-
viding a previously unknown
level of nearfield stereo imag-
ing, resolution and clarity.
Web site: www.tdk-
europe.com

▲ ▲

▲
▲

▲
▲

▲▲
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Observe the young lad, engrossed
in a ritual. Note how oblivious he
is to his surrounding; grimace as

he slams his foot on the pavement, lower
lip twisted in pain. Pay heed to the arched
eyebrow and the piercing gaze that stares
hungrily at a pixilated screen. Select fin-
gers fly over an array of keys, buttons are
pressed, princesses rescued and worlds are
saved. Ah, a change of pace; now more
frantic, forceful; utterances emerge from
his mouth and lead those around to him
to shame…a dismissive toss of the head,

a sideways glance that ends in a devious
smile or maybe a resigned sigh. 

You have just spotted a new breed:
species mobilus, sub-species entertained. 

The sight is most frequent at bus
stops, train stations and the many queues
that string our life, whilst we wait in a
motionless inertia. What better way to kill
time than to play games on a cell phone?
With many it’s almost an obsession. Jacob
Joseph, a 23-year old youth from Goa
says, “I play Snake on any Nokia phone
that I can get my hands on.” The most

popular games are Nokia’s Snake II, F1, Pin
ball and Space Impact. “I play whenever I
am free,” says Mufaddal Patanwala, a self-
employed 24-year old. A proud owner of
the Nokia 8310, Mufaddal would such as
the cell phone makers to create games like
bike racing. Even Abdulkadir Dahodwala,
a 23-year old computer engineer agrees.
“I play games while travelling, and  would
want games that promise speed and are
more competitive.”

But buying phones only for the games
that they offer is not exactly the topmost
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ENTERTAIN YOU!
Stuck in a jam, morning, noon or night?

Whip out your cell phone—Round One, Fight!
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priority for most consumers.
Shabbir Patanwala, 25-year
accountant, for example,
bought the Nokia 3330
because it was cheap and
had good features. “Games
do not top my priority list. I
would eventually love to buy
a 7650 but only because of the embedded
camera.” Gagan Gupta, a 25-year old
game enthusiast also agrees with that
point of view, “I did check for games but
it was not the most important feature.”
He plays Snake on his Nokia 6510 and
brags of a record score of 1600+. “If I see
a score on someone's cell phone that
exceeds mine, my first reaction is to break
their record. It may annoy them but it
entitles me to some big-time bragging
rights,” Gagan confesses.

Games do take on an important hue
with some though. Jacob ‘dumped’ his
Siemens cell phone only so that he could
continue to play his favourite game. “I use
a Nokia 3210; I bought it because I loved
the game Snake. I had a Siemens
handset, but the games in it didn’t
interest me at all. I owned a
Motorola too, but it was even
worse—it had no games at all!” His
latest score is 513.

B. Mathew, the 31-year old
General Manager of Fastcursor,
says: “Instead of spending money
on an expensive cell phone for
some rudimentary game that is
only neon-coloured, I choose to spend
that amount on a PDA and get a better
gaming console. I don’t find the non-
coloured pixel dominated games as inter-
esting as those on the higher-end con-
soles.” For hardcore gaming fanatics who
are thrilled by the hunt, the kill, the blood
and gore, mobile games is kid’s stuff. 

Here be the money
This does not mar the enthusiasm of the
mobile makers, who see the gaming
industry as a huge revenue-generating
model. Established digital games compa-
nies are increasingly recognizing the
potential of mobile gaming. Partnerships
between wireless companies
such as network operators or
device manufacturers, and
video games giants have
emerged, including collabo-
rations of Motorola with
Sega, Nokia with Eidos,
Orange with Rage and NTT
with Nintendo. Distribution

systems that range from
pre-bundling of games to
downloadable content are
being experimented upon;
the search for maximum
profit is on.

Pedro Amaro is an inde-
pendent game developer

based in Portugal. With game program-
ming experience mainly in Pascal, C, C++
and Java, he’s currently focused on devel-
oping games for the J2ME and J2SE plat-
forms. He is the author of Colourama, the
first J2ME game to be fully developed in
Portugal, and to be licensed for an inter-
national release.

“Regarding distributions systems,
there’s one thing that I’d like to see: air
time revenue sharing”, says Pedro. “Cur-
rently operators only distribute the games
and share the revenues of each unique sell
but do not share the revenue they make
with the time the player spends playing
over the air. If such a feature was imple-
mented, I suppose that over the air mul-

tiplayer gaming would
takeoff. Currently, most
software houses aren’t
interested in creating mul-
tiplayer games as the extra
work doesn’t pay off in
financial terms.”  

The mobile gaming
market is subject to the dis-
ruptive principles of emerg-
ing technologies, and cur-

rently plays host to a sceptical view point
that mobile games are not a profitable
venture. 

Norbert Chang, co-founder and CEO
of Enorbus, the premier provider of wire-
less entertainment services in China,
clears the air as far as profitability is con-
cerned. “Markets such as Japan have
demonstrated the amazing potential, not
only for handset sales, but for games and
wireless entertainment as well. And while
we admit that some in the industry have
mistakenly heralded wireless games as a
get-rich-quick scheme, we also insist that
there is a large profit to be made.” Pedro
cites price as a hurdle to be cleared, “The
only thing holding back this market is the

cost of the latest Java-
enabled colour devices,
which scares away most
customers. However, once
that problem is solved, I am
sure that those who believe
that this is a non-profitable
venture will change their

mind.” Norbert adds that, “as a develop-
er and content provider we are willing to
work with any technology that entertains
our users. We focus on exploiting the
strengths of the technology, rather than
dwelling on the limitations. Intelligent
game design and a little creativity go a
long way in developing games that max-
imize the opportunities of today’s tech-
nology.”

Games developed are as varied as the
people they hope to appeal to. For
instance, “I would prefer complex puz-
zles,” says Sabira Slatewala, a 
19-year old student. Or take Gagan who
excitedly says “Arcade games are a must!
They can add as many advanced games as
they like, but classic games such as Snake
will still be the most played ones. It’s
something like Windows Solitaire being
the most popular videogame around the
world.” The popularity of a platform
spawns a surfeit of software aimed at it,
including games, a glut that attracts more
users to it fur-
ther raising its
popularity; it is
a self-con-
tained cycle
that attracts
many like
Gagan. “I'm
really interest-
ed in getting a Nokia 7650! I’ve been
doing some research over the Net, and
have already found freeware games such
as DOOM, Prince of Persia, FIFA Soccer and
Street Fighter. There’s a lot of free software
available for it, and with the attached
cam, I don’t think I’ll ever get bored.”

It is interesting to note that the Nokia
games group is a product of accident
rather than a decision. George Pneumati-
cos, Marketing Manager of Nokia Games
explained that whilst developing the
6100 series of phones, some engineers
recognised that the platform was  sophis-
ticated enough for games. The employees
at the Product Development gave them
the go-head and, “It turned out to be a lot
more popular than people expected.” The
6100 series of phones included three
games namely Memory, Logic and Snake.
And no sooner was it launched, than
Snake became the most popular game.
According to studies, almost 68 per cent
of people with Nokia phones with Snake
on them had played the game.

Sing when you’re winning
The simplistic nature of mobile phone
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According to
IDC survey, 15

per cent Indians
play online
games and 
13 per cent shop
online



games, com-
pared with the
rich environ-
ment of con-
sole games,
means the
games rely
more on the
game experi-

ence rather than the surrounding media.
The in-game sound and vision have been
enriched almost to a distraction, with
game experience almost taking a back
seat. According to reports, some players
in the mobile gaming industry believe in
text-based games whereas others opine
that 3D-games will take over the market
soon. In fact, content providers think
that SMS will be the most successful tech-
nology for mobile gaming even in 2005.

Ask Norbert about SMS games and
nostalgia takes over, “SMS games were
such a novelty: exciting and
new to the market, a lot of fun
to create... Probably our most
famous SMS game was Dating
Annie. We used a famous Tai-
wanese movie star, Annie Wu
to encourage users. It was a
‘character-development’
game, in which users, through
SMS choices worked to build
up their personalities, careers,
physical health, etc. The other
element of the game involved
SMS Essays. Users were invited
to express their affection for Annie via
SMS messages. The grand prize was a
night on the town with Annie.  Users
responded very strongly to the unusual
and unheard of prize.” 

Jeffrey Kay has been developing soft-
ware for over twenty years and while he
doesn’t consider himself to “have signif-
icant expertise in the mobile gaming
industry”; he nevertheless follows the
market closely enough to offer a signifi-
cant insight. He points out the populari-
ty of SMS games; moreover he sees info-
tainment as a very viable means to get
revenue out of such games. “The show
American Idol, allows voting using SMS,
which provides a revenue
stream to the mobile carriers,
who charge around 10 cents
per message,” he adds,
“Mobile gaming technology
will find areas where revenue
is obtainable, most likely
through infotainment at
first.”

The other half believe, that the tech-
nology development will be fast, and
advanced two- and three-dimensional
games will emerge in the near future.
However, very few companies have made
definite strategies that they would be pur-
suing. It seems that the industry is cur-
rently lacking persistence and changes
the focus whenever a new technology is
introduced.

“Both theories are true in way. With
the Nokia N-Gage phones, you can get
PSone quality graphics on your handheld
mobile phone, which makes it a better
handheld gaming option than even a
Gameboy Advance. But not everyone can
really afford a phone such as the N-Gage,
and not everyone wants a mobile device
solely for the purpose of gaming. That
segment may be more than satisfied with
the humble arcade games in their cell
phones. As far as SMS gaming is con-
cerned, it’ll work extremely well if SMS

becomes free,” explains
Gagan.

E n t e r t a i n m e n t
through mobile phones is
a nascent business niche
that is gaining more atten-
tion. SMS games target
audiences that are inter-
ested in, say, a 5-minute
pursuit. The cost for these
games is minimal while
the market volume is
high. The target group of

advanced games is primarily in the age
group of 20 to 30-years, who can afford
expensive devices. The games sold on
such platforms are expensive and the vol-
ume of the market is very less.

Fragmented markets and disagree-
ments over standards spawn simple con-
tent. Due to limited technology, games
such as Bingo, cards and quizzes rise up
the popularity pole. Games are also
expected to expand using the “commu-
nicative properties of the phones”. Mul-
tiplayer and location-specific games are
expected to develop. Customers will be
willing to pay for playing the games, and
most wireless gaming revenue will come

from two sources—sponsorship
and subscriptions. Priced games
will probably be limited to net-
works that can offer faster serv-
ice, and therefore higher quality
games. Jeffrey expounds, “There
will be some revenue obtained
through multi-player communi-
ties and infotainment as a sub-

scription service. Some games will obtain
revenue as a percentage of the fees
charged by the carriers for data access.
Some games will have to be purchased
like software is today.” 

He points, “Live delivery—via WAP
and such—is probably going to take the
longest to happen because of the time
involved in downloads and the cost to the
carriers. Downloadable games will proba-
bly focus on multi-player revenue models
where subscriptions or percentages of the
carrier’s data charges can be obtained.” The
fact is that WAP is an exciting medium; it
has a social flavour that appeals to devel-
opers such as Norbert, “The technology has
allowed us the opportunity of increasing
user interaction to the point of creating
wireless communities. A WAP game is
about far more than just playing, it’s also
about competition: playing against, or with
other users is very exciting.” 

Talk of technologies, market shares and
delivery methods pale in comparison to
the passion showed by some of the con-
sumers of this content form. The jubilation
shown by some is
virulent. Take
Adarsh Kaul for
instance: married,
working, happy,
with a penchant
for cell phone
gaming that would
put a 9-year old kid
to shame. His pas-
sion certainly rivals one of that age group,
“I am an avid fan of Snake I and II, a high-
est of 1324 in the first and 2416 in the sec-
ond! I need to play the game for a solid 52
minutes to get at those scores.” His sense of
wonder shines bright in his jovial eyes,
intent to shatter barriers between fun and
religion as he candidly confesses that, “I
always hoped that Nokia would host a
Snake championship, I would win it!”

Dreams have a wonderful property of
being shared by all. As Norbert expounds
his vision, “We love games, and are always
trying to offer better to our users and
friends. We anticipate the day when people
put down their PS2 joysticks in favour of
their phones. For us, the key to success is
ultimately found in fantastic games: great
graphics, fun and addictive playability.
Regardless of the other pieces of the wire-
less value chain, or the direction that tech-
nology may lead, great games will contin-
ue to be our goal, and will ultimately be
our measure of success.” Amen to that.

AHMED SHAIKH and RUPALI PATIL
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Datamonitor 
predicts that the

year 2005 will 
witness 200 million
people in Western
Europe and the 
United States 
playing Internet
games on their
mobile phones
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The Digital Media
Test & Research
Centre (DMTRC)
conducts a series

of elaborate tests to eval-
uate the merit of each
hardware and software
product. To ensure that
our readers have all the
information they need to
make an informed buy-
ing decision, engineers at
DMTRC evaluate and
review the latest hard-
ware, software and technology services in accor-
dance with the most up-to-date evaluation
processes and methodologies used around 
the world. 

Comparison Tests
We use a dual rating system, the first of which is

applied to the Comparison
Tests in which we compare
the performance of products
within a particular category.

Each product is evaluat-
ed under different parame-
ters such as performance,
value for money, features,
warranty and support, etc. 

Weightages are then
applied to the various test
parameters according to
their importance for 
that particular category of
products. 

These weightages are
then used to arrive at an
overall grade for each indi-
vidual product. An overall
grade of A+, therefore, indi-
cates that the product is
close to perfection.

The Awards
Digit awards out-
standing products
by selecting a Best
Performance and
Best Value winner in
each comparison
test. The winner of
the Best Perfor-
mance Award will be
the product that
scored the highest in
the performance seg-
ment of our tests.

This award represents the best performing prod-
uct in our tests and doesn’t factor in any other
parameter such as value for money, features, sup-
port, etc. The winner of the Best Value Award
will be the product that scores the highest in
our value for money parameter which is derived

taking into account the ratio of
a product’s performance and fea-
tures to its price. The product
winning this award offers good
performance at a great price.

In Bazaar
The second part of the rating system is used to
evaluate individual hardware and software prod-
ucts in the Bazaar section. The evaluation covers
parameters such as performance, ease of use,
value for money and the build quality/features of
the product in question and then arrives at an
overall rating. 

Here each of these parameters is given a
weightage of 25 per cent and is rated on a scale
of 5, which is represented by arrows ( ). 

The greater the number of arrows, the better
the product. This simple five-point rating system
is designed to give you an easy-to-interpret
assessment of a product. For example, a product
that receives an overall score of five arrows sig-
nifies an outstanding buy!

How we Test
Tring! Tring! Ok, so we all
hate those loud ring tones
but cell phones are increas-
ingly assuming an integral
part in our technology-
driven lives. 35 of these 
consumables ring in their

charms within the
busy walls of the
Digit Test Centre.
Nokia, Sony Eric-
sson, Siemens,

Alcatel are
all covered

in this comprehensive
shootout. Ergonomic con-
siderations such as grip; per-
formance parameters such
as voice clarity and ease of
use; aspects relating to the
user interface and features
such as Bluetooth were all
held firmly in mind while
putting these gadgets
through the paces.

Acer is the latest entrant
in the Tablet PC market, with
an 800 MHz processor and
256 MB of RAM. Is it a wor-
thy addition? Find out in
Bazaar.

Another neat little trinket
is the optical mouse chris-
tened with a mouthful of a
name—the SecuDesktop
2000 EyeD Optimouse. A
digital camera from 
Olympus and a digital cam-

corder from Fron-
tech also go
under the magni-
fying glass. The

latest version of
McAfee VirusScan
also makes an
appearance,
promising to offer

security from
viruses, with new features
such as HAWK to boot. 

And there is more—a
hard disk, a UPS, DVD burn-
ing software, a 4.1-speaker
set, the works! Enjoy! 

In Test this Month
It looks good and the technology is glitzy, but does it do the job?

Excellent: A brilliant combination of price, performance and features—far 
beyond expectations
Good: A good buy, better than most products in its category
Average: Reasonably competent but nothing spectacular about the product
Mediocre: Does not live up to expectations, needs improvement in many areas
Poor: has serious drawbacks and needs improvement before it can be 
used for its target application

The 5-point Rating System used in Bazaar
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T
he cellular phone market has a reason to rejoice.
The demand for mobile phones have sky rocketed;
business has kindled fierce competition between
the service providers, and GSM service has become
more affordable to the common man. Whether it
is the affordability or the sheer joy of flaunting the

sleekest models, the mobile phone craze has diffused through
every section of our society. To take a close look at the booming
handset market, we tested the best and latest instruments that are
available in the Indian scenario. We covered five major brands
and 35 models, and classified them into three categories: The
‘Just a phone’ category had the low-end, no-frills, affordable
handsets; the ‘Smart phone’ category saw sets meant for the
business user, that had a few extra features; the ‘Also a phone’ seg-
ment comprised gadgets that would, almost as an afterthought,
also allow you to make a phone call.  

How We Tested
Since a mobile phone is a consumer product, its allure is built
through print advertisements and television commercials. This
is why the looks and design of a model played integral part in its
overall score—after all, everyone wants to buy a cute phone. 

Since mobile phones are also turning in to the smart devices
that can perform tasks other than just making phone calls, we
assigned maximum weightage to features. 

The performance of the phones was tested by calling to and from
landlines to the test handset from different locations such as
open grounds and the innermost areas of a multi-storeyed build-
ing. We also noted down the period and type of warranty offered
by the vendor and suitable weightage was assigned. 

The phones were categorised by the most determining fac-
tor—the price. All the phones that cost below Rs 8,000 were clas-
sified within the ‘Just a phone’ category. Similarly, the phones
that fell within the price range of Rs 8,000 to Rs 18,000 formed
the ‘Smart phone’ category; whereas all the phones above Rs
18,000 formed the ‘Also a phone’ category. 

The phones in the Just a phone category must possess fea-
tures such as compact size, light weight, rugged body shell,
decent address book capacity, and a standby battery life of
around 2 days. They should also come bundled with some games,
ring tones, a calculator, reminder options, etc. If the phone sup-
ported SMS chat, personalisation, had a calendar, or had WAP
support, it earned extra points. 

Similarly, for the Smart phones we looked for features such
as an address book with storage space of over 250, SMS storage
capacity of at least 100, a good calendar to cram in reminders

or notes, capability to send
notes and schedules via SMS, a
larger screen to display long
messages and the calendar, data
connectivity through WAP or
an IrDA port, and most impor-
tantly, a solid standby battery
life of about a week. If a phone
in this category had a colour
display, an icon-based menu,
GPRS or camera support, it
edged ahead in terms of score.

Testing and benchmarking procedure
We evaluated the cell phones based on the following criteria:
Style and design: We rated the look and feel of each and every
phone on the scale of 5. We also took into consideration the
opinions of mobile users. 

The reason we rated style so highly, is the fact that even if a
phone is very feature-rich and performs well, but looks average,
there is very little chance of it being accepted by users. 

We looked at various features such as phone grip, build qual-
ity, keypad lock, shortcut customisation and so on. 

The weightage assigned for the style and design to Just a
phone was 20 per cent, Smart phone was 25 per cent and Also a
phone was 35 per cent.
Features: The features of the phones were logged and depend-
ing upon the categorisation, differing weightages were assigned.
For example, SMS is ubiquitous and is a given in any cellular
phone, be it low or a high-end. MMS however, is the in-thing and
only present in the high-end pocket burners. We thus awarded
points for MMS under the Smart phone and the Also a phone 
categories, whereas the phones in Just a phone were not evalu-
ated on this particular feature.

We prepared a comprehensive feature list to pace the cellular
phones through. Details such as ring tone functionality, group
messaging, phone memory, display quality, ease of use, durabil-
ity, grip, calendaring and to-do lists, PC connectivity, Bluetooth,
IR, WAP and other Web browsing capability, HSCSD, GPRS, MP3
playback, etc, were all appropriately considered. 
Performance: Performance of a cell phone depends on the net-
work. To avoid any ambiguity due to network loads, we tested the
phones in three different network zones, at three different time
intervals. Performance is a necessity, thus these scores did not
vary across the three categories.
Value for money: Value for money is an indicator of the over-
all price to performance ratio of a product. It is obtained by
adding scores from performance and features, and factoring it
with the price of a product. The weightage assigned to Just a
Phone was 50 per cent, as price is the deciding factor in this 
category. For Smart Phones we assigned 25 per cent, and only 10
per cent for the Also a Phone category.
Warranty and support: Warranty and support plays an
important role for these costly, light, delicate and sensitive elec-
tronic devices. The requirement was a one-year warranty, and
the option of a standby handset, in an emergency, is also a good
option. However, we
did not assign any
weightage to it because
all brands offered one
year warranty.

JUST A PHONE
Price: Less than
Rs 8,000
Page: 39

SMART PHONE
Price: Rs 8,000
to Rs 18,000
Page: 43

ALSO A PHONE
Price: More
than Rs 18,000
Page: 52

Features table for cellphones 
Find it on the Mindware CD 
Some prices have  changed after
CDs went to press
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The ‘Small is beautiful’ philosophy works just fine
in the world of Mobile devices. Compactness is
now a necessity, not a luxur. Mobile phones have

shrunk over the years, and are now smaller than a pack
of cigarettes, and packed with features that were previ-
ously unheard of.

Looks have also transformed, from the first cell
phone—the Motorola DynaTAC 8000X, which weighed
870 grams and was almost a foot long—to the tiny marvels
of today. The more you pay, the more a phone can do for
you, however in this section, we look at today's vanilla
phones, which perform the basic function of a mobile
phone and don’t cost the earth. 

Design and style
The design and style of a phone, plays a vital role in the buy-
ing decision. The keys should be designed for typing long mes-
sages easily, but also gel with the design of the phone.
Phones such as the Sony Ericsson T100, and the latest Nokia 2100
and 3610 stand out in the crowd, because of a complete new design
and good grip. The Alcatel One Touch 311, was too thick with a
smooth body that impeded grip. The Motorola C300, on the other
hand, had a firm grip thanks to the small form factor and the fin-
ish of its body. 

As for usability, many phones—ranging from the older Nokia
3310, to the latest Nokia 3610—have a 2-way navigation key that

comes handy while scrolling through a long list
of names or messages. The Alcatel One Touch
311 has a two-way navigation key, which is
better than other phones. It is akin to the
scroll wheel of a computer mouse, which can
be used to scroll up and down, and also as a
button. However, the button has to be pressed
hard, which is taxing if you’re in a hurry to

get to some menu option.
Many people complain about the number of

key presses it takes to reach a function within a
menu. Therefore, we checked the ease of use of the

interface by performing commonly
used tasks, such as writing new
messages or changing ring
tones. The Nokia phones were
simple to use. Sony Ericsson, on
the other hand takes some get-

ting used to. Once you spend 10 or 15 minutes with
the user manual, everything falls into place. Both the
Sony Ericsson T100 and T200, have the same inter-
face, but the T200 has a 4-way button, which provides
easier access to settings. Sony Ericsson and Motorola
are the only phones to have shortcut customisation—
you can assign the same key combination to your new
phone as your old phone. Nokia on the 
other hand, has the old system of keying in digit combi-
nations to access different menus, which calls for
good user memory.

If ease of use is a must, and design is high on your
list, consider the Sony Ericsson T100.

Basic phone features
Once you have checked out the look and feel of
the phone, and browsed through its menu, the
next important consideration is battery life
and weight. A phone should not compro-
mise on weight, with build quality, as
impacts can leave the phone useless if the
internal electronics or the LCD screen is
damaged. As far as build quality goes, the
Nokia phones are the most sturdy
phones in the market, especially the

33xx series. The Sony Ericsson
phones, especially the T100,
were not far behind. This phone
weighs only 75 grams, has a good
build quality and low price, mak-

ing it a good buy.

Battery life 
The battery life is one of the most critical features of a cell phone.
The phone with the maximum battery power, was the
Nokia 3350, which was blessed with an 850 mAh Li-
Ion battery that can last as long as 4 hours and 45
minutes. This time will come down if you use other
features such as sending or receiving messages,
composing tones or editing pictures. 

The Alcatel 311, has a rated talk time of 5
hours and 30 minutes. In real world conditions,
where signal strengths and temperatures fluctu-
ate, this time will reduce to about 3 hours. This
was also the only phone to have a Ni-Mh (700
mAh) battery, which looked like three AAA bat-
teries, enclosed in a feeble plastic case. 

All the phones were Dual band, and if you
plan on roaming abroad, only the Sony Erics-
son T200, with Tri-band support is a viable
option. This phone also sports WAP and GPRS. 

Sony Ericsson has introduced a serious contender—the
T200—to Nokia phones in terms of basic features, such as
weight, network support, price, and looks.

Memory
The in-built memory of a cell phone not only helps you store
more contacts, but also lets you access your phone book, even
if your SIM card expires. While adding to the cost of a unit,
in-built memory definitely extends the usability of the phone.
More data that can be stored on such a phone helps in day
to day use. Out of the 10 phones compared in this category,
only the Nokia 3310,
3315 and Sony Eric-
sson T100 did not
have in-built mem-
ory. The Sony Erics-

son T200 can store
350 contacts, while
the Alcatel 311, can
store 250. The main

Voice clarity (out of 5)

Just a PhoneJust a Phone

Nokia 2100 4

Nokia 3310 4

Nokia 3315 4

Nokia 3350 4

Nokia 3610 4

Alcatel 0T 311
Rating: B    
Price: Rs 4,995

Motorola C300
Rating: B-    
Price: Rs 6,695

Nokia 3315
Rating: B    
Price: Rs 5,399

Nokia 3350
Rating: B    
Price: Rs 6,499

Sony Ericsson T100
Rating: A-    
Price: Rs 5,995

To
p

 5
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LG CDMA Phone
The LG CDMA phone is a part of the RelianceIndia mobile serv-
ice. It is very compact and sturdy with a very firm grip. The keys
are nicely laid out for easy browsing through the menus. There
are four hotkeys for one-click access to the message menu, ring
tones, R-world and phone book. R-World has two games, the R-
menu and Multimedia tab, which did not work at the time of
testing. Just like the Nokia phones, the reception was excellent—
so loud at full network strength that the handset needed to be
kept at a distance of at least an inch away from the ear. The
reception quality drops significantly once the signal strength falls
below the 50 per cent level. 

The menu browsing is as easy as Sony Ericsson phones and
you will not take more than 10 to 15 minutes to get used to the
menu structure. Voice-dialling, a common feature, is absent from
this phone—a major shortcoming. The phone also supports two
phone lines, which is good feature for those who expect to get
multiple calls simultaneously. 

The four-way button works as the selector for four different

functions. This reduces the number of
clicks required to perform simple
tasks. The same ease is built in the
planner where the user can easily key
in the schedule and set an alarm as a
reminder. The keys of the phone are a
bit hard and therefore the users will
find it a bit difficult to key in long
messages and schedules. The four
lines of messages lets the user read
the SMS without much scrolling. 

This phone is filled with all the
regular features of the sub-Rs 8,000
category phones plus some more
features such as the JAVA based
games, Mobile Hawk and Black Jack.
The phone has good voice clarity
and ease of use.

test drive ■
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advantage that the Alcatel has is that a single name can
be assigned 3 different numbers. This saves lots of space
since many contacts have both mobile and land line
numbers, and therefore managing and retrieving them
becomes very easy. 

SMS    
SMS is used extensively to exchange pictures, jokes
and important messages. Manufacturers are now
selling mobiles in which the user can type a message
as long as 460 characters. However, because of the
GSM standard limitation, you will not be able to send
or receive a single message with more than 160 char-
acters. Newer handsets break long messages into units
of 160 characters and send or receive them. All the
33xx phones from Nokia can take 459 characters mak-
ing them the most comfortable phones for typing
long messages. 

The 33xx series also has soft keys and good button
placement, which reduces fatigue. The Siemens A50

supports a whopping, 760 characters though, the
keys are bit hard and therefore not really con-
ducive to typing that much on the go. 

Ring tones  
None of the phones, including the Nokia 3610
and Sony Ericsson T200, had Polyphonic ring
tones. However the Nokia 3310 had as many as
37 in-built ring tones and seven user-defined
tones, either via downloading or composing—
44 is enough of a variety by any standard.
Many phones also had the feature of assigning
specific ring tones to particular contacts—two
models, namely the Motorola C300 and the
Nokia 3610 did not have this feature. With the
Nokia 3610 however, the user can assign dif-
ferent tones as SMS alerts. 

PIM 
Personal Information Managers (PIMs) are very important if
you need to maintain an extensive number of notes and
require an alarm and calendar to remember multiple things.
Some high-end phones now support the ability to create
and forward notes, to other supported devices. Sadly, these
technologies are still expensive to integrate in the low-end
phones, and therefore only a few, such as the
Sony Ericsson T200, T100 and the
Motorola C300 had them. The Sony
Ericsson T200 and T100 are the only
phones to give a weekly view of the
calendar as well, which is very impor-
tant if you need to key in notes for a
particular date. All the Nokia phones
had the reminder feature. The Sony Eric-
sson T200 is a good recommendation but
it has very hard and noisy keys, which is
not the case with the T100, making it a bet-

ter choice over the T200.

Internet connectivity
WAP is outdated now, with GPRS looming on
the horizon. The reason GPRS isn’t already pop-
ular, is the poor network coverage by service
providers and the high associated costs. Greater
WAP content should be available once WAP
over GPRS is made available in the market. With possible data

transfer rates of 171 Kbps,
in theory, you will be able
to browse, chat, send pic-
tures, check e-mail and
even transfer files. The
advantages are many but
the infrastructure is not
yet ready. This is probably
why only the Sony 

Nokia 3610
Rating: B-    
Price: Rs 7,499

Seimens A50
Rating: C-    
Price: Rs 6,150

Talk time (in minutes)

Alcatel OT 311 330

Motorola C300 300

Seimens A50 300

Sony Ericsson T200 300

Nokia 3350 285
Nokia 3310
Rating: B    
Price: Rs 5,495
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Ericsson T200 had GPRS support in this category. The Nokia
3610 and the 2100, which are new launches were not GPRS
enabled. We hope to see more GPRS capable phones, under the
Rs 8,000 price tag soon.

Extra and Miscellaneous features
The mobile phones of today have some nifty features to show
off. The Motorola C300 had the voice-command feature, where
as voice-dialling is common in all Nokia phones. Adding voice
tags is very easy with the Nokia phones. The voice tags were per-
fect, even though they were recorded in noisy environments.
Surprisingly, the Sony Ericsson phones missed out completely on
this feature. They also disappointed us, with support for only
one phone line, which even old phones such as the Nokia 3310
have. If you are looking for the cheapest, frill-free, phone with
a calculator and games, then Nokia 3310 is the best choice.

Performance
When it comes to voice clarity and picking up signals, there is
no competition to a Nokia. Nokia phones have the best anten-
na and support electronics, which gives them excellent clarity.
We tested the phones in different areas, both open air and inside
buildings, and found out that there were some areas where only
the Nokia phones managed to stay connected. All Nokia phones
performed equally, thus you need not worry about voice clarity

when buying a Nokia. Sony Ericsson
performed decently, but lacked voice
clarity. These phones also failed to catch
signals in building interiors. The same was the
case with the Siemens and other brands. Hence,
if your workplace is located far away from sun-
light, as it is in many offices in the metros, a
Nokia comes across as the ideal candidate. 

Take that call
This comparison was mainly between Nokia,
which was dominant in terms of numbers,
and Sony Ericsson, which has the impressive
T100 and T200. The Nokia 3310 and 3315 are
showing signs of ageing, as they lack many
common features, such as calendar-
ing, and still sell only due to the glory
they earned in the past and their lower
prices. The Sony Ericsson phones are
looking very competitive. The T200,

which costs less than the
Nokia 3610, 2100 and
even the 3350, packs
more features and looks
just as good. The T100,
on the other hand, not
only has a different look,
but is equally good in per-
formance. It is also com-
petitively priced. 

Phone grip (out of 5)

Sony Ericsson T100 4

Motorola C300 4

Nokia 3610 3.5

Nokia 3350 3.5

Nokia 3315 3.5

Sony Ericsson T200
Rating: A    
Price: Rs 6,495
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p
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Speak Easy
GSM offers a variety of advanced features and services

that includes speech encryption, facsimile, data services and
SMS. From the outset, GSM has been a system designed with strin-
gent levels of inbuilt security. With constantly enhanced transmis-
sion protocols and algorithms added to the flexible platform, GSM
remains a very secure wireless standard.

Enhanced Full Rate (EFR) is one of the key features in 
developing new markets for differentiation of speech quality
between existing GSM networks and new networks that have EFR
infrastructure and mobiles. EFR not only enables the GSM operator
to differentiate its product from existing networks, it also allows it to
compete with services as it offers a comparable speech quality. 

So what exactly is EFR? It is a codec that has been defined specif-
ically for speech quality purposes with its improved coding algo-
rithms so that it has higher tolerance to interference. 

With GSM radio, speech is converted: transferred by a 
mathematical algorithm into digital format, transmitted and then
translated back to its original form at the receiver end. 
The EFR codec is particularly optimised for the natural 
transmission of the human language. The characteristic sound and
the language melody of humans remain (the harmonics 
are maintained), thereby the language becomes warmer. 

A majority of handsets available in the market support the EFR
standard. If supported by your handset and your service provider,
you can receive far better quality voice reception, at the cost of a
decrease in the talk time of your phone. On the other hand if the
network has the Half-Rate codec active, then there is a decrease in
the voice quality with an approximate increase of 25 per cent to 30
per cent in the talk time of your phone. 

We called up a leading mobile operator to find out whether
they provide EFR. But they were clueless about it and we still await
a response.
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How Grey is Your Valley…
The price difference between mobile phones available in
India and abroad has always been a sore issue with con-
sumers. This is because what you get here for as much as Rs
6,500 can easily be bought for up to Rs 1,200 less from the
Dubai and Singapore markets. This price gap widens with
the latest, and top of the line mobile phones. This is enough
of a reason for a popular grey market where the phones are
cheaper than those available through the proper channel.

The other reason that contributes to the customer’s
inclination to the grey market is the narrowing of the rift in
services offered by the two factions, namely the authorised
dealers and the grey market. Earlier the authorised deaslers
gave one the advantage of a legal bill of purchase, which
was a valuable documentation. However, now even the
grey market has begun providing bills along with a pur-
chase. The service came in rather late, once the authorised
dealers started selling the phones at competitive price and
stroked a fierce contest amongst the grey market operator.
In the end, it was a win-win situation for the consumers.
But how does this network operate? Is it akin to a den of a
horrifying villain from our silver screen or a plush office of the
smart, white-collared dude? Let us find out.

Since this is an illegal affair we are talking about, don’t
think that any taporis are involved here. The kind of people,

or passengers, as they are commonly known as—who pull this
whole affair through—have enough education under their belts to
tackle most of the dicey situations that might arise with grace. They
are the lot who travel to off-shore markets, make purchases there
and dump the phones in our local market. They travel in aircraft
and carry other items—mostly electronics gadgets, watches, DVDs
and so on. Although they are known faces with the custom officials
they still don’t get caught because the guy on the other side of the
desk gets a percentage to let the luggage go unchecked.

Once the package is out of the airport,  70 per cent of the
battle is won. The only thing left now is to get it to some

wholesaler. Experience and contacts let them know who to
approach in the business—people with enough money to buy the

goods, and further distribute them in the market. These are the sec-
ond level contacts who either buy the complete lot or pick the one
they think is better suited to them.

The wholesaler then spreads the word within the so called
business circle about the arrival of a new lot. The new

arrivals will  be bought by local shop owners situated in the main
market and famous malls, where it will be sold to the consumers. 
This completes the circle. If you think that the passenger, the
wholesaler and the shopkeeper, earn hefty margins on these hand-
sets—then you are mistaken. The margin on each of the low-end
phones is as low as Rs 200 to 150 per piece. It is the high-end
phones, other electronic gadgets and optical media, which earn
good margins. As you read this, the scene is going to get much
tougher for grey market operators. The reason behind this is the
minimal, and fast dwindling price difference between the models
available through proper channels and the grey market. Even con-
sumers now prefer buying from official sources rather than the grey
market. 

1
STEP

2
STEP

3
STEP

A casual traveller flies to a market
abroad. Here he purchases a variety 
of phones through his regular contacts.
These phones are cheaper abroad and
can be sneaked in to India. 

The retailers source the newly arrived
phones from the wholesaler on a 
week's credit. These retailers are the
guys who sell us the phones 
in the grey market.

The second person is the wholesaler
buyer who buys either the complete
stock or a part of it. This person then
markets the arrival of the new stock in
the retailer arena. 
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The 525 is a small and compact phone that looks a bit out-
dated, and feels like a soap bar with little aesthetic appeal. The

display is extremely small, the keypad cramped and the buttons
really hard to press. Though Alcatel provides three different face
plates, none of them look appealing.

The menu structure is uninspiring and does not offer an intu-
itive interface; this is further complicated by the hard, rectangu-

lar three-way joystick meant for navigating
through the menu. The keypad is cramped and
the keys lack the tactility and are at times,
unresponsive. A high-resolution small LCD
screen forms the display that is capable of dis-
playing three lines of text at a time. A bright
blue backlight provides the night vision
capabilities.

The phone comes with 250 capacity
entry book, and lacks group SMS and SMS
chat support. It comes bundled with a cal-
culator, currency converter, three games
and two phone line support. The presence
of voice dialling, voice commands and
voice memo capabilities are an obvious
advantage. It also does away with calen-
daring options, but one can key in
reminders into the alarm menu that rings

even when the phone is switched off.
The phone comes with WAP 1.2.1 sup-

port and GPRS for high speed connectivity, but
sorely misses an IrDA port. It has poor signal reception, due to
which the voice clarity and quality is significantly hampered.
The phone comes with a Lithium-ion power pack that gives it a
maximum of three-day standby time. 

Overall, this is an outdated model that neither charms the
buyer with looks, nor features, but still costs Rs 9,995. 

Alcatel has tried to break into the high-end phone market with
this well-researched handset. The 715 is a sleek, oblong, rec-

tangular phone with a large LCD display that takes up the upper
three quarters of the entire length. The phone comes in four basic
colours; the one we reviewed sported a combination of light grey
and silver imparting it a sedate, business look. 

The keypad that takes up the remaining one-third of the
phone surface, is quite large, and the buttons are well spaced out.
All the keys are very responsive except for the five-way joystick,
which is hard and tacky. A shortcut key placed on the sides can
be personalised to bring up the most frequently used menu.

The large LCD display is capable of displaying seven lines of
text and the font size can be increased and decreased according
to preference. However, the display isn’t as crisp as it should be
and the screen appears faded out.

Alcatel has used an icon-based menu structure that can be
navigated conveniently using the five-way joystick. The phone

book has space for 800 entries and you can
even create up to 13 directories (four direc-
tories by default) in the memory, and assign
each group with a different ring tone. Also,
the contact information is very compre-
hensive with ability to record the name,
surname, job profile, two e-mail addresses,
postal address and a text note. Similarly, the
calendar is also extremely detailed and func-
tional, yet simple to use. The phone sup-
ports SMS, EMS, voice-dialling, voice-com-
mands and also doubles as a dictaphone;
not to mention it has the mandatory, cal-
culator, currency converter and alarm clock.
It comes with polyphonic ring tones and an
external composer that can be loaded onto
a PC. One of the joys of the 715 is playing
games on it—the screen display rotates 90
degrees, giving it a handheld games console feel. 

Apart from these features, the 715 comes with WAP 1.2.1 sup-
port for browsing the Internet. On the data connectivity front,
it is provided with an IrDA port and GPRS support. It has a hand-
some, one week of standby battery time. In our tests, the phone
showed excellent signal reception, speech and voice clarity. 

To sum it all, the Alcatel 715 is a good phone that is stuffed
with practical planning features. The menu takes some time to
get used to, but once done, you won’t touch any other phone.
However, it can do with a better navigation keys. Priced at 
Rs 14,995, it is slightly expensive, especially when pitted against
the Sony Ericsson T68i. 

Alcatel 525

Although this phone breaks the Rs 18,000 barrier set for the
Smart phone category, it still finds itself here. This is

because of the limited set of features that this cell phone pos-
seses. We did not think it appropriate to
let it compete with the entrants in the
Also a phone category.

The A388 believes in the new age
mantra of enmeshing various infor-
mation technology products to come
up with an all-in-one solution. It
combines the usability of a cell phone
with the functionality of a PDA.
Weighing 130 grams, it’s a heavy
phone, but that is justified by the
extra hardware that makes it a PDA.
The build quality is commendable,
the phone feels rugged and solid.
Open the flap and you will immedi-
ate notice that something’s missing—
a keypad! Motorola has made
the screen into an input device,
by using a touch screen. The phone
comes with a large, standard, crisp LCD 

Smart PhoneSmart Phone

BBPrice: Rs 9,995

Motorola A388 BBPrice: Rs 19,995

Alcatel 715 B+B+Price: Rs 14,995
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The C350 is a sleek looking phone, with a nice use of
colours on its outer shell. The keys are radically designed
with curves flowing over them, but the ergonomics of

the keypad is not up to the mark. The menu navigation is
achieved using a four-way key and two dedicated soft menu
buttons. The menu is simple, intuitive and self explanatory. 

The C350 has many features built into it, the most visible of
them being the 4,096 colour LCD display capable of displaying
three lines of text. It also sports SMS, EMS, SMS chat, group SMS

and long messages of up to 450 characters.
The phone features an address book capac-
ity of 250, apart from the SIM capacity. It
also has a weekly calendar view to sched-
ule your appointments, reminders etc. 

The C350 features a vast range of
multimedia features including poly-
phonic ring tones (60 total—30 in-built
and 30 downloadable), interchange-
able covers, downloadable screen-
savers and themes, as well as other
multimedia enhancements. Other
nifty features such as voice dialling,
Java support, WAP 1.2.1 and GPRS
support, further enhance the fea-
ture list of this phone. However,
the phone does not have an IrDA
port for data connectivity.

The C350 does come with a
mini USB connector at the base,

which is a good feature to  directly con-
nect to the PC. It has decent signal reception, and fairly good
voice quality; only when the signal strength decreases consid-
erably, does the speech quality get hampered.

Overall, a good phone with loads of features, decent looks

Motorola C350 B+B+Price: Rs 9,795

The T 720 is one of the most beautiful looking and func-
tional phones from Motorola. This phone has an amazing

mixture of looks, cutting edge technology and usability that
is seldom seen on any other phone. Flip open the phone and
feast your eyes on the neat laid out keypad, the four-way nav-
igation keys, and the large soft menu keys. The build quality
is excellent—the phone feels rugged and solid. The large colour
LCD display is beautiful, with everything showing up won-
derfully bright, crisp and clear. The display is
capable of displaying 9 lines of text, which
really helps in reading long SMS messages
since it requires minimum scrolling.

The T720 employs an icon-based
menu structure that is simple to use and
intuitive. The user interface is excep-
tional with excellent use of direction-
al keypad and soft menu keys. You can
even assign six favourite functions to
the keys—four for the directional key
and two from the two soft menu
buttons. As if that wasn’t enough,
voice command activation is also
possible. The keypad buttons are
large and easy to use with good
touch feedback—the only sore
point was the directional keys,
which aren’t suitable to play the
games.

The phone comes with a
mammoth 1.75 MB of memo-
ry, that can store all the down-
loaded games, applications,
themes, wallpapers, pictures
etc. On the entertainment
front, the phone comes with
three pre-installed Java
based games—MotoGP, the
evergreen Tetris and Astros-
mash. It does have a date
book option, but Motorola has not
provided a monthly view that would have
complemented the large screen well. 

The phone supports WAP 1.2.1 and has GPRS. The only
thing missing from this phone is an IrDA port and hence, if
you have to download, your only option is the cable connec-
tion or WAP. It also supports an external FM radio set thus
turning it into personal radio on the go.

The T 720 has excellent signal reception and good speech
clarity. At Rs 15,995, the phone is priced on the higher side,
but it makes up for with its beauty, excellent display screen and
loads of features.

Motorola T 720 BBPrice: Rs 15,995

display capable of displaying seven lines of text. The backlight is
feeble, but lights up the entire screen evenly. The flip cover also
comes with an external LCD that lets you see the caller’s number
without opening the phone.

The menu structure is extremely simple with large self-
explanatory icons. The touch screen makes navigation very sim-
ple, but the absence of a keypad takes some time to get used to.

The phone-PDA combination gives the A388 the extra edge
when it comes to information management. Entering the infor-
mation using the touch screen requires some practice, though the
phone does a decent job at character recognition. The phone can
gulp down a humongous 1000 detailed entries, apart from the
memory space for SMS, e-mails and graphics. It supports six dif-
ferent e-mail accounts, using nearly all protocols such as POP3,
IMAP, etc. It offers neat calendaring options, a calculator, to-do list,
call history,plus it lets you download Java-based applications.

It has an IrDA port and a serial cable for data communication
with a PC. It is also GPRS-enabled for faster data transfer. 

During the test we noticed that the phone can either be used
as a PDA or a phone and not both simultaneously, which is the
biggest drawback. The signal reception and the voice clarity were
fairly good. At Rs 19,995, it is a decent deal, especially when you
think it as a combo and not as just a cell phone.

and a terrific price, at just Rs 9,795 it gives the most bang 
for the buck. The C350 has rivals in the form of the Sony 
Ericsson T310, which —apart from the same features—
provides an IrDA port, WAP 2.0 support, and is also priced some
where around Rs 9,500. The deciding factor between them are 
the looks.
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The Motorola V70 is quite stunning: the small, compact silver
body, white on black display screen, luminescent keypad 

and unique 360 degree rotating keypad cover are certain to 
turn heads.

It sports an elegant menu structure that is simple to
use like the Nokia phones. The keypad layout is
bit odd, with soft menu
keys placed on the
rim of the rotating
bezel, whereas the
navigation key is
placed on the 
keypad, a tedious
arrangement to work
with. Moreover the keypad keys are too
small. The small LCD display is also bit dif-
ferent the text appears white on a black dis-
play and the contrast offered is not up to
the mark. Due to its small size, only two
text lines can be displayed making reading
long SMS messages cumbersome.

Motorola V70 CCPrice: Rs 16,995

The V66 sports an ultra-compact design with a foldable earpiece
that contains the display LCD. The phone is small enough to be

hidden within the palm. The three line LCD display is
crisp and clear, especially when the white backlight

is switched on. 
The V66’s minimal size, however, forced

Motorola to sacrifice a lot on the practical func-
tionality and usability. The buttons on the key-
pad are recessed and hence are quite difficult to
operate when you want to dial a number quick-
ly. The navigation keys also suffer 
from the same problem—the usability of 
the soft menu keys is further hampered by the
small size.

The menu structure is simple and easy
to use due to the presence of four-way nav-
igation buttons and two soft menu keys.
Despite its small size the V66 isn’t short on
features. The phone has an address book
capacity of 500 and a calendaring option
with date book that gives a weekly view.
It has voice dialling and ability to record
a one minute voice memo. Many cus-
tomisation options are available, where-
in one can personalise the  32 ring tones,
assign them to a group etc. The phone

also supports animation—the cursor moves
smoothly to the next menu rather than jumping.

WAP 1.1, and GPRS provide connectivity. On the performance
chart, the V66 produces decent performance with good speech qual-
ity and acceptable signal reception.

The V66 costs Rs 10,495, which is quite expensive considering
the features offered. One would rather opt for the C350, which offers
all the features at a lower price with a colour screen.

Motorola V66 BBPrice: Rs 10,495
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The V70 lacks features when compared to the Sony T68i or
the Nokia 6510. You’ll find a calendar, a currency converter, a
calculator, voice-activated dialling, voice-dialling, 64 ring tones
(32 of which are customisable), vibrate mode, two-way SMS,
caller ID, conference calling, three games, and wireless Web
access. The V70 does not have a calendar option, but has a date
book that gives a weekly view of your schedule. This isn’t very
effective to work with, due to the limited screen size. 

The phone supports WAP 1.2.1 and GPRS, and has a Li-Ion
power pack, which provides good battery life—a standby time of
around three days. The signal reception strength is good and the
call quality is acceptable. But when the signal strength does drop,
there is appreciable loss in speech.

Overall, it is a very stylish but not a very practical phone.
One would expect more features for the hefty price of Rs 16,995.
If you want a phone for daily business, which is simple and prac-
tical to use, then overlook this phone. The 5210 cell phones carry the ruggedness introduced by

the 5xxx series of Nokia cell phones to new levels. This is
the only phone that has a rubberised protec-
tive shell, which to a certain extent, makes
the phone water and dust resistant.

The 5210 comes in a burnt orange
and pastel blue rubber casing, giving the
phone its distinct identity and an
aggressive character. The keypad lay-
out is good with ample spaces
between keys. The only problem
with the keys seems to be the power
button, which has to be pressed
with all your might., The naviga-
tional keys also require additional
force. The four-way button navi-
gation buttons make menu
browsing simpler. 

The menu structure is very
simple and effective and brows-
ing through it is a breeze as the
shortcuts let one jump directly
to the required sub-menu by
pressing a combination of
keys. It sports a high-resolution
LCD display, capable of display-
ing four lines of text, with a pastel
orange backlight.

This phone has been available for over a year now, and the
ageing is prominent. The 5210 has a 250 capacity address book,
and call registration showing the last 20 dialled, 10 received
and 10 missed calls. It has support for long messages and also
supports the SMS chat feature. It comes with an in-built PIM
functionality, though the calendar view is restricted to only
two weeks at a time. This can be frustrating if you use the cal-
endar frequently. 

The phone comes bundled with five games, a ring tone 
composer, stopwatch, count down timer, calculator with cur-
rency converter, a thermometer and an inbuilt IrDA port for
data transfer. It has a decent standby time of 3 days. As with
all Nokia phones, the signal reception is good and voice clar-
ity is excellent.

The only drawbacks are the outdated features and the price.
Even after one and half years, the phone still sells at Rs 10,899.
This is expensive, when compared to the features that a phone
such as the Sony Ericsson T310 offers for a lower price.

Nokia 5210 BBPrice: Rs 10,899

With the launch of the 3530, Nokia seems to have gauged the
market reality well. Thus far, we have seen Nokia over-

stretching the life of all their models. But with the competition get-
ting hotter, as Sony Ericsson and Motorola are bringing in colour
phones to cater to the low-end market, Nokia couldn’t afford to
be left behind. The 3530 seems to be the perfect answer to count-
er both, the Sony Ericsson T310, and Motorola’s C350.

Nokia shows its traditional strength of bringing in radical
design ideas for its cell phones, which makes one sit up and take
notice. The 3530 is Nokia’s first colour screen model for the mass-
es. It has the typical characteristics of the 3xxx series—a slightly
elongated body and weighs around 100 grams. The keypad makes

it really stand out from all other Nokia phones,
as well as the semi transparent cover, which
allows the white backlight through certain
parts of the shell.

The 3530 comes with a 4,096-colour
display that infuses life into otherwise
dull menus and icons on the phone. The
colour screen is dimmer, but makes up
for it with excellent sharpness. The rad-
ically designed keypad is the most
responsive keypad on any cell phone
that we have come across in this
comparison. Although it requires
some time to get used to, once done,
it is a walk in the park for any SMS
junkie.       

The menu structure is classic
Nokia, with colours added for
more fun. The menu is browsed
through a four-way keypad. This
phone has the fastest processor
amongst all the smart phones.

With the Sony Ericsson
phones, you have to stare at the

hourglass, but the 3530 jumps to the
next screen in a flash.

The cell phone comes with all the standard 3 series features,
such as SMS Chat, MMS, WAP 1.2.1, calculator, currency 

Nokia 3530 A-A-Price: Rs 9,099

converter, alarm clock etc. Apart from these features, the phone
also supports polyphonic ring tones and Java based applications
that can be downloaded using high-speed data connections, such
as GPRS and HSCSD. Nokia has been considerate enough to provide
a 1000 mAH battery for 5 hours talk time and 13 days standby time.
The 3530 has excellent signal reception and good voice clarity.

The 3530 makes an excellent package with good features and
performance alike. The only drawback is the lack of an IrDA port
for communication. It provides you with all you can ask for—the
usual Nokia features, a good colour screen and a terrific price of just
Rs 9,099.
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Not only does the 6510 pack in all the virtues of the 6xxx
series,  phone but also the best features of all other series,

especially the 8xxx series.
The change that comes to immediate notice is the high-res-

olution screen and the slowly fading in turquoise backlight when
activated. Such backlighting is refreshing, especially after using
the conventional green, which is widely used for all other Nokia
models. The build quality is acceptable, except for a flimsy bat-
tery cover.

The 6510 also employs the same
menu structure as the rest of the Nokia
phones, which is quite simple to use.
The keypad buttons are very respon-
sive, though the navigation buttons
are bit cramped. Feature-wise it is
almost identical to the 8310.

This the best phone when it
comes to calendaring—it comes
with a full monthly or weekly view
for those with busy schedules. The
phone is able to store 500 contacts
along with notes, reminders etc.
the best feature being the ability
to send these notes to other
devices or to other phones via
SMS and infrared. This is a good
way of sharing your informa-
tion with friends and col-
leagues. The phone also sup-
ports voice-dialling, voice-
command and voice-record-

ing, of up to 3 minutes. On the
messaging front, the phone can store up to

150 SMS or 50 picture messages. The overall speed response of
text input is also very fast.

In terms of data connectivity, the phone supports both GPRS
and HSCSD for faster connections. It also supports WAP 1.2.1 for
browsing the Internet, and an IrDA port for data transfer. 

The phone comes bundled with four games for your enter-
tainment, and also a mono FM radio that has 10 presets through
the keypad that saves scrolling through the entire list of chan-
nels. The signal reception and voice clarity were commendable.

If you need a good phone that doubles as a PIM, then 6510
is the phone for you.

Nokia 6510 B+B+Price: Rs 13,599

The 8250 is a spruced up version of the trendy 8210. This
phone has the best set of clothes in the entire Nokia line

up of models. The colour combination, the eye grabbing key-
pad layout and the exhilarating blue backlight, gives the
phone its unique appeal.

The most striking feature is the ergonomic keypad layout.
The navigation keys sport a beautiful butterfly shape or the X-
theme that not only looks cool but is very practical. The keys
are big, raised and provide excellent touch feedback—a boon
for SMS junkies. The menu structure is always the same across
the Nokia models, with a few additions here and there.  

Nokia 8250 B-B-Price: Rs 10,299

The 8250 incorporates many of
the features, such as screensavers
and SMS chat from the 3xxx series
of phones. The phone book, call
registration, etc are similar to
other Nokia models. It doesn’t
come with a full-fledged calendar
option, but supports reminders
and notes. Furthermore, these
notes can be sent via SMS, Infra
red and so on.

The 8250 comes bundled with
four games, good ring tones, a
ring tone composer, picture edi-
tor and FM radio. It is not WAP-
enabled, which takes away from
its appeal. It offers an IrDA port
for faster data transfer between
your PC and phone.

Overall a fantastic looking
phone with all the basic features,

but a price that will make you flinch—Rs 10,299.

The 8310 is a small, compact cell phone that will surely
attract the younger generation. Our review unit sported an

elegant blue and grey outer shell with alternating colours for
the keypad. The use of chrome for menu buttons and the nav-
igation keys give it a retro finish. Nokia has gone a step forward
to include a bright white backlight, which
further enhances the overall appeal.

The phone does not rule the tech-
nology roost, concentrating more on
quality rather than a quantity of fea-
tures. It supports a mammoth 500
address book entries and has a dynam-
ic memory allocation, which lets you
push in more numbers if the names
occupy less space. The phone can also
store up to 150 SMS or 50 picture mes-
sages. It comes with a 35 pre-loaded
ring tones, the usual stopwatch, cal-
culator, currency converter and four
games—including a snow boarding
game, reflecting the phones Finnish
origin.

Features such as WAP 1.2.1 sup-
port, GPRS and HSCSD also make
their way into this phone, not to
mention the evergreen IrDA port.
The inclusion of a mono FM radio into
the set is a refreshing idea and makes it an ideal companion on
the go. 

The best feature is the awesome signal reception. This was
the only phone that displayed full signal strength in our test,
no matter where we placed it—due to which the speech qual-
ity was excellent.

The only bitter taste in this perfect concoction is its price—
It is definitely not worth the price tag. 

Nokia 8310 B+B+Price: Rs 15,599
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Although this phone breaks the Rs 18,000 barrier set for the
Smart phone category, it still finds itself here. This is because

of the limited set of features that this cell phone posseses. We did
not think it appropriate to let it compete with the entrants in the
Also a phone category.

The 8855, by its very look, is targeted towards the upper
segment, business community. Our test unit sported a dull
navy blue facade with a thin chrome finish on the periphery

of the display, and the sides of the phone. The
sliding cover feels flimsy and reveals small,
closely packed, chrome finished keys.

The menu is the very simple to use. The
cramped keypad affects the typing and the
last row of keys are even more difficult 
to work with since the cover comes in 
the way. 

The 8855 looks stunning, but does not
have the features to justify its stratos-
pheric price. It comes with an average
address book capacity of 250 and 100
calendar notes. On the messaging front,
the phone supports SMS but despite
being aimed for the elite, lacks MMS
capability. However, concatenated
messaging is included. The calendar-
ing features are neat with options of

repeating notes—weekly and monthly
view—and it also has the capability of sending

notes and schedules—via SMS and IrDA—further enhances the
PIM functionality.

On the data connectivity front, the 8855 comes with an
IrDA port and an optional cable to connect itself to the PC. The
phone has support for WAP 1.1, but lacks high-speed data con-
nectivity support such as GPRS. The phone comes bundled
with 32 ring tones that can be personalised, a ring tone com-
poser for composing custom tunes, and four games. Priced at
Rs 26,999, it needs a serious price revision to stay in the race. 

Nokia 8855 B-B-Price: Rs 26,999

This cute phone from Siemens tries to break the mould with
attractive packaging and looks. The uniqueness of the C55

lies in its integrated sound system.
As apposed to the previous Siemens models that lacked aes-

thetic appeal, the C55 is miles ahead—the phone has near per-
fect ergonomics and the oval theme gels well with the overall
design cues. The keypad layout, with its plastic keys, is instinc-
tive and has a good touch feedback—a boon for SMS junkies.
The covers, for the first time in a Siemens phone, are inter-
changeable with three simple and elegant hues. The back-
lighting can be changed according to the colour of the cover.

The four-way navigational keypad, again a first time feature
in the Siemens species, is by far the best in its class. The menu
structure remains the same, except for some minor changes,
but with the four-way key browsing makes navigating simpler.
The C55 has a standard high resolution LCD display capable
of displaying four lines of text.

The C55 has enough features to match any other phone in

Additional features for a low price  is rare, but this is exact-
ly what Sony Ericsson offers. The

T310 is a feature packed phone
designed on the lines of the elder sib-
ling the T68i. 

The keypad is smartly laid out
with a small five-way joystick for
menu navigation. Apart from the joy-
stick, two keys are entirely dedicated
to the software menu.

The phone has a bright 256-
colour LCD display that is capable of
displaying five lines of text. Similar
to the T68i, it has an icon-based nav-
igation main menu, wherein all fea-
tures are grouped together under a
particular main menu. The grouping
of menus was the best we have seen
in the entire comparison. Due to the
icon-based approach, it does require
total attention when browsing.
However, shortcut customisation
reduces the searching required in the

Siemens C55 A-A-Price: Rs 9,400

Sony Ericsson T310 AAPrice: Rs 9,995

its class. Apart from the integrated sound sys-
tem, the phone comes with polyphonic
ring tones. It also comes with a sound
recorder, so one can record any sound
and use it as a ring tone or message
alert—try setting a rooster’s call for the
alarm! The phone comes bundled with
two java based games: the remake of
the old Prince of Persia game and
Arachnoids - Galaxy Hero. Both the
games are playable but slightly slow.

The phone comes with a mini-
mal 50 contact capacity, which is a
tad less for this class. It supports up
to 765 characters in the SMS, and
also has support for EMS. The PIM
functionality is very basic with
only reminders and a to-do list.
The other features include seven
profiles, two Java-based applica-
tions and other tid bits such as
calculator, alarm clock, currency
converter and metric converter. 

On the data transfer front, the
phone is equipped with GPRS for faster
connection speed and downloads, and WAP 1.2.1, but lacks
IrDA port or any cable connection for data transfer. The phone
displayed excellent voice clarity and signal reception.

Priced at Rs 9,400, the C55 phone offers an excellent pack-
age with features such as support for Java applications, GPRS
support, polyphonic sounds excellent games and good looks.
But it still can’t beat the price-to-features value of the Sony
Ericsson T310, which apart from these features, also offers a
colour screen, albeit at the same price.

MAY 2003
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This phone has been around for a year, and gives strong
competition to the high-end cell phones, with its features,

performance and terrific price. 
The phone has an aesthetically appealing design that

would set many a heart afire. The use of matt-silver colour for
the body and metallic blue for the bezel
make it stand out. The keypad is
ergonomically laid out with no key
cramping. The menu can be navigated
using the slick joystick, which pro-
vides excellent audible feedback
when pressed or tucked sideways.
Two other soft keys also help in
menu navigation. 

The most noticeable feature of
T68i is the 8-bit colour LCD display,
which displays 5 lines of text. The
256-colour screen has excellent
brightness and gives good contrast
even when exposed to direct sun-
light. 

This phone comes with a mam-
moth address book entry capabili-
ty of 500, apart from the addition-
al SIM capacity. As far as messag-
ing goes, the phone has support for
MMS, EMS, POP3 e-mail client and mobile chat. Similarly
when it comes to data transfer and connectivity, no other
phone offers as much as this phone. The phone has IrDA,
Bluetooth, cable connectivity, WAP 2, GPRS or HSCSD. An
external camera can also be attached to it via the camera port
at the base of the phone. 

The phone also has an excellent calendar and PIM func-
tionality, making it an ideal business companion. It comes
bundled with 8 games, 32 ring tones, good screensavers and
pretty decent themes. All these features provide excellent per-
sonalising options.  

Though the manufacturer claims 12 hours of talk time,
we expect it to be around 6 hours, which is still commend-
able, not to mention a stellar standby time of 320 hrs. The
phone shows decent signal reception but has exceptional
voice clarity with hardly any broken speech or other distur-
bances when talking.

The T68i is an excellent cell phone that will appeal to
people from all spheres of life and, with an aggressive pricing
of just Rs 14,995, leaves all other phones in this category
chewing its dust.

This is the most compact and the cutest phone to make it to our
comparison test. The phone has a two-tone finish and is avail-

able in two colours—Marine Blue and Moonlight Silver. The keys
sport a silver finish with a striking blue backlight, that is visible in
all the lighting conditions. 

The phone has a well-sized, high resolution LCD display that
can display four lines of text, and is lit with a xenon backlight, pro-

ducing pastel blue lighting. The keypad, though
small, in size, is quite effective due to an effi-
cient key layout that gives access to all the
required features with a few clicks. The
menu structure is very simple to navigate
with two dedicated navigation keys and
one menu key. The grouping of various
features in the menu is impeccable—all
the features are where they should be.
The phone has some decent features—a
250 capacity address book, speed dial set-
ting for 8 numbers and ring tones asso-
ciation for 10 names. It supports con-
catenated SMS, group sending, EMS and
SMS chat. It also features PIM function-
ality, where you can switch between a
monthly and weekly calendar view,
assign various types of events to a par-
ticular day and also set alarms for partic-
ular times.

Other frills include a calculator, cur-
rency converter, stopwatch and five excit-

ing games. The signal reception was not up
to the mark—the phone experienced speech loss

and voice breaks in the interiors of our building.
The T600 phone is targeted at the fairer sex and does not have

what it takes to be a business phone. Though it is probably the
smallest phone in the market, it fails to justify the price tag of Rs
9,995 with its limited bag of features. 

Sony Ericsson T600 B+B+Price: Rs 9,995

Sony Ericsson T68i BBPrice: Rs 14,995user interface.      
The phone supports all the latest features such as MMS,

EMS, polyphonic tones and downloadable games. It also sup-
ports WAP 2.0, GPRS and HSCSD, not to forget the IrDA port
that can be used for transferring files between devices. The
phone also supports POP3 e-mail clients for sending and
receiving mails with attachments. The only one thing that is
missing is the PIM functionality, you can insert reminders but
a full weekly or monthly view is absent.

The phone handles speech with aplomb and all in all, is a
feature rich phone for an extremely irresistible price.

■ Samsung failed to send in their products even after continuous
follow ups. 
■ Philips has discontinued all their Fisio models and is scheduling a
launch of new models somewhere in the second quarter of 2003.
■ Though Panasonic has a slew of models on offer, they managed

to send in only the GD55 model, without the charger, due to
which we could not test it. 
■ The first Indian brand V K Munoth did not wish to get their mod-
els tested right now.

Those Who did not Make it
Though we tried to get all the brands for the comparison, some were regrettably left out. 
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Also a PhoneAlso a Phone

The 6100 phone gives you a 4096 colour display and has
the capability of displaying five lines of text. The keypad

has a tactile feel—the four-way scroll pad makes flipping
through the menus and playing games a pleasure. The design-
ers have wisely used the four-way scroll pad to allow you to
access the calendar or the composing message menu by sim-
ply pressing the right or left scroll key. 

The phone book memory can store up to 300 contacts and
150 messages, and if you so wish, you can also save a varying
number of MMS messages, ring tones, images and J2ME appli-
cation using the 725 KB of memory. You also have the 
flexibility of saving an image received as a MMS or saving it
as a wallpaper. 

The phones two pre-installed games,
Chess and Bounce, entertain you, while
one Java application called World
Clock, allows you see the time in var-
ious countries all over the world. 

We were disappointed with the
processing power of the CPU
because it takes a reasonable amount
of time to open and execute Java 
programs. The games bundled are
average and the screen flickers while
playing them.  Since the user is
expected to pay a handsome price 
for this handset, one could expect 
a faster CPU.   

The 6100 has a ‘Wallet’ feature,
that allows you to save sensitive
data such as credit card informa-
tion and use it while shopping
online. With respect to voice qual-
ity, we had a bad experience as
there was a consistent drop in the
reception where the network sig-
nal was weak. In contrast, the Nokia
7650 and the P800 did not face any such problems.
Another strange glitch was seen upon charging —we tried to
recharge the completely drained battery, and within 20 min-
utes the battery indication showed it completely charged.
However, when we tried to use it again, the indication bar
dropped instantaneously. While this could have been an iso-
lated error pertaining to our particular handset, it would pay
to check the battery indicator during a purchase. 

The phone is provided with a Pop-Port that can take on
an external Nokia camera for snapping pictures. 

Overall, a cute looking phone but it needs more features
and a faster CPU to justify its price tag. 

Nokia 6100 BBPrice: Rs 20,099

++  Tri-band, MMS, GPRS and Wallet, good design 
– Screen flickers, slow CPU, low memory, no voice-dialling

This new release from Nokia is built on the Symbian
operating system version 6.1, just like the Nokia

7650. This is a novel looking phone. The keypad is a 
bit of a change, and you will have to figure out which

key is placed where. A five-way scroll
pad, makes manoeuvring

easy. However, one-
handed operation is dif-
ficult, due to the
cramped keypad layout.
Even the top two but-
tons are rather small,
making the contact with
your fingers a bit diffi-
cult. The volume but-
tons have not been
included on the sides. 

On the software
front, it is exactly the
same as the Nokia 7650
except for the addition of
the video recorder and 
the RealOne application.
These applications can be
downloaded for the Nokia
7650 from Nokia’s Web
site. 

The charm of this phone
lies in its price tag, the support

for external memory and the 16 MB bundled stick. The
backlight colour complements the colour of the phone,
for example, the blue phone has a blue backlight. This
could pose a problem for the white coloured phone as
the readability would suffer in daylight. This is where
the Nokia 7650 outsmarts the Nokia 3650, as it has 
a light sensor which controls the back light of the 
phone as per the outside surrounding giving perfect
readability. 

Nokia gives you Bluetooth, however disappoints us
by not supporting headset profiles. Nokia Bluetooth only
works with Nokia phones or its own accessories, defeat-
ing the open standard that is Bluetooth.

The model includes some minor improvements 
such as tri-band support, external memory support,
longer battery life, Web access for XTML sites and a 
completely  new design. 

Overall, the only front that the 3650 beats the 
7650 is extending support for external memory, making
it ideal for power users. 

Nokia 3650 A-A-Price: Rs 23,399

+ Tri-band, quality camera, external memory, support for 
viewing XHTML sites, good battery life
– Odd Keypad layout, poor SIM contact management, 
No cable connectivity.
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The Nokia 7210 is one of the first tri-band phones to 
be released by Nokia, which has  a funky cool and a 

very stylish look. Looks apart, this phone has a feature 
set very similar to the newly released 

Nokia 6100. 
The designers have introduced a 

new keypad layout, which makes it 
difficult to operate. Moreover the 
backlight is white for the corner two
rows, while the middle row has a 
green one, causing readability prob-
lems. We also found the volume   but-
ton too stiff to operate with ease, just 
as the power button. 

The software and user interface is 
no different from any Nokia phone—
Flipping through the menus is not a 
problem thanks to a four-way trans-
parent plastic scroll button. 

The phone book has a memory of
300 contacts and a capacity of 150
messages. In contrast to the 6100, this
one has a faster CPU and we did not
notice any flickering. It also offers an

Infrared, a data cable connectivity option

Nokia 7210 BBPrice: Rs 22,519

++Sleek and stylish, Fast CPU,  tri-band and FM stereo tuner
– Odd Keypad layout, bad backlight,noo  real-time support for e-
mail, no voice-dialling

Nokia India released this phone prior to the 6100. While
the 6100 is targeted at the business segment users 

who want a trendy phone with features
galore, this phone is meant for the entre-
preneur who prefers classic looks. 

The design is also strikingly similar
to the 7210, except for the keypad and
the scroll pad.  The keys are well-placed
and you don’t  need to struggle with
them while dialing numbers or typing
messages. It offers 725 KB of memory,
two games, and a Java application
called Portfolio. Not to forget support
for MMS, GPRS and Infrared. Nokia for-
got to include the CPU of the 7210
hence you may find the phone a bit-
sluggish.

As usual, Nokia does not bundle 
Bluetooth for reasons best known to
them. We do find it strange that a
phone targeted at the business com-
munity can be released without this
particular feature.

Nokia 6610 BBPrice: Rs 16,399

++ Tri-band, GPRS, MMS, FM, well-designed keypad
– No support for Bluetooth, slow CPU, less memory

and GPRS connectivity for the Internet. 
The phone comes pre-installed with one Java application

i.e. the Converter II, which allows you to convert currencies,
temperatures, area, volume, etc. 

The Wallet feature has not been included. Instead, an FM
tuner allows you to tune in to your favourite radio station.
There was no voice drop at all and the integrated speaker-
phone gives you the convenience of talking freely. 

This is quite a stylish phone that offers reasonably good
features but it’s the odd key pad layout that will deter many
from buying this phone. 

Moving a step up in the 7xxx series of phones, Nokia
unleashes the 7250, with an absolute stunning design.

Unlike its younger sibling, the Nokia 7210, this one has well
designed keypad. Like all Nokia colour phones, this one also
has a 4096 colour display, and looks and feels like its prede-
cessor—the major change being the camera that is activated
by pressing the top scroll button. The menu structure is the
standard Nokia fare and just like the
6610, the 6100 and the 7210,
Nokia has pre-assigned shortcuts
to the scroll keys. You can man-
ually assign a function to the
right scroll key of the phone so
that it opens an application of
your choice. The scroll pad does
not pose a problem while navi-
gating menus. However, while
playing games you will find it
uncomfortable to use, as the base
of the pad is small, unlike the 6100
which has a reasonably good scroll
pad.

Even though this phone is bun-
dled with a self-timer camera and two
modes namely Standard and Portrait,
the image quality can be disappoint-
ing. The camera supports a maximum
resolution of 352 x 288 only due to
which images are blurred. 

A rather amusing thing was that
Nokia had initially claimed that this model
has 725 KB of memory—the phone we received had a capac-
ity of 5.2 MB of memory. After its  release, Nokia still claims
a memory size of 3.5 MB dynamic memory for this phone.

Despite being a new release, you cannot send an SMS to a
group or to a distribution list, something that you can do with
the Nokia 6100. It does support MMS and SMS, however, there
is no real-time support for e-mail. This means unlike your

Nokia 7250 A-A-Price: Rs 26,299 
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The Nokia 7650 is the first device running the Symbian OS.
The phone has an integrated digital camera. It uses a TFT

matrix, non touch-sensitive screen that has up to 4,096 colours
to make your pictures look good. The screen does lose some of
its sharpness outdoors, but the contrast can be adjusted and the
light sensor automatically adjusts the backlight. The camera has
three different modes of operation. 

From the view of ergonomics, the Nokia 7650 is one of the well-
designed devices. But the grip could have used a little more atten-
tion—the smooth front panel slips out of your hand easily. More-
over, since the device lacks any sort of a curve, you tend to leave
imprints on the screen, especially while talking. The phone is decep-
tively light and uses a good sliding mehanism for its front panel. 

The menu button on the front panel takes you to the gener-
al menu and the five-way navigation joystick makes manoeu-
vring through it a joy. You can personalise the menu by rear-
ranging it according to your convenience.

The phonebook is expansive, with room for eight different
entries per contact. You can even add details by assigning the entry
a note, or identify it by adding a photo of the person. The poorly
implemented interface makes viewing messages stored in your SIM
card quite a pain—you first have to mark the message, copy it to a
folder in your inbox and view it from there. 

The calendar gives you a daily, weekly, as
well as a monthly view for a complete snap-
shot of your schedules. However, there are
only three event types to which you can set
an alarm. 

The 7650 has a built-in speaker phone 
that allows you to talk and listen from a short
distance.  

You can install applications based on Java
to enhance the functionality of your phone—
everything from zipping and call management
applications, to games can be installed. Howev-
er, if you are the one of those who would like to
install loads of applications, then you will be dis-
appointed as the 7650 supports only 3.4 MB of
dynamic memory with no support for external
memory. The voice recorder allows you to record
sound and forwarding the clip or set it as a ring tone.

On the connectivity front, you can choose
between infrared and Bluetooth connection. How-
ever, basic cable connectivity is not provided. When
we tried to connect it to a Sony Ericsson, the 7650
refused to detect it; However, the Sony Ericsson detected it on a
fly. The voice quality lives up to the high Nokia standard.

It’s a pity that Nokia only upgrades the BIOS and not the
software functionality in the newer versions of its existing model.
Though Nokia India claims to sell this phone with a  830 mAH
Li-Ion battery, we received had a 750 mAH Li-ion battery. 

Overall, this is a phone that has a few path breaking features,
but with its high price tag, it’ll take some convincing before a
prospective buyer will make the leap.

Nokia 7650 A-A-Price: Rs 26,999

You’ve just spent your hard earned money buying
an expensive mobile phone. Ensure you keep the following
points in mind while handling it to avoid long term damage. 
■ In a country such as India, where temperature and humidity
levels are high, your phone may stop functioning in extreme
cases. If this does happen, do not try to open the phone your-
self instead give it to the authorised service centre and they
will do the needful. 
■ Avoid storing or using the phone in dusty, dirty areas as its
moving parts can be damaged.
■ Never forget your cell phone in your vehicle. The heat could
shorten the life of electronic devices, damage batteries, and
melt certain plastic components. Similarly, in cold areas the
phone warms up to its normal temperature and moisture can
form inside it, damaging the electronic circuit boards.
■ Never attempt to open the phone yourself as non-expert
handling of the device may damage it. Avoiding dropping,
knocking or shaking it as rough handling can break internal 
circuit boards.
■ If you wish to knock out the dirt from the cell phones do not
use harsh chemicals, cleaning solvents, or strong detergents
to clean it. Just take a soft moistened cloth to wipe off the
dirt.
■ Use only approved accessories and batteries. Do not con-
nect incompatible products.
■ A new battery usually lasts for 2 years provided that you 
use it in the right way. Never charge the battery unnecessarily,
this reduces the effectiveness of the battery. Ensure that 
you use the specified charger, even this affects the battery 
performance. 
■ If you do not intend to use your mobile phone for a long
time, remove the battery and put in a dry and a cool place.

Dial M for Maintenance

Nokia 7650 or Sony Ericsson P800, which support the POP3,
and IMAP protocol, all this does is use the SMS gateway to
send the e-mail. 

Apart from the usual features that Nokia bundles, this
phone allows you to set an alarm tone either from your ring
tone list, the radio, etc. An all-new feature called Synchroni-
sation has been included, which allows you to synchronise
your calendar items and phone contacts with an assigned
server. However, one thing which really put us off was the
slow CPU speed—juggling through the menus was sluggish.
Imagine the performance when your inbox is full and the
phone is loaded with applications! 

It seems Nokia does not include Bluetooth in phones 
that have FM radio; and this one has FM, hence Bluetooth 
is missing. 

Overall, the 7250 is a sleek and trendy phone with 
a camera, but asks too much money for the features it has 
to offer.

++ Sleek looks, digital camera, 5.2 MB internal memory, FM, GPRS,
MMS
– Low camera resolution, no Bluetooth, no  real-time support for
e-mail, no support for voice-dialling, slow CPU, no photo caller
identity

++ Unique design, ability to install Java applications, support for real
time e-mail 
– Very little memory, poor management of SIM contacts, no cable
connectivity, low battery life, Bluetooth problems ➜
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++ Sturdy display screen, office viewer, browser supporting Java and
CSS, capability of adding external memory
– No support for Bluetooth, GPRS, MMS

This mobile phone is targeted at corporate users and pro-
fessionals who would like to have the functionality of

office applications in a phone. The 9210i is quite big in size
when compared to other phones with similar functionality,
the grip however, is very firm. There are two display screens—
the one on the outer surface is monochromatic and offers a
glimpse at the basic functions of the phone, the other is a
4,096 colour screen on the inside that shows you the various
PDA functions. The flip is that none of the screens are touch-
sensitive. The resulting juggling with buttons takes time. The
buttons are well placed and the white backlight does not hin-
der readability. 

The Nokia 9210i offers a QWERTY keyboard on the 
inside panel, which allows you to type your text and insert
characters. It has a Symbian operating system and a 
whopping 40 MB of memory, out which 16 MB is allocated for
applications. Out of this 16 MB, 6 MB of applications are 
preinstalled, thus only 10 MB of memory remains for personal
use. If you want additional memory, you can add a 64 MB
MultiMedia Card (MMC).

The phone comes with a word processor, a presentation
viewer, and a spreadsheet program. It has an exhaustive cal-
endar, an updated browser with support for Java script, Cas-
cading Style Sheet  offers a better Web experience.  

A voice recorder allows you to record more than 10 min-
utes of voice (depending upon the memory occupied) and a
note application lets you to make some quick notes. 

It’s surprising to see that the Communicator lacks GPRS
and MMS, which most of the newer set of phones possess. 

This phone has good voice clarity—one thing that we did
find amiss was its inability to catch a signal in sensitive areas,
where other models from Nokia performed admirably. Over-
all,this is a phone that provides some excellent functionality
but seriously requires the manufacturer to upgrade the soft-
ware to compete with the upcoming models. 

Nokia 9210i Communicator CCPrice: Rs 37,599
Key to good health

■ Using your phone while driving is a punishable
offence. Let the caller know that you are driving, and suspend
the conversation.
■ You can use a hands-free accessory available, but making use
of this while driving is also an offence under the law.
■ Even while walking, ensure you stand on the side of the pave-
ment while talking over a mobile phone. Avoid using it while
crossing roads as your attention is always diverted during a con-
versation.
■ Always buy cell phones, that are SAR (Specific Absorption
Rate) approved—it is a measure of the rate of absorption of RF
energy in the body—this ensures that the radiations emitted by
them are in the minimal range.
■ Keep the phone away from electronic devices as this causes
EMI (electro-magnetic interference). While travelling in an aero-
plane always switch off the mobile to prevent any sort of inter-
ference with the navigation systems of the airplane. Similar care
must be taken when in hospitals and petrol pumps.

The 8910 comes in a titanium shell that aims to offer maximum
protection. The sliding mechanism is great to use, and is of a

good build-quality. The keys are well laid out, but a bit cumber-
some due to the small size—the last row is particularly more diffi-
cult to get at as the rim of the shell interferes with the accessibili-
ty. This was one of the few phones that carried an exhaustive acces-
sory package with it—an extra battery pack, a desktop charger, a

leather pouch and a headset.
The user may be dissapointed on

the software front, as it neither supports
MMS nor has the facility of concate-
nated messages—you only get the old-
fashioned four line display.  The phone
supports connectivity through Blue-
tooth, as well as Infrared. Phones with
Bluetooth allow exchange of contacts
using this medium—however the 8910
only allows an infrared or SMS transfer.
This phone has a faster processor than
its predecessor, the 8855 and you can
instantly feel the difference when it
opens your filled inbox. It allows you to

store around 500 contacts and 150
messages. 

On the performance front, this
phone provided astounding voice
clarity even when the signal was
at the weakest. All this makes it a
pretty neat phone to flaunt, if you

can afford the price.

++ Titanium shell for protection, range of accessories bundled, fast
processor, GPRS, voice clarity
– Small screen, difficulty in using the keys, no concatenated mes-
sages, no real-time e-mail

Nokia 8910 Natural C+C+Price: Rs 35,499

➜
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Companions for your cell phone
Cell phones are no longer just communication devices; they reflect
the owner’s lifestyle and attitude. This leaves a lot of scope for 
customisation options and pheripherals such as car kits and hands-
free sets. These accessories can be lifestyle defining or simply add-
on kits that enhance and simplify the overall cell phone experience.  

Let’s first look at the various accessories that are available in the
market for a cell phone. These accessories can be classified basically
into functional—those that enhance the usability of the cell
phone—and the non-functional—those that improve its aesthetics.

In the function-
al range of acces-
sories, we have
various options
such as headsets,
music stands,
music players,
external video
cameras, desktop
chargers and 
batteries.

Headsets have
being around for

quite a while now, and they can now let you make and receive
calls without even bringing the phone to your ear—just plug in
the ear piece and your hands are free to do other things while
you receive the call.

For business users who are always on the move, a better bat-
tery life is always an added advantage. But having a spare one on
an especially long trip can be quite a boon. Nearly all manufactur-
ers today provide spare batteries and a desktop charger to charge
them. Nokia even provides different types of chargers and the
ACP 12E charger is the best of the lot, as it reduces the time taken
to charge to 50 per cent.

Similarly, for enter-
tainment purposes, you
get MP3 and FM radio
sets that can be plugged
into your phone. Nokia has
an add-on MP3 adapter for
most of its phones, whereas Sony
Ericsson offers a FM radio kit for
some of its models. Nokia
has recently introduced a
music stand that sits on 
your desktop and lets you
play your music through its integrated speakers. 

With the advent of MMS and support from the service
providers, manufacturers such as Nokia, Sony Ericsson, Motorola
and Panasonic have introduced external cameras for some of their
models. These cameras can be plugged into the Pop-Port and
photographs can be taken using the cell phone. 

Apart from these functional accessories that make you life sim-
pler and more organized, cell phone makers have added flamboy-
ance to their models to appeal to the easily-bored youth. Nokia,
as usual has lead the way—all its models come with inter-change-
able covers. Other manufacturers are not far behind.

Some other high-end models also come in their own leather
carry case for protection from the wear and tear of regular use. 

A Bluetooth car kit lets one control calls,
keeping the hands free for driving

A hands-free headset for Nokia cell
phones that uses Bluetooth technology

Sony Ericsson P800 A-A-Price: Rs 39,995

The introduction of the P800 is the first attempt by Sony
Ericsson to break into the phone and a PDA combination

market. Moreover it is the first Symbian OS v7.0 tri-band hand-
set available. It can display 4,096 colours, and has a small key-

pad that contributes towards conserv-
ing space. Since the phone has a
touch screen, you can flip open and
make use of the stylus, placed at the
side, to operate the various functions

of the phone. You can also detach the
dial-pad and dial with the help of the stylus.
The stylus provided is quite accurate, how-
ever its build-quality is no great shakes
and you tend to loose it, as the grip is not
good. To make navigation simpler you
also have a five-way jog dial. 

It comes with an ARM 9 processor,
that loads applications swiftly.  It has an
audio and video player that lets you
watch MP4 videos and play MP3s. 

However, the video playback is a tad
sluggish.

You can add a vari-
ety of parameters for

your contacts including
images. The calendar provided is

quite functional showing you with a daily, weekly or a monthly
view. However, there are only three types of events, appoint-
ments, reminders, or all-day events. Similarly you also have a
Jotter application that  lets you take notes down. An office appli-
cation viewer is also included, which allows you to view Word
and Excel files. It has SMS, e-mail and MMS functionality to let
you communicate using both text and images. 

The P800 comes with 12 MB of internal memory and a 16 MB
memory stick duo card for storing pictures, ring tones, screen
savers, themes, text messages, songs and third party applications.
The point to be noted here is that the memory stick is propri-
etary, so if you plan to purchase more memory it may be more
expensive than otherwise. 

The P800 includes all the common connectors—infrared,
Bluetooth, data cable—and ships with a USB cradle for recharg-
ing and syncing purposes. The most interesting feature is the
radio-free or flight mode that ensures compatibility with sensi-
tive devices. When you activate this mode, its phone functions
will be temporarily disabled so that you can use the PDA func-
tions of the phone while flying, or in hospitals without fear of
dangerous interference. 

The lithium polymer 1000 mAH battery that comes along
with this phone will allow it to go without charging for around
3 to 4 days of normal usage—extensive usage will drain the bat-
tery very soon.

We recommend this only for a business phone class user,
who is always on the move and will actually make use of the
plethora of options offered. It would be quite a waste of resources
for a casual user.

++ Symbian 7.0 operating system, expandable memory, excellent
PDA functions
– Plastic stylus,small plastic buttons, proprietary memory stick
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What it all leads to…
Although popular, Nokia has failed to win any awards in our test.
The reason for this being that Nokia has not revised their pricing
policy—their models cost nearly the same as they used to a year
ago. On the other hand, Sony Ericsson has come out with models
that are more feature-rich and are priced less than any compara-
ble Nokia sets. 

The Best Value award went to the Sony Ericsson T200—it costs
less than the Nokia 3610 or the 3350, packs in more features than
these competitors and manages to come out looking good too. A
nice blend of the right price and enticing features ensured the
crown that it got.

The Best Performance award went to the Sony Ericsson P800.
With an ARM  9 series processor powering the excellent Symbian
v7.0 OS, this phone gets off on the right foot. It won because it is
an impressive PDA, a truly functional phone device, with support
for external memory, a great screen, wonderful audio and video
capabilities, and Bluetooth connectivity that works flawlessly.

ALIASGAR PARDAWALA, MITUL MEHTA, SANKET NAIK and AHMED SHAIKH

Nokia India Pvt Ltd
Phone: 011-26779000
E-mail: k.sriram@nokia.com

Sony Ericsson Mobile Commu-
nications International AB
Phone: 011-26180808
E-mail: sudhin.mathur@
sonyericsson.com

Motorola India Private Ltd
(Personal Communications 
Sector)

Phone: 0124-2303212 
E-mail: s.sravani@motorola.com 

Alcatel India Ltd
(MPD Division)
Phone: 0124-2455050
E-mail: sonal.thakur@alcatel.co.in

Siemens India
Phone: 022-24987257
Email:
ContactUs@bom4.siemens.co.in

Drop them a line
Personal Organic Assistant
Not satisfied with the plethora of GSM handsets available in
the market? You can have a phone adorned with gold, silver
or even platinum if you wish. VERTU,
an independently run subsidiary of
Nokia has started selling such luxury
phones since 2002 in Asia, Europe and
the U.S. The highlight of such phones
is custom-made software, which will
allow customers to receive and make
calls, contact book, calendar, and of
course, play games. The approximate
cost of such a phone will be around 
$ 21,240. 

The VERTU phones, which are
strictly targeted for the elite segment,
will be built on Nokia’s technology and
some of its parts. VERTU will assemble
and customize the technology to suit
its clients. It will also add exclusive
parts, such as 
high-quality antennae, microphones
and displays, and produce casings
made out of precious metals.

Such phones are to have a special
key on their side, which will allow
clients to connect to a team of operators who have, for exam-
ple, specialised information on travel and entertainment, and
offer assistance in major cities around the world—a personal
assistant of sorts.

The standard kit will come with a charger, portable hands
free set, a CD and a data cable. You can also purchase a key-
pad, if you have the money to shell out. 

Apart from the branded stuff, there are people who are
willing to add diamonds and gold to your phone. Check out
Web sites such as www.aloisson.com, and www.goldcom.org, for
more information. 

Prices mentioned are indicative in nature and are subject to change
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The Olympus C-5050
ZOOM has a black,
rugged body made of

magnesium alloy. This
makes it slightly heavy,
which adds to the feel of a
professional camera. 

When set to Control
Panel mode you get
information about the
camera status on the
LCD screen. You can focus
by viewing the movable LCD
screen or using the optical
viewfinder. 

The camera allows Smart
Media, xD-Picture Cards, as
well as Compact Flash cards
for storing pictures. Two
memory slots—one accepting
either, Type I or II Compact
Flash cards, including the IBM
Microdrive;  the other accepts
either SmartMedia or a xD-Pic-
ture Card. We tested the cam-
era with the 32 MB xD-Picture
Card that came bundled. 

The quality of the photo-
graphs is very good. The pic-
ture quality highlights shad-
ows and brightness very well,
and details are picked up with
great accuracy. In order to test
the resolution, water droplets
on a leaf were photographed.
The results were excellent,
with even the reflections of
the environment visible on
the droplets of water. The
zoom is quite powerful with-

out pixelation and the shutter
speed, aperture size, white bal-
ance and flash type can be
controlled using a button and
the jog wheel. 

The photographs are
transferred to a computer 
via the high speed USB port.
At a tag of Rs 49,995, the 
camera is reasonably priced,
and is ideal for budding 
photographers.

The TravelMate C100
weighs just 1.4 Kg and
measures 9.9 x 8.2 x

1.16-inches. A single hinge
binds the screen to the key-
board. The four-
way scroll key,
located at the base
of the touchpad,
makes scrolling
through long doc-
uments and Web
pages conven-
ient. The touch-
pad is responsive
and the small key-
board is designed for easy
text input.

To switch to Tablet PC
mode, you have to push open
the latches located at the side
of the screen, swivel the screen
clockwise, and fold it back on
top of the keyboard. The
screen orientation has to be
changed to portrait using
either the pre-assigned hard-
ware button or the Tablet and
Pen settings icon. The device
comes with two electronic
pens—a PDA-sized stylus that
is housed in the edge of the
screen bezel, and a regular-size
pen. Both pens have side but-
tons that allow you to right-
click while tapping. The regu-
lar pen also has an eraser in the
form of a second electronic
sensor on the top of the pen.

Based on the Windows XP
Tablet PC edition, the C100 is
easy to carry around and work
on in the Tablet PC mode. You
can use the onscreen virtual
keyboard or input panel to

write text. The
handwriting recog-
nition feature con-
verts this accurately
into editable text

that can be insert-
ed into any
application. 

The two
SmartCards pro-

vided in the kit are
used with the PlatinumSe-

cret software suit to provide
authorised access and
enhanced data security. 

This canditate for the
future of mobile computing is
powered by its aplenty fea-
tures.

Olympus C-5050Zoom
In your eyes

Acer TabletPC
Take a tablet

We test the latest and the best hardware and software products available in the market 

Price: Rs 49,995
Contact: Komal International
Phone: 022-22631366
Fax: 022-22610219
E-mail: indiaolympus@vsnl.com
Web site: www.olympus.com

Price: Rs 1,59,990
Contact: Acer India Pvt Ltd
Phone: 080-5219520/23
Fax: 080-5219535/7
E-mail: ailenquiries@acer.co.in 
Web site: www.acer.co.in

SPECIFICATIONS

113.5 x 79.5 x 69.5 mm, 
5 megapixel, 375 g without
battery, 4 AA or 2 CR-V3 batter-
ies, DC in, maximum resolution
2560 x 1920, Optical viewfind-
er, Auto Focus, image ratio 
4:3 or 3:2, 1/1.8 inch CCD sen-
sor, 1.8 inch TFT colour LCD
display, Digital ESP metering,
spot metering, shutter speed
from 4 seconds to 1/1000 sec-
onds, aperture F1.8 to F8.0, 
self timer mode, 3x optical
zoom, (focal length from 35
mm to 105 mm) supports RAW,
JPEG and TIFF picture formats

SPECIFICATIONS

800 MHz mobile Intel Pentium
III processor, 256 MB SDRAM, 
10.4-inch TFT LCD display, 
30 GB hard drive, two USB
ports, Ethernet (RJ-45),
modem (RJ-11), IEEE 1394
(Firewire), Infrared, optional
802.11b wireless LAN, five
launch keys, four-way scroll
key, built-in microphone and
speakers, SmartCard slot, Type
II PCMCIA slot

Olympus C-5050Zoom

Performance
Build quality
Value for money
Features
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Frontech has brought inte-
gration and compactness

to the fore with the Palm DV.
This digital camcorder can
also be used as a digital cam-
era, a Web cam, a voice
recorder and an external stor-
age device. It comes bundled
with a small tripod, a quick
start guide, a manual, an A/V
cable, a USB cable, 
a sling and batteries. 
The driver CD has the palm
DV manager, Ulead Photo
Express/Explorer, VideoLive
Mail, Windows Netmeeting
and DVD Movie Factory.

The camera has a
1.4-inch LCD display
for easy management. It
is easy to operate—using
the quick start guide—and the
manual explains every func-
tion well. The PalmDV can be
set to operate on different res-
olutions: VGA, 1.3 megapix-
els or 2 megapixels. It has 16

MB SDRAM integrat-
ed, and can store a
maximum of 10 still
pictures or 90 seconds of
video (at 2 megapixels and
high quality), and up to 20
minutes of voice recording.

Stills are stored in the JPEG
format (ranging from a reso-
lution of 640 x 480 to 1600 x
1200, interpolated); video is
stored in the AVI format (at 15
to 25 fps) and voice is stored
in the WAV format.

The Palm DV performed
satisfactorily in the tests, with
no outstanding aspect to it.
One might fumble with delet-
ing pictures or exiting from
the playback mode, as it is not
explained in the manual. The
menu scroll bar is sluggish
and refuses to scroll up and
down at times. When used as

a removable disk, Win-
dows only detected 6 MB

of space, this is unexplained
in the manual.

Another setback is the lack
of a zoom utility, especially
during video recording. The
bundled tripod was cumber-
some to attach, and when we
finally managed, we were left
with a camera that tilted to
one side.

The price is right, it also-
supports 2 megapixels on the
box, although the manual
could use an improvement. It
is still a good buy for its price,
compactness and features.

Price: Rs 11,000
Contact: Jupiter Infosys India Ltd
Phone: 022-22001211
Fax: 022-22001214
E-mail: frontech@bom5.vsnl.net.in
Web site: www.frontechonline.com

SPECIFICATIONS
Tripod stand, camera to TV
audio/video cable, installation
guide, driver + software CD,
quick start guide, neck strap,
two AA size batteries

Frontech Palm DV 
Performance
Build quality
Value for money
Features
OOVVEERRAALLLL
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The K7VTA3 is built around
the VIA KT333 chipset that

combine support for the faster
DDR 333 SDRAM and the
AC’97 audio codec. The moth-
erboard supports the  AMD
462-pin Socket A interface,
with a 100 or 133 MHz DDR
front-side bus, accommodat-
ing the Athlon and Duron
range of processors. 

The motherboard has five
PCI expansion slots, RAID sup-
port and two USB 2.0 ports,
apart from two serial ports, a
parallel port and a MIDI/game
port. It also has a 4x AGP slot
for attaching a graphics card.
There is a Communica-
tions Network
Riser (CNR)
s l o t ,
which can
remotely shift
the computer from
‘standby’ to ‘power up’,
over a network. The compo-
nents on the motherboard are
well placed, with small tabs
near the CPU socket that pro-
tect the board from screwdriv-
er slips during heat sink instal-
lation. There is enough space
between the memory clips and
the AGP slot to avoid incon-
venience during installation.
On the flipside, the ATX power
connector could have been
placed more towards the edge
of the board.

Our testbed was powered
by an AMD Athlon XP 2400+
processor, a Kingston 256 MB
DDR333 SDRAM stick, an IBM
Deskstar 40 GB hard drive, a
MSI GeForce4 Ti4600  graph-
ics card, and a 17-inch moni-
tor. We ran a number of real
world and synthetic tests to get
a clear picture of its perform-
ance. The Ti4600 add-on card
gives the system enough

power to handle high-end
gaming, yielding a more than
adequate score of 222.3 frames
per second, while playing
Quake III Arena at the highest
quality settings and 1024 x
768 resolution, 32-bit colour.
The 3DMark 2001 tested the
Direct3D capability of the sys-
tem, which scored 9643 in the
benchmark run at 1024 x 768
resolution, 32-bit colour. How-
ever, the CPU Index score of
4365 was lower than other
boards.

The installation CD, also
contains some useful soft-

ware such as Acrobat
Reader, PC-

Cilin, CD
G h o s t ,

G e n e s y s ,
Language Genius

and MediaRing Talk.
The ECS motherboard

along with an AMD Athlon
2400+ provides a good solu-
tion for Internet browsing and
content creation. Hardcore
gamers can install a graphics
card to match their needs.
Overall, this is a simple moth-
erboard, a good choice if look-
ing for reasonable quality at a
good price.

Price: Rs 5,500
Contact: Great World tech Pvt Ltd
Phone: 022-23892828
Fax: 022-23879020
E-mail: sales@gtechworld.com
Website: www.ecs.com.tw

SPECIFICATIONS
305 mm x 244 mm, ATX main-
board, Socket 462, VIA KT333
chipset, 3x DDR 200/266/333
slots accommodating a maxi-
mum of 3 GB memory, 5 PCI
slots, 2x IDE connectors, IDE
RAID support, Communications
Network Riser slot, 2x USB 2.0
ports, 2x PS/2 ports, 2x serial
ports, one parallel port, one
MIDI/game port, jacks for
microphone, Line-In and
Line-Out. 
Box Contents: User’s guide,
installation CD, ATA 100 cable
floppy drive cable

ECS K7VTA3 mainboard
An affordable solution

ECS K7VTA3 mainboard 

Performance
Build Quality
Value for money
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The BenQ 4816A is a CD-
ReWritable drive with a

48X read and write speed and
a 16X rewrite speed.

This corresponds to a
rated speed of 7200 KBps
while reading and writing on
CD-ROMs, and a speed of

2400 KBps on rewritable
media. Since the drive uses
BenQ’s trademark Seamless
Link technology there is no
buffer under-run, which
could severely affect the 
performance of the drive. 

The CD tray is quite stur-
dy and comes out smoothly
when the eject button is
pressed. There is also a vol-
ume control, play and skip
button, and a headphone
jack on the front panel. It also
has an analogue, as well as a
digital output connector at
the back. The emergency
eject hole allows you to
unload the disk manually in
the absence of power.

The drive supports differ-
ent writing modes such as
Disc-at-once, Track-at-once,
Multi-session, Packet writing
and Raw writing. The
CRW4816A was tested on a
Pentium 4 2.8 GHz system
with, Samsung 512 MB of RD
RAM and an IBM Deskstar 
40 GB hard disk drive. The 
drive performed reasonably
while reading and writing 
assorted data. 

The ISO and assorted
write speeds are about 20 per

cent less than the best drives
with the same speed specifi-
cations. The CD registration
speed of 12 seconds is a long
time, that needs to be
improved upon. It took 259
seconds to burn a 650 MB
Audio CD, which means an

average speed of about 2600
kbps. This recording time
could have been better. The
Nero average read speed of
37.4X is however comparable
to the best. 

One CD-RW and one CD-
R media are provided gratis
with the drive, along with
Nero Burning ROM. Bundled
with this is an operating guide
for Nero, a users guide and an
audio cable for listening to
Audio CDs. 

Given the satisfactory per-
formance, standard bundled
accessories and reasonable
price tag. The BenQ is defi-
nitely worth a look, if a slight
compromise on performance
is acceptable to you.

BenQ CRW4816A
Write on

SPECIFICATIONS

134 x 39 x 165 mm, 1 Kg, 
read speed 48X, write speed
48X, ReWrite 16X, E-IDE/ATAPI
interface, Seamless Link (buffer
under-run proof), 2 MB buffer
size,  compatible with 
Windows 95/98/ME/NT 4.0/
2000/XP. 
Box Contents: Nero Burning
ROM, Audio cable, 1 CD-R and
1 CD-RW medium, user manu-
al, Nero operating guide

Price: Rs 3,450
Contact: BenQ India Pvt ltd
Phone: 022 - 25705231
Fax: 022 - 25705235
Web site: kamleshsalunke@
benq.com
Web site: www.benq.co.in

BenQ CRW4816A
Performance
Build quality
Value for money
Features
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The latest McAfee VirusS-
can Home Edition

includes many new features,
such as HAWK (Hostile Activ-
ity Watch Kernel), that runs
in the background and moni-
tors activity on your PC. We
tested it on a Pentium 4 2.0
GHz processor on an Intel
D845GEBV2 motherboard,
128 MB DDR SDRAM and a
40 GB Seagate
ST340016A hard
disk drive.

It scans e-
mails for viruses,
worms, scripts
and other mali-

cious code, while remaining
up-to-date by automatically
downloading the latest virus
definition files. A good fea-
ture is the inclusion of a fire-
wall—McAfee Guardian. This
firewall gives detailed infor-
mation regarding the Internet
activity on your machine. It
comes with an easy to use
wizard called Configuration

A s s i s t a n t ,
which lets the
user set up the
firewall in just
five small steps.
S w i t c h i n g
between the

McAfee VirusScan Home Edition 7.0
Fortify your PC

Samsung’s latest VL40 series
hard drive is a compact

version of the old V40 series.
PC users are often dissatisfied
with 20 GB hard drives,  and
look for upgrades. For home
users, speed less important
than capacity, and many will
find this 5400 rpm, 40 GB
drive acceptable. 

The hard
drive was tested
with a 2.8 GHz
Pentium 4
processor, 512 MB
Kingston DDR 333 SD
RAM, a GeForce3 graphics
card and a 40 GB IBM
Deskstar primary hard drive.
The drive to be tested was
connected as the secondary
master with Ultra DMA
enabled for faster access. 

The SV0401H has a low
CPU utilisation of 2.3 per
cent, which prevents strain
and leaves the processor free
for other tasks.

The random read and write
speeds are pretty good, making
it an ideal choice for hard disk
intensive applications, such as
PhotoShop. In the SiSoft San-
dra benchmark, it clocked a
good sequential read speed of
25 MBps and write speed of 24
MBps, for a home user. The
disk gave an average drive

index score of 17334. If
you want to

transfer large
amounts of
data, you

should consider a 7200 rpm
drive.

This drive is a good entry-
level buy as it is very silent and
comes with a three-year war-
ranty. It will suffice for Inter-
net browsing, word processing
and database management.

Samsung SV0401H
Quiet data access

SPECIFICATIONS

0.67 x 4 x 5.75 inches, 0.55 Kg,
5400 rpm, ATA 100 interface, 
2 MB buffer, 512 Bytes per sector

Price: Rs 4,350 
Contact: Samsung India 
Phone: 011 - 5151 1234
Fax: 011 - 5160 8820
E-mail: marketing@
samsungindia.com
Web site: www.samsungindia.com

Samsung SV0401H
Performance
Build quality
Value for money
Features
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Gigabyte technologies
have introduced an opti-

cal mouse, in a move towards
becoming an all-round IT
hardware solutions provider,
working on the strength it has
created in the motherboard
segment. 

The mouselooks good
with its metallic blue and sil-

ver coloured plas-
tic case—a shiny sur-
face that is a trademark of
most Gigabyte products. It is
not too heavy, but is quite
large and fits in the palm
well. The mouse has the stan-
dard two buttons and a ser-
rated scroll wheel, which is
slightly stubborn and has a
response time that is not
ideal for playing computer
games. The mouse has well

designed buttons and three
rubber pads at the bottom to
allow smooth, uninhibited
movement. 

While the scroll button is
a hindrance, the mouse itself
is sensitive. The buttons are
well spaced to prevent acci-
dental clicking. For compati-
bility with older mother-
boards, Gigabyte was kind

enough to provide a USB-
to-PS/2 connector.

The mouse is priced
below the thousand-
rupee barrier and is a

reasonable buy for the qual-
ity it offers. We would defi-
nitely recommend this device
for people looking for an
attractive optical mouse. 

Gigabyte Optical Mouse GM 2C
Giga bites another pie

SPECIFICATIONS

Optical mouse, USB or PS/2
connectivity, 2-buttons with
scroll wheel, Win9x/NT/2000/
Me/XP compatible

Price: Rs 900
Contact: Tirupati enterprises
Phone: 033-22423861/2423868
Fax: 033-25543255
E-mail: mail@tirupati.net
Web site: www.gigabyte.com.tw

Gigabyte Optical 
Mouse GM 2C
Performance
Build quality
Value for money
Features
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The Mouse FP combines
the advantages of an

optical mouse and biometric
security to produce a win-
ning combination. A tech-
nology called Surface
Enhanced Irregular Reflec-
tion (SEIR) and a CMOS
image sensor captures your
fingerprint and displays it on
the monitor for identifica-
tion. The mouse is slightly
larger, sturdily-built
and has great
manoeuvra-
bility. It has pro-
grammable buttons
and a scroll-wheel.

The installation CD
makes the set up process 
easy and orderly. To setup
the process, log on with
administrator privileges (in
Windows 2000 or XP), enrol
your fingerprint, and select a
user ID and logon password.
The software also helps you
to encrypt important folders
on your computer. 

To log on, simply
place your finger

on the transpar-
ent window
that is present
on its side and

the logon com-

Mouse FP
Security at your fingertips

VirusScan and the Firewall is
easy as it has a browser like
interface, with buttons for
navigation.

VirusScan also includes
support for PDA synchroniza-
tion scanning. Thus, it
detects any malicious code,
which tries to gain access
while transferring files from
your PDA to your PC. A new
inclusion in VirusScan is the
Script Scanning utility that
makes your PC more robust
and resistant to attacks by
malicious scripts.   

Priced at Rs 2,500, it’s a
definite buy for the security
conscious user looking for new
antivirus software. There is no
need to buy this if you already
have other virus software.

SPECIFICATIONS

System Requirements:
Microsoft Windows XP, 2000
Pro, Windows Me, or 98, 
32 MB RAM, 61 MB hard disk
space, Pentium 100 MHz
processor, Internet Explorer
4.01 SP2

Price: Rs 2,500 
Contact: Network Associates
Phone: 022-56935278
Fax: 022-26650078
E-mail:custserv_apac@nai.com
Web site: www.nai.com

McAfee VirusScan 
Home Edition 7.0 
Performance
Ease of Use
Value for money
Features
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Price: Rs 2,500
Contact: Abacus Computer Ltd
Phone: 022-22040888
Fax: 022-22872309
E-mail: pankaj@abacusindia.com
Web site: www.abacusindia.com

Mosaic, from Abacus Soft-
ware, promises features

such as multi-language sup-
port, support for popular and
customised keyboard layouts,
a library of 50 in-
built fonts and sup-
port for third-party
fonts. Amusingly,
the actual product
came with just one
font! When con-
tacted, the vendor
informed us that a
buyer has to pay
extra to get addi-
tional fonts and key-
board layouts. This increases
the total cost of ownership.

There is absolutely no doc-
umentation, and the two
pages we received were basi-
cally printouts of the features
listed at the Web site. The help
feature does not work proper-
ly and at times causes I/O fail-
ures and insufficient memory

errors, even though the test
machine had tons of memory.
While a spellchecker is includ-
ed with the software, it does
not have a default diction-

ary—you have to
make your own 
dictionary from
scratch. 

The best thing
about this software
is its inherent sup-
port for laying-out
typed material. The
product failed mis-
erably on almost

every other front. Only if the
bugs are fixed and all the fea-
tures delivered, will this prod-
uct become desirable.

SPECIFICATIONS

System Requirements:
Microsoft Windows 98, 
16 MB RAM, Pentium 100 MHz
processor, 10 MB HDD space

Mosiac
Performance
Ease of Use
Value for money
Features
OOVVEERRAALLLL
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Half cooked Indian curry



65 MAY 2003

Powercom, one of the lead-
ing manufacturers of

power protection products, is
weaving its way into India.
The Powercom Black Knight
UPS is well packaged and
designed, with three power
sockets, a serial
cable to interact
with the computer
and even a tele-
phone cable to offer
surge protection for
your modem. There is no
quick set up guide and the
manual is a bit technical, but
very neatly organised.

The Black Knight is com-
pact and protects all devices
connected to it from power
failures, surges and lightning.
The UPS has an automatic
voltage regulator—that pro-
vides optimal power supply,
and a circuit breaker, that pro-
tects from short circuits and
overloads. The UPS provides
protection for a maximum of
one cabinet, a CRT/LCD mon-
itor and a modem—via a pow-
erful battery—capable of a
cold start and recharging up
to 60 percent, five minutes

after power restoration.
The bundled software,

UPSMON, monitors voltage,
frequency, battery and load
levels. You can also set tim-
ings—such as the time it takes
to shut down after a power

failure, or when its battery
is low on power and
also  schedule a
shutdown. The soft-
ware also maintains
a log, thus providing
details for later

perusal.
Unfortunately, in an

emergency no other device
can be connected to the UPS
as its power cords can be used
only with a printer, cabinet or
a monitor.

Price: Rs 3,650
Contact: Zeta Technologies
Phone: 022-24102288
Fax: 022-24102277
E-mail: tejas@zetaindia.com
E-mail: www.powercom.co.tw

SPECIFICATIONS

Capacity 600VA, 100V to 240V
input  5% (auto sensing), 
Transfer time 2/4 ms, Lead acid
Batteries 3-6 years lifetime, 
6 hours full recharge time, 
25-35 minutes backup time,
6.5Kg, 97x320x135 mm, 
RS 232 interface

Powercom Black Knight UPS
Compute, uninterrupted

Powercam Black Knight
UPS
Performance
Build Quality
Value for money
Features
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pletes instantly. However, there
is a way of bypassing the 
security—logging on in safe
mode in Windows 95 or 98
stops the  drivers from loading,
and gives access to all the files.

It aims to offer decent 
security in a low-security 
environment like that of an
office. With a price tag of 

Rs 9,900, the it finds itself in a
niche product category. 

SPECIFICATIONS

37 x 64 x 128 mm, 150 gms,
160 cm cord, USB connectivity,
less than 1 second verification,
13.6 x 16.2 mm sensing area
with inbuilt CMOS sensor,
includes driver CD, user guide

Mouse FP 

Performance
Build quality
Value for money
Features
OOVVEERRAALLLL

A-A-Price: Rs 9,900
Contact: Print Electronics
Phone: 022-56624555
Fax: 022-24135883
E-mail: darshan@
printelectronics. com
Web site: www.secugen.com 
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This product is primarily
targeted at the home user.

It uses a wizard-based interface
to make movies. Although an
excellent feature for
novices, more expe-
rienced users might
find it tedious.

Creating a
movie is simple—
just start a new
project with the
wizard, choose any
of the three formats
(DVD, VCD or SVCD), and
you’re all set! The Direct to
Disc option in the wizard uses
the DV-In DVD-Out capabili-
ty; you can record from a
camcorder directly onto the
CD or DVD without storing
on the hard disk—though,
without a wireless camcorder
you will be limited to the
length of the connecting wire

to your PC or laptop.
It supports the Windows

QuickTime MOV format,
amongst others and the Photo

Express bundle is an
advantage, as one does
not need additional tools
to burn CD or DVD
labels. At a price of about 
Rs 3,000, this is one of
the cheapest products in
this category. Ulead DVD
MovieFactory 2 makes

movie making fun and 
easy and is recommended 
for novices.

Arena, it clocked 70.1 fps in
normal mode and 28.3 fps in
high quality. This fps score is
just enough for casual gamers,
though not enough for net-
worked gaming. We couldn’t
run Content Creation 2003—it
crashed every time we ran it—
and SiSoft Sandra indicated
that the board is sufficient 
for word processing and Web
browsing.

The MSI 650GLM Combo
motherboard is built on a

Micro-ATX board that fits eas-
ily into your computer cabi-
net. The board has a 478-pin
socket for Pentium 4 proces-
sors, and a  400 MHz front side
bus (FSB) that supports proces-
sors up to 2.6 GHz. The
special feature
of this
mother-
board is that it
supports both SDR
and DDR memory.
There are two slots for each
type allowing for a maximum
of 2 GB of memory. 

It has two USB ports and
an additional USB header,
where extra USB devices can
be connected via the exten-
sion. As the board is small,

there are only three PCI slots
and no AGP slot—you have to
settle for the onboard SiS 650
graphics chipset. The BIOS is
hardwired and will be difficult
to replace in case of a mal-
function. The absence of an
onboard LAN is also notable,

as a LAN card will leave
only two free PCI

slots.
W e

used a Pen-
tium 4 2.2 GHz,

256 MB DDR SDRAM, a
40 GB IBM hard disk on a

17-inch monitor to test this
board. It performed ade-
quately in the   PC Mark 2002
and 3DMark 2001 tests, with
some tests being skipped due
to lack of hardware support.
When running Quake III

Price: Rs 2,800
Contact: Priya Ltd.
Phone: 022-22663611
Fax: 022-2664154
E-mail: sales_bom@priyagroup.com
Website: www.msi.com.tw 

SPECIFICATIONS

Micro-ATX, 400 MHz Front 
Side Bus, 478-pin socket for
Pentium 4, supports 1.7 GHz to
2.6 GHz speeds, SiS 650GL and
SiS 962L MuTIOL Media I/O
chipsets, supports both DDR
and SDR SDRAM (maximum 
2 GB), 3x PCI slots, 2x USB 
2.0 ports

MSI 650GLM COMBO
All-aboard Integration

MSI 650GLM COMBO 

Performance
Build Quality
Value for money
Features
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Price: Rs 2,800
Contact: Micrographics
Phone: 011-22092423
Fax: 011-22099648
E-mail: micrographics@vsnl.com
Website: www.ulead.com

Ulead DVD 
MovieFactory 2
Performance
Ease of Use
Value for money
Features
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Ulead DVD MovieFactory 2
Burns DVDs, not pockets

SPECIFICATIONS

Box Contents: Ulead Photo
Express 4.0, My Custom Edition
Plus, DirectX 8, Windows Media
Player, Apple QuickTime, and
Adobe Acrobat Reader

Spyz is slightly larger than a
matchbox and comes in sil-

ver and metallic blue. It bun-
dles a dog tag and an USB
cable, but oddly, misses the
battery. The software bundle
comprises the Che-ez manag-
er, Arcsoft Photo Studio 2000
and the driver CD. 

The manual explains fea-
tures such as sound beeps, LED
and LCD displays very neatly.
The device can take up to 26
photos in the high-resolution
mode of 640 x 480 pixels, and
107 photos in the low resolu-
tion mode of 320 x 240 pixels.
Other features include a timer
and continuous capture that
turns the camera into a cam-
corder. The Che-ez Manager
also lets you convert frames
into a movie in AVI format.  

The Spyz can also act as a
Web camera when used with
the Che-ez Manager or MS
Netmeeting. However, some-
times the manager does not
recognise shortcut keys such as
the [Alt] + [F4] combination
for closing the program. The
interface is also very basic and

below par. 
The price tag may justify

all the features of the Spyz, but
the management software has
too many drawbacks to ignore.
Also, there is no provision for
an additional memory card.
Although Spyz is difficult to
compare with the other cam-
eras in the market, it’s a better
bet than any other camera
offering this resolution. 

Che-ez Spyz Digital Camera
Say che-ez

SPECIFICATIONS

0.35 megapixel, CMOS sensor,
video clip duration 8 sec (high)
and 28 sec (low); 8 MB SDRAM;
BMP storage format, Lens: 2.8
mm, 6.2 mm; Automatic expo-
sure and white balance; USB
interface; Dimensions: 60 x
38.6 x 15 mm; Weight: 34 gms

Price: Rs 4,995
Contact: Enkay House
Phone: 022-24939835
Fax: 022-24962710
E-mail: janhanvi@enkayindia.com 
Web site: www.che-ez.com

Che-ez Spyz Digital 
Camera
Performance
Build quality
Value for money
Features
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‘Low Disk Space’! Not a great mes-
sage to see one fine Sunday morn-
ing. I had planned to spend the

day tinkering with my computer, and had
begun copying some MP3 CDs I had bor-
rowed from a friend the day before. I con-
stantly swap MP3s, freeware and other
stuff that I download with my friends—
thanks largely, to my always on cable con-
nection. The low disk space error was the
last straw. I decided to change my plans,
and finally get that CD-Writer I had been
planning to buy for some time now. 

My old 32X CD-ROM drive had out-
lived its usefulness and was also giving me
a lot of read errors. With a new CD-Writer,
I could free up a lot of hard disk space, by
archiving the GBs of MP3s, movies and
freeware I had stored. 

After a quick trip to the
ATM, I visited my local hard-
ware guy to check out what
models were available. My
requirements were simple—I
needed an internal IDE CD-
Writing device that was fast
and cheap, made by a reputed
brand and one that included
the latest burning software. I
was hoping the local hard-
warewallah would guide me
to the best model avail-
able. Easier said than
done! I discovered that
there are tons of options
to choose from—there
was LG, Samsung, Plextor,
Yamaha, Iomega, Sony,
BenQ, ASUS, and quite a
few others I had never
even heard of. Speeds
ranged from the latest 52X
to the older 32X write
speeds. Devices that could
write at 48X were the most popular. All of
them included the audio cable, and most
had the interface cable and Nero Burning
ROM as the bundled software. Samsung
even had a combo CD-RW/DVD-ROM
drive that really got me interested. 
Not only would I be able to burn CDs, I
would also be able to play the DVD
movies that some of my friends had! 
I decided to explore further and—as the
TV commercials say—to make sure I got 
the ‘best deal’.

I headed out to the hardware-mandi of
Mumbai, Lamington Road, and asked a
couple of vendors about the options. I dis-
covered that at close to Rs 3,000, the Sam-
sung 48X CD-Writer was the cheapest,
while the Plextor 48X was one of the most
expensive at about Rs 6,500. The Sony
52X was available for Rs 4,100. One of the
dealers here recommended the LG 52X
drive, priced at Rs 3,350. The Samsung
48X combo drive was available at 
Rs 4,800, but the dealer advised me
against it, as it hadn’t got a good customer
feedback. Instead, he suggested that I buy
either a plain vanilla Samsung or LG one,
and opt for a separate DVD ROM drive, as
the total price would approximately work

out to be the same. When I asked
him about other brands

such as ASUS, HP and
Yamaha, I was told that
these had not been
well-appreciated either.
More confused than

ever, I decided to take
a break. 

After a lot of
thought over a cold
drink, I called up a
friend and got the
number of his deal-
er in Andheri, a sub-
urb of Mumbai. I
was in for a shock—
the prices this deal-
er quoted were
significantly higher
than the Laming-
ton Road dealers. It

seems that location mat-
ters a lot, with dealers in
areas such as Andheri, Ban-

dra and Khar quoting higher prices. For
instance, the Sony 52X CD-Writer costs
Rs 5,000 in Andheri, as compared to 
Rs 4,100 at Lamington Road. Similarly,
the LG 48X drive costs Rs 3,800 in And-
heri, as opposed to Rs 3,350 you can get
it for at Lamington Road. 

I went back to the Lamington Road
dealer, and though he did not seem
happy to see me again, he patiently
answered my questions about the media.
On enquiring, I discovered that 52X com-
patible blank media were simply unavail-
able and 48X was the best that could be
obtained. Thus, buying a 52X CD-Writer
would not really help as it would be
slowed by the blank media I used. Fol-
lowing the motto of better safe than sorry,
I dropped my plans for the combo drive
and chose to buy a vanilla CD-Writer.

I decided on the LG 52X/24X/52X
drive, under the assumption that the
52X compatible blank media should be
available soon. Then I would really be
able to churn out CDs faster than you
could say “Burn baby Burn!” Meanwhile
I will have to settle for the burn speed of
the 48X, and the 6 GB of hard disk space
I just freed up.

■ In contrast to spin speed, lower
access times are better. Access
time is more important if you are

planning on running titles where
the information you’re seeking is scat-

tered and not sequential. This informa-
tion can be obtained from the manual
of the drive.
■ The CD-Writer should support over-
sizing and over-burning, as well as tech-
nologies such as Burn Proof. 
■ The writer must support TAO, DAO,
and Multi-Session and Incremental
Packet writing for CD-RW. 
■ Choose a writer that has support for
RAW Writing. 
■ See to it that the drives have the
required bundled software. Check if the
drive is bundled with DOS and Win 3.x
drivers.
■ The higher the speed, the better a
CD-RW will be able to perform, because
the computer will transfer information
to the drive more quickly. Note that
compatible media must be used to take
advantage of this.
■ Confirm that the audio cables and
other cables such as IDE cables come
with the drive.
■ The warranty period for the CD-Writer
should be at least one year.

ILLUSTRATION: Mahesh Benkar

Burning (CD-)ROM
Agent 001 burns for a CD-Writer
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It’s starting off carrier wars all over the country—but can WLL-CDMA services
possibly be the ones to get India connected?

It’s not what kind of network you use, it’s about
what the network can offer you. We’ve all
heard about how the last mile connectivity

can turn out to be hideously expensive. Cell
phones are continuing on their onslaught to
takeover the world, and though it has been several
years since the introduction of cellular commu-
nication services in India, it still hasn’t brought
the vast majority of us Indians closer to a phone.
We still have a very low tele-density. Here comes
the new kid on the block, WLL, (standing for
Wireless in Local Loop), it may be just be our net-
working solution. It’s been touted as the one that
will get one billion Indians connected to a phone
line. The introduction of WLL services has also
highlighted a newer digital communications
technology, the CDMA (Code Division Multiple
Access) wireless technology.

WLL it, won’t it?
WLL is a new communications access method
that uses radio waves for the transmission of
information between customers and service
provider sites (‘the exchange’ or central office).
This is unlike the traditional methods where a
fixed copper or optical fibre line is used to con-
nect the subscriber to the nearest central office.
In the traditional copper-wire setup, the two-wire
connections between each subscriber’s telephone
and the local central office, is known as the local
loop. With the WLL link, the service provider can
avoid the expense of laying out copper cables to
the subscriber’s home. While most urban areas
are well laid out with the requisite cabling, it is
not very hard to implement WLL services in areas
that are inaccessible or remote. This is where the
beauty lies. WLL could step in to provide con-
nectivity in rural areas, as WLL networks are eas-
ier to set up than regular landline networks. With
a WLL network in place, the service providers can
increase the capacity of the network without hav-

ing to dig and layout new cabling. 
Since WLL is a wireless access method that

uses radio waves to connect the subscriber to a
local central office, it can be implemented along-
side a regular PSTN (Public Switched Telephone
Network), or be combined with digital wireless
technologies, such as CDMA (Code Division Mul-
tiple Access) and GSM. The use of a WLL system
alongside a CDMA network has been very suc-
cessful worldwide and for a good reason. Here in
India, MTNL started WLL services in December
2001 and BSNL has been toying with it for quite
some time now. But, what has really made WLL
a buzzword is the entry of telecom biggies, such
as Reliance Infocomm and the Tata group. WLL-
based networks are coming up nationwide and
promise quick and immediate access to telephone
services and cheaper calling rates. They also offer

the likes of broadband and multimeda-rich con-
tent on your handheld, when the upgrade 
to the next generation standards takes place. 
With the WLL link in place, subscribers might
soon have the best of both worlds—a phone on
demand and access to a slew of multimedia-rich
content, making the phone an entertainment
device. As most of the WLL services in India are
being launched on the CDMA platform, we get
the advantage of using the CDMA technology—
a comparatively newer technology than the 
existing GSM standard. 

In the mobile, wire-free world of today, the
dominant technologies are GSM (Global System
for Mobile communications) that started out as
an European standard, and is now commonly
used in Europe, Asia and Africa. The other is
CDMA, which has been implemented in North
America, Japan and Korea. Wireless communica-
tion systems are designed to use the radio spec-
trum to send and receive information through
the air. While the spectrum may appear to be a
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vast and infinite resource, with just
about everybody laying claim to signifi-
cant usable chunks of it, in reality, it is a
scarce resource. The essential differences
in the two systems are in the techniques
of allocation and usage of the spectrum. 

Spread that spectrum
CDMA is a digital wireless technology
that makes intelligent use of the radio
spectrum. For all mobile wireless servic-
es, there is a fine line between the num-
ber of users and their total capacity. It is
a classical problem—you need sufficient
bandwidth to maintain a decent quality
of service, but not so much that it
becomes vastly unprofitable. In order to
make efficient use of the radio spectrum,
multiple access technologies were
designed that divided the allotted spec-
trum by time or frequency, thus letting
a number of users make use of the com-
munications system. The division of the
spectrum on the basis of time is known
as TDMA (Time Division Multiple
Access). Here each user is allotted a time
slot on a specific frequency after  the
expiry of which, the time slot is then
used by another user. TDMA thus tends
to work in a round-robin fashion. 

The other technique used is allotting
frequency-based slots to all the users.
This is known as FDMA (Frequency Divi-
sion Multiple Access). Here each user is
allocated a frequency i.e., a radio chan-
nel that remains in use till the user has
terminated the connection.  Once the
channel is free, it does not get reallocat-
ed or cannot be used by other users to
increase capacity. Hence it tends to be a
wasted resource. The interesting thing
here is that most of the digital wireless
technologies depend on either TDMA or

FDMA, or a combination of both, to
solve the channel allocation problem.
Here is where CDMA comes in—as a
channel allocation system. It doesn’t
divide the spectrum in terms of time or
frequency, instead it allows all users on
a CDMA network to share and occupy
the same frequency, at the same time.
CDMA allows each station to transmit
over the entire frequency spectrum all
the time. The multiple simultaneous
transmissions are separated using cod-
ing, where each conversation is unique-
ly coded and can be understood only by
the party that is called.

CDMA uses a form of the Spread Spec-
trum technology. The principle of Spread
Spectrum theory is the use of a larger
bandwidth carrier wave than is required
to transmit the message signals. The car-
rier waves essentially cloak the message
signals and provide the
required bandwidth to
transmit the message.
Here the narrowband
message signal is
‘spread’ over the carrier
wave and hence the
name. At any given
time all the stations
use the same carrier fre-
quency to transmit at
the same time and are
operating independent-
ly of each other, with
one user having no
knowledge of the other.
To ensure security, each
of the multiple simulta-
neous conversations
are encoded with a chip
sequence or code. The
intended recipient of

the signal performs a time-correlation
operation to detect the specific desired
codeword. All the unsynchronised signals
then appear as background noise. This lets
the recipient home in and lock into the
desired signal, apply the user’s code and
recover the message.

CDMA can be implemented in both
2G and 3G networks—the commercial
deployment since 1995, was pioneered
by Qualcomm, which holds several
patents to components of the technolo-
gy. The 2G implementation of CDMA is
called cdmaOne, and is based on the IS-
95 standard. There are two modified
standards to the IS-95, the IS-95 A and
B. They differ in data throughput, with
IS-95B coming close to 115 Kbps. 

The CDMA architecture
The typical CDMA network architecture
consists of four major components,
namely the mobile phone or the hand-
held, the Base Station Transceiver Sub-
system (BTS), Mobile Telephone
Switching Office (MTSO) and the Public
Switched Telephone Network (PSTN).
The PSTN provides the access to con-
ventional landline phones located in
individual homes and offices. The net-
work topology of CDMA consists of rel-
atively high-powered BTSs that are
strategically located and sufficiently dis-
persed within the region to ensure a
proper quality of service. GSM on the
other hand, uses lots of relatively low-
power transmitters that are clustered
together. Here, the same frequencies are
reused in neighbouring BTSs, unlike in

This is a really interesting way to under-
stand the various methods of channel
allocation, called the Cocktail Party The-
ory. Imagine a large room filled with a
variety of people. The TDMA users are
those who need to use the specific time
slots to say their bits, and they take turns
to cycle around their time slots and con-
verse with each other. In FDMA, the
users are grouped into widely separate
clumps, with each one holding conversa-
tions at the same time, but independent
of the others. The CDMA folks, on the

other hand, are the people who converse
with each other all at the same time. To
differentiate between one another, one
pair in the cocktail party speaks Tamil,
another speaks Hindi, a third speaks
French and so on. The Tamil-speaking
couple just hones in on the Tamil and
ignores everything else as random noise.
The Hindi-speaking couple does likewise,
and so do the French speakers. The key
to CDMA is to extract the desired signal
while rejecting everything else as 
random noise.

The wireless cocktail party

1 The phone is switched off… 
2 The phone is turned on and starts 

scanning for the strongest signal from all BTSs
3 Once it catches a strong signal…
4 The phone pages the MTSO…
5 The MTSO updates the HLR and registers the phone

When you Switch on the Phone

1
2

3
4 5
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GSM where the frequencies are used
with a certain buffer space. This is essen-
tially one of the reasons that CDMA
networks are easier to set up—and this
also has the additional payoff of better
spectral efficiency. 

The BTS consists of a several trans-
ceivers that can simultaneously handle
full duplex communications, and gen-
erally have towers that support several
transmitting and receiving antennas.
The BTS adjusts the transmitting power
of the mobile phones that it services
and takes care of several CDMA call pro-
cessing functions. It takes the digital sig-
nal from the MTSO and encodes and
interleaves it. This ensures redundancy
and takes care of error correction cod-
ing. At this point, the digitised voice sig-
nal is then encoded to separate it from
all the other voice signals. After this, the
encoded signals are channelised or
spread over the entire bandwidth of the
CDMA channel. Finally, the chan-
nelised data is combined into one ana-
logue RF (Radio Frequency) signal,
which is transmitted over the air. The
BTS thus serves as a bridge between all
the mobile phone users in the area and
connects the simultaneous calls via
high-speed cable links or microwave
radio links to the MTSO. 

The MTSO is the nerve centre of the
operations—similar to central offices in
the telephonic system, the MTSO han-

dles all the control processing, and
along with the switching network,
maintains the updated database of sub-
scribers and billing records. The MTSO
also takes care of compressing the digi-
tised speech signals for more efficient
transmission over the scarce radio spec-
trum. This is known as vocoding. To
communicate with other MTSOs, BTSs
as well as the PSTN, the MTSOs use a
switching network that makes the actu-
al physical connection between a con-
sumer on the radio side of the system
and the consumer on the PSTN. The
switching network in turn routes calls,
implements all call features, as well as
stores the billing records and interpret-
ing dialled phone numbers. The MTSO
or Switch also stores the Home Location
Register (HLR). The HLR is the official
database of all the customers on the
wireless system. The HLR may be locat-
ed at another more centralised location,
where several switches can query it. It
generally holds the information about
the phone, its technical parameters, and
the subscriber’s account status. The HLR
also keeps track of whether the phone is
turned on, and if so, which switch is
currently serving the phone. 

When a mobile phone is switched
on, it first scans through the group of
preset control channels, to select the
BTS that beams out the strongest signal.
The mobile phone then registers with

the system to inform that it is up and
ready to send and receive phone calls.
The phone then monitors that control
channel till the signal drops below
usable strength. At this point, the
mobile phone scans all the control
channels in search of the strongest sig-
nal. Since the control channels are stan-
dardised throughout the entire region
or country, all phones scan the same
channels, whilst on standby. 

Hello, operator?
When a telephone call is placed to a
mobile phone, the system checks with
the HLR for the current location of the
phone and pages the phone’s identifi-
cation number—the subscriber's tele-
phone number—over the control
channels. The phone then recognises
the paged message and sends back an
acknowledgement to the strongest BTS.
The MTSO then instructs the BTS to
move the call over to an unused voice
channel, and the BTS then responds by
instructing the mobile phone to move
over to the correct frequency. The
phone acknowledges the transmission
and jumps over to the assigned voice
channel. At this point of time the
mobile phone alerts the subscriber of an
incoming call with a ring. 

When the user of a mobile phone
initiates a call, the initiation request is
sent to the BTS that contains the mobile

MAY 2003

1 The incoming signal reaches the MTSO…
2 The MTSO checks with the HLR for the current location of the phone…
3 It then sends off messages all over the control channels in the area…
4 The phone receives them, and if it is ready to take the call, rings and alerts

the user; Else it doesn't accept the call
5 If the phone can take the call, the connection is set and the conversation

begins

1 The phone messages the MTSO with its own number and
the target phone number

2 The MTSO does a validation check with the HLR
3 As soon as it gets the OK signal
4 The Switch routes the call and sets the connection
5 And the conversation begins
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phone number, the serial number of the
unit and the target telephone number.
The BTS forwards this data to the MTSO.
The MTSO in turn, validates the request
and makes a physical connection
through the switching network, and
instructs the BTS and the mobile phone
user to move over to an unused voice
channel, to allow the conversation to
begin. Often the request may be made
to the PSTN, to make a connection to a
number within the PSTN. Since these
events typically occur within a few sec-
onds, they are not noticeable to the user.

Once a call is in progress, the MTSO
governing the call adjusts the transmit-
ted power of the phone through the BTS
and changes the channel of the mobile
phone and the BTS in an effort to main-
tain call quality as the user moves with-
in the range of each BTS. Since the user
is mobile, the user may tend to weave in
and out of the range of a BTS—when
that happens, a sophisticated switching
technique known as a handoff enables
the call to proceed as the user moves to
the range of another BTS and is handed-
off into another unused voice channel.
This ensures smooth and uninterrupted
service for the user.

The fine print
The advantage of CDMA over the
other technologies is that there
is no specified absolute limit on
the number of users on the net-
work. Rather, the system per-
formance very gradually
degrades for all the users as the
number of users goes up, and
improves as the number of users
is decreased. Of course, if all the users
on the network decide to simultaneous-
ly clog up the network, it will tend to go
down. Also there is the point of spectral
efficiency. CDMA makes maximum effi-
cient use of the available spectrum allot-
ted to it. Moreover, since the message
signal is spread over a wide spectrum,
the resultant signal is more powerful
and offsets the effects of small scale fad-
ing. These features translate to longer
battery lives and talk time for CDMA
users. As with every new technology,
CDMA isn’t without its own set of prob-
lems. Most CDMA services don’t use a
SIM (Subscriber Identity Module) that is
typically used in GSM phone services.
Instead the carrier generally programs
the phones. This means that if you
would want to shift carriers at a later

date, it would be upto your carrier to
have the phone reprogrammed. Anoth-
er point here is that the CDMA con-
sumer base is comparatively less than
the GSM base. This means that your
CDMA service provider today may not
yet be able to provide you the kind of
roaming services that we take for grant-

ed in GSM networks—but
then again, with some of the
biggest names in the industry
pushing for CDMA in India, it
may soon be possible, at least
within India. This is not due
to any technical limitation of
CDMA—it’s all about the geo-
technical politics of the
mobile world. Overall, CDMA

technologies are easier to implement
and maintain. Additionally, one rather
controversial point is that the running
costs of CDMA are lower than than
those of competing technologies. And as
far as the consumer goes, CDMA in its
current form is relatively future-proofed. 

CDMA and 3G
Virtually all of today’s mobile networks
use the second generation, 2G tech-
nologies, or better. Although it sounds
rather exciting, this is nowhere near
what is being promised in the future.
Later in this decade, we could be drown-
ing in world of incredible multimedia
content. The idea is that as most mobile
communication networks move beyond
to the promised manna of 3G, they will
unveil services that could be the literal

equivalent of having broadband on your
handheld. Look forward to seeing full-
blown colour videos, crisp polyphonic
audio and live videophony. It’s already
happening-look at Japan’s NTT-DoCo-
Mo, and South Korea. With the step up
from CDMAOne to CDMA2000 1x
already happening in places around the
world, we could soon be seeing data
speeds of up to 307 Kbps—and if we
look just one step beyond, at the second
phase of 3G, with technologies such as
CDMA2000 1xEV DO (Evolution, Data
Only), we could be looking at speeds of
up to 2.4 Mbps! 

What would this bunch of airborne
goodies get us? If all the carriers had
their way, with 3G, every country on the
planet would turn out to be like South
Korea—all of us would be experiencing
broadband Web access on our mobile
devices, not on our desktops. The
mobile phone isn’t just a phone any-
more; it is evolving into an entertain-
ment centre. With 3G, the carriers are
hoping that we will be playing multi-
player games, querying Google, sending
and receiving e-mail, and sending off
full-colour, full-audio videos to just
about everyone all over the planet! 

It may well be possible. Remember
that within five years of commercial
deployment of CDMA services, the first
3G networks had appeared. The
entrance of WLL and CDMA services in
this country could well be the precursor
to putting India online.

SRINIVASAN RAMAKRISHNAN

In a country of 1 billion potential 
consumers, the carrier war appears to have
just begun. The bone of contention here is
the so-called hybrid WLL services that are
now being rolled out by Reliance Info-
comm and the Tata group. Backed by the
CDMA technology, customers will have
their cake and can eat it too. With super-
low charges being the main attraction to
shifting your carrier, the older GSM-based
carriers are fighting back crying foul over
the charges. The cases have been filed and
are being argued out in the courts. What
this essentially means for the average Indi-
an is that till the GSM,  CDMA, as well as
TRAI (the Telecom Regulatory Authority of
India), get down to resolving their differ-
ences, we are stuck with incompatible or

partially compatible services. 
To add further fuel to the fire, there

appears to be a new technical problem
regarding the co-existence of GSM and
CDMA. GSM operators point out that
CDMA transmissions now affect the quality
GSM services. The controversy has arisen
because the high-powered CDMA trans-
mitters are beaming out pretty close to the
frequencies of GSM services that are com-
paratively low powered. This results in call
drops and poor receptions and not to
mention, overheating of GSM mobile
phones.  The solution appears to be in the
usage of frequency filters that prevent
such leakage—just another petty squabble
or a real problem of incompatibility? Only
time will tell.

It's not all Hunky-Dory

There are
800 million
GSM service
users and 150
million CDMA
service users
globally
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We show you the means to best use two of the
funkiest gadgets in town, the Nokia 7650 and the
Sony Ericsson P800. Send and receive mails, take
photographs, use them as personal assistants and
of course, make the essential phone call or two. A
how-to on two ‘how-cools’

Managing a thousand
words

Clicking on the Camera folder activates the
camera. It can take images in three formats:
Standard, Portrait and Night. You can
change the camera settings by clicking Select
> Settings. Here you can change the resolu-
tion, thus the quality, of the images that the

camera shoots, and
also set the default
name of the image
shot. Keep in mind
that high image
quality costs more
in terms of storage
space.

Snaps taken by
the camera are

stored in the Images folder. You can manip-
ulate, send, upload and move images from
within this folder. Highlighting an image
and then clicking on Select is the way to
these options. You can send a particular
image via an MMS message, via Bluetooth
and via Infrared.
To delete or move
images en masse,
you first need to
mark them up. Do
this using the
Select button.
Once a bunch of
images are
marked, you can
do the needful.

You can also
upload your
favourite snaps to a
Web site and you
can conveniently
share pictures with
friends and family.
Define an image
server by clicking on
an image, choose

Select > Image upload > Upload. Click on Yes
in the next dialog box, this will take you
to the Image Server screen. Here you have
to input the name of your server, the con-
nection through which the 7650 will con-
tact the server (Access point in use), the
URL of the server and personal settings.
Once done, you can connect and upload
pictures to the Web site.

Creating MMS messages
There is more fun to be had with

the pictures taken. MMS or Multimedia
Messaging Service, lets you send and
receive snaps,
music, text and
video all rolled
into one bundle.
Of course, you
need the service
provider to be a
willing accom-
plice. To create an
MMS in the 7650,
head inside the

Messaging folder.
Click on New mes-
sage and then on
Multimedia mes-
sage. In the window
that pops up, type in
the number of the
recipient. You can
add a picture with
the message by

clicking on Insert > Picture, type in the
accompanying text, click the Select but-
ton and choose Send. 

Regular, text-only SMS messages are
also sent similarly. At the New message
option pop-up, choose Short message.
Type in the phone number and the text
message. Note that you can insert pre-
defined templates here. 

Task master
You can set reminders in the form

of to-do lists and calendaring notes within
the 7650. Head to the To-do folder, click on
the Select button
and  choose New
to-do note. Here
you can enter the
subject of the
reminder, the due
date and the prior-
ity of the task that
is to be done. The
tasks can be tagged
or deleted.
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Nokia 7650

More
than

Changing the image
quality of the camera

Sending an image to
another location

Defining a server to
upload images

Creating MMS
messages

Choosing a template
for an SMS message

Sending a task via
SMS or other means ➜
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Similarly the Calendar lets you set
reminders and appointments. Click on
the Calendar folder, pick a date and then
click Select > New entry > Memo. Enter the
subject, and other details to finish the
memo. You can also send this entry to
another person via SMS, e-mail, Bluetooth
and Infrared.

Contacts, done right
Contacts are very important, and

managing information on them even
more so. The 7650 lets you play with con-
tacts in many interesting ways. Enter the

Contacts folder, and
let the fun begin.
You can quickly
search a contact by
keying in the letters
that form his or her
name—this appears
in the text box next
to the magnifying
glass icon. Editing,
calling, sending a

contact a message is all done via the
Options menu. You can also receive a con-
tact or a business card via Infrared, Blue-
tooth, etc.

You can define a group and add any
selected contacts to
it. A group allows
you to send com-
mon messages
(SMS, e-mail, etc),
exchange files,
notes, etc. Select
the Group tab on
the upper right cor-
ner (the icon
denotes three per-
sons). Via the Option menu, choose New
group and give it a name. Click on Select >
Add members. Choose the contacts that you
wish to assign to this group. You can also
rename a group and find out the group
that a particular contact belongs to.

Configuring the phone
The two shortcut keys that flank

the joystick on the face of the 7650 can be
programmed. Head to the Tools > Phone >
Standby mode and customise as required.

For example, you
can assign the left
selection key to
bring up the cam-
era and the right
selection key to
bring up your
Inbox.

The 7650 has pre-
built behaviour pro-
files for different sce-
narios. It can, for
instance, be asked to
silently vibrate dur-
ing meetings using a
Meeting profile,
wherein even the

beeps when keys are pressed can be sup-
pressed, so as to cause minimal distur-
bance and annoyance. You can activate
and personalise these presets from with-
in the Profiles section of the Connectivi-
ty folder.

The 7650 can act as a modem and can
communicate with other Bluetooth
devices, and transfer
data using Infrared.
All of this is found
under the Connectivi-
ty folder. Note that the
Infrared port must be
manually activated
before transmitting or
receiving data, to keep
battery consumption
at the minimum. To configure Bluetooth
capability, click on the Bluetooth icon and
change the options. You can also pair up
the 7650 with another Bluetooth device,
be it a PDA or a PC. This pairing involves
an exchange of passwords, and forms what
are known as trusted devices. Only trusted
devices can communicate using Bluetooth.

The 7650 has some pretty useful tricks
up its sleeve when it comes to managing
calls. Speed dialling is par for the course, but

other tricks involve
the ability to answer
a call by pressing any
key on the unit, the
option of using more
than one phone line,
call barring and call
divert. Enter the
Tools folder, click on
Settings, and choose
the Call settings tab.

Here Turn on Speed dialling. 
You can turn on Anykey answer and

choose which phone line to use, amongst
other things. By activating Call divert—a
call can be diverted to either a voice mail-
box, or to another landline or cell phone
number. Finally you can
decide to divert a call either
when your phone is busy
or if you haven’t answered
the incoming call. You can
also divert all calls, effec-

tively using your phone as a pager.
Back to Speed dialling. Now that we

have turned on this feature, head again to
the Tools folder and click on the Speed
dial tool. The numeric pad simulated here
can be assigned 9 quick dial numbers,
click Select > Assign then select a contact to
associate with a number. That’s it, pressing
the assigned number on the numeric key
will now speed dial your contact.

Surfing the Internet
Connecting to the Internet using a

GPRS service could not be simpler on this
phone. Once you sign up for the relevant
service from your
provider, the latter will
SMS you a configura-
tion script. You need
to simply run this
script and your phone
will be all set to surf
the Net. You can spec-
ify browser settings
such as  font size and
cookies under Tools > Settings, you also need
to specify the Default access point here.
Also note that Bookmarks and cached pages
are to be found inside the Services folder.

Creating e-mails
E-mails can be sent and received

using the 7650. To get started, click on
Messaging > New message > E-mail. You will
need to create a
mailbox. Give it a
name, a default
connection to use
(access point, set it
to your service
provider), Mail-
box type (POP3,
IMAP4) and of
course, choose
security settings such as user name and
password. This should create the box and
you are all set to mail bomb your world,
on the move.

The rest is pretty straight forward if
you have ever worked with a mail client
before—the recipient address goes in the
To field, and so on. You can also attach
files—text, sound, pictures  and multime-
dia at will.

These cell phones come with tools
bundled within CDs. Look within

them to find synchronisation tools and
drivers, the latter specifically if you
wish to use the phones as a modem to
your handheld, laptop or PC

Sending a contact to
another phone or PC

Creating a group
from contacts

Configuring a
phone profile

Configuring luetooth
connectivity

You can divert calls
to another line
from here

You can allow or
deny Web cookies 

Creating and sending
e-mail messages

➜
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Snap it; manage it
Go to the Applications tab, open the
CommuniCam application and head for
the Preferences. As you can see, the
Brightness, the Contrast and the Lighting
settings for the camera can be changed

from here. For
example, click
on the cloud
icon if you are
snapping under
overcast condi-
tions. Once
happy with
these settings,
click on Done to
head to the
Ready screen,
where you can

take pictures. Note
that the camera of

the P800 has a timer option—a delay of
15 seconds-which you can use to take
group photos with or snap a self-portrait.

Snaps taken are stored in the Pictures
folder, here you can manage, view and
send your snaps. You can send a picture
through Bluetooth, Infrared, e-mail and
as an MMS. You can also copy a picture to
an external Multimedia Card (MMC).

Multimedia messages
You can send an MMS message from
within the Pictures folder. Select a pic-
ture and click on Send as > MMS. There are
three tabs on the bottom of the picture,
which let you add contact details and
attachments. Head to the centre tab for
contact information, subject of the mes-
sage, its priority, etc. An attachment in
the form of a document, an audio file, a
video clip can all constitute the MMS
message. Once you are done forming the
message, click on the Send button and
select the appropriate option from the
send or save dialog box.

To view a received MMS message, go
to the Messages folder under the Applica-
tions tab. From the drop down box of the
right-hand, upper corner choose Inbox
and click on the received message. You
can now read the message text and view

the attachments
by clicking on
the second tab
just below the
message.

S imi l a r l y,
you can also
type in SMS
messages; we
suggest calling
the on-screen
keyboard to 

do this.

To-do or not to-do
Turn to the calendar for managing your
time and schedules. Find it under Appli-
cations and Click on Calendar > New.
P800’s calendar gives you daily, weekly,
and monthly views, for better time man-
agement. For our purposes, we will stick to
the daily view. Click on Calendar > New,

choose the type
of to-do task,
specify the time
limit or location,
if any, you can
also tag an alarm
to the task—the
alarm can pre-
cede the event
by a defined
time and you
can choose the
file to play when
the alarm is set
to go off. You
can either input

the text for the task via the stylus or use
the on-screen keyboard to do so.

Staying in touch
Managing contacts with the P800 is a
breeze. Contacts can either be stored on
the phone’s memory or on the SIM card.
Furthermore, you can manage contacts
within folders—such as Business or Per-
sonal—and all contacts are filed alpha-
betically. 

Finding a contact is even easier with
Contacts > Find tool. Also in this menu you
will find means to send a contact to
another folder, to send it as a business
card or to view a received card. Contacts
can be sent via Bluetooth, SMS, Infra red,
e-mail or as MMS.

You can also choose to personalise
your contacts—the personal information
can be edited, special ringtone can be

associated, as can a picture, and so on.
Click on Contacts > Edit to perform these
tasks. To assign a unique ring to a contact,
click on the Ring Tone drop down menu,
set an associated image, click on the third
tab where you can add, remove or change
the picture.

Configuring the phone
The P800 is extensively configurable and
most of its settings can be changed in the
Control Panel tab.
For instance, the
shortcuts visible
when the flip
cover is closed can
be changed from
here. If you have
an external MMC
storage disk, you
can format it from
the Control Panel.
You can change
the wallpaper that
the phone dis-
plays during boot-up, the welcome mes-
sage, assign a screensaver and most
importantly, power saving settings from
within Control Panel > Display. Make sure
that Power Save is active and set at a low
enough time period, and that Light is set to
Auto (this is the screen backlighting).

The P800 can act as a modem; it can
communica t e
with other Blue-
tooth devices
and can transfer
data using
Infrared. All of
this is found
under the Control
Panel > Connec-
tions tab. The
Infrared port
must be manual-
ly activated
before data
exchange to save on battery consump-
tion. To configure Bluetooth capability,
click on the Bluetooth icon and change
the options, making sure that the opera-
tion mode is set to Auto. You can also pair

Sony Ericsson P800

You can remove the physical flip
completely and work with a virtual,

on-screen one by clicking on Control
panel > Flip removed under the
Device tab

The P800 has a proprietary slot
that can take 16 MB external storage

cards (MMC). This is in addition to the
14 MB free memory that the phone
comes with

Configuring the camera
for lighting conditions

Creating a MMS
message

To-do notes can have an
aural reminder
alongside

Contacts are
alphabetically arranged

The power settings can
be configured from here
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up the phone with
another Bluetooth
device—be it a PDA
or a PC. This pairing
involves an exchange
of passwords, and
forms what are
known as trusted
devices. Only trusted devices can communicate via Bluetooth.

Web surfing
The Web browser can be activated from within the Applications
tab (it is called Internet). Here you can open a Web page, add a
bookmark, or change browser preferences. 

Connecting to the Internet is sim-
ply a matter of running a configura-
tion script that your service provider
will SMS to you when you sign up. To
change or view details of your Net
setup, head to the Control Panel and
click on Internet Accounts. Here, you
can add or remove accounts or edit
information pertaining to accounts
present on your phone. Click on the
Edit button to do so, this will bring up
a Settings window. Your username and
password will go in the Server tab of
the Settings window, IP address can be
auto-fetched or manually set in the

Log-in tab (depending upon the service provider), and if you
need to use a proxy server, it goes into the Proxy tab. 

Jotting it down
The Jotter is a fun utility that can be surprisingly useful. For the
artistically inclined it can be used as a rough scribble pad to
note down musings
or to sketch muses.
For the rest of us it
can be a handy-
dandy utility to bring
direction to the lost
sheep. It is found
under the Applica-
tions tab. There are
icons lining the bot-
tom of the screen, the
first one looks like an
earmarked note—you
can type stuff here, or use the stylus to write a note as text. The
second icon, that of a scribbling pencil is where the real fun
lies—you can also change the font and point size of text typed
as well as the brush size and the colour used.

Access the Jotter menu to uncover that you can send what
you scribble in Jotter to others. Wouldn't it be great if you
could mail your friend visual directions to the theatre where
the movie is showing this evening? You can do just that. Scrib-
ble, scribble, scribble (you can also erase what you don’t 
like, click on the third icon). Once satisfied with your 
skills, head to the Jotter menu and send the note as a PC Mail
or an MMS!

AHMED SHAIKH

Each application has a menu hot
spot on the upper left corner of the

screen. This drop-down menu offers
access to options and allows you to
change application settings

Your phone can
automatically fetch an
IP address

You can use the Jotter to send scribbles
and drawings to others
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The amount of information that’s
available on the Net is staggering.
The most common way of sifting

through it all is to use search engines such
as Google or Lycos, and browse through
the results to find the most relevant links.
When you find pages that you would like
to visit again or keep track of, you can
bookmark them by adding them to your
Favourites. Now, this involves a lot of
work, as sometimes the Favourites list can
contain more than a hundred different

Web sites. Getting the latest from all these
sites, involves a lot of patience, as graph-
ics and large sized pages take some time
to load. Often you have to wait for entire
pages to load and search through
immense amounts of uninteresting text to
find what you need.

Now, imagine a technology that helps
you obtain updated information, on any
subject of your choice, without any effort
on your part-except for a double-click here
or a right-click there. Sounds interesting,
doesn’t it? This kind of a tool called aggre-
gation or syndication that gathers the lat-
est information to bring it to you has been
around for some time now.

What is aggregation?
Aggregation or syndication is a simple con-
cept, where data in an XML (eXtensible

Markup Language) format document stan-
dard called RSS (Rich Site Summary), is col-
lated and displayed. RSS is widely available
today and enables the sharing of resources
and news, easily and quickly.

Web sites such as Google news and
Yahoo! News, use their own aggregators to
crawl the Web and mine the latest news
from around the world. While these news
sites are very reliable, you wouldn’t find
anything here that a regular Web search
couldn’t yield—and you will still have to
do a lot of sifting to get to the most rele-
vant bits. In addition, you will have to
scan through pages upon pages of head-
lines—a list of practically everything that
has happened around the world—to find
the things that are of interest to you. 

Of course, not all of us are general
news buffs. Some of us prefer to get the
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Amphetadesk v0.93.1, Syn-
dirella 0.9b 
and Microsoft .NET 
Framework v1.1. 
Find it on the Mindware CD 

The Internet connects you to information, but can you use it to bring information to you? 
Here's how to get relevant news and information delivered to your desktop

ILLUSTRATION: Mahesh Benkar
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latest happenings in the Linux communi-
ty, the latest trends in fashion or just read
messages from user groups—tastes vary,
and one person’s pleasure is another’s poi-
son. Here’s where a desktop aggregator
comes in to save us from the cacophony of
garbled information that the Internet is.
A desktop aggregator sets you free by con-
trolling your dosage of information to
exactly what you want and need.

Whatever your poison; chances 
are there is someone out there publishing
it in XML format or running a blog on it.
Even if there isn’t, you can build your own
site, and with a few lines of code, syndicate
information from other sites for your areas
of interest on to your Web page.

How does it work for me?
Personalising your syndication require-
ments is easy with software such as
AmphetaDesk, Beaver and Syndirella that
deliver news to you from popular news
sites, or other sites you choose to subscribe
to. These software, known as news aggre-
gators, can deliver a plethora of the latest
news from all around the world to your
desktop, keeping you as informed as a
news anchor for the BBC. What type of
information, and how much information
you get is limited only by your imagina-
tion, your Internet connection speed and
the capacity of your hard drive.

How to?
First things first: You need to choose the
type of aggregator that you are comfort-
able with. There are two basic types—
Web page type and the three-pane type
aggregators. They are named according
to the way they display the news, after
they update and collate the data that you
have opted to subscribe to. This is the
only noticeable difference between the
two types, and mail client users will prob-
ably feel more comfortable with the
Three pane type.

For those who have never used aggre-
gators before, the toughest part is learn-
ing about subscriptions. In order to
receive news updates on your choice of
subjects, you have to find the appropri-
ate XML links. Most sites that provide
content in XML or RSS format, advertise
the fact with little orange XML Buttons.
If you copy the link associated with this
button, and subscribe using your aggre-
gator, you will receive the latest updates
from that site. You might face some
slight problems initially when trying to
find these links, or while subscribing to
them, but a few trial runs later, you will
be well-versed in the nuances of blog
searching.

Most aggregators have a default list
of general news links—ranging from
world news and sports, to the latest on
the XML front and developer news. They
also offer links to various Web sites such
as popular blogs. Look through the list
that is displayed on your aggregator’s
Web site and chances are you will find
what you are looking for right there
instead of searching for it on the Net.
However, if you still want to search for
content, you should look out for XML
buttons on the sites you visit. 

Once you’ve zeroed in on the stuff you
want to keep track of, all you have to do
is subscribe to it via any Web page display
aggregator such as AmphetaDesk. Just run
the installer, extract to a folder location
on your hard disk, double-click on the .exe
file and wait for it to update itself. When
AmphetaDesk is updated, it will open a
locally hosted Web page, with the latest
versions of the default subscriptions. Now
you are free to mould the Web page as per
your preferences, and add or delete sub-
scriptions. To add subscriptions, click on
Add a Channel and choose from the list of
the thousands of popular feeds that are
displayed alphabetically, or add a link to a
known Web address.

Once you have decided on your

choice of subscriptions, click on My 
Settings and personalise the way
AmphetaDesk works. Changing the
refresh rate to the minimum—once an
hour is probably wise for those who want
fast updates and near real-time informa-
tion. Once you have checked all the set-
tings and subscribed to your choice of
links, just sit back and relax, and watch
the information flow into your lap.

Three-pane display aggregators such as
Syndirella, run on Microsoft’s .NET plat-
form. Hence, if you don’t have .NET
installed, you can download the 20 MB
file from www.microsoft.com or by using
Windows Update. Most software have

Some aggregators are Web-based, or can
send news feeds and updates via e-mail.
Others are Web page display or three-
pane display types.
Some other popular aggregators are:
Peerkat: A Web page display type aggre-
gator, that can be found at
http://www.oreillynet.com/~rael/lang/pyth
on/peerkat/
Beaver: A popular three-pane display
aggregator, which can be download at
http://www31.brinkster.com/toolmaker/be
aver.htm
FeedReader: Another three-pane display
type of aggregator, which can be down-
loaded from www.feedreader.com
News Is Free is a Web-based aggregator,
that allows you to build a personal Web
page with feeds of your choice. ww.new-
sisfree.com
Rss2email: A tool for Linux users that can
send news and updates from the feeds
you chose, to your e-mail account. How-
ever, this  is a script that has to be run on
a Unix based server that has 24/7 con-
nectivity—get it at
http://www.w3.org/2002/09/rss2email/

Aggregators Ahoy!

Google News offers news from 4,500 sources

AmphetaDesk’s Web page display style

The AmphetaDesk My Settings page
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their own feeds set as default. As in any
Web page display aggregator, to add more
links, you will have to find news that
interests you on the Internet. Copy the
XML links and paste them in the Add RSS
feed popup and click Download. The soft-
ware then checks the validity of the link,
and downloads the initial feed to display
it. The advantage of this type of aggrega-
tor is that it looks and feels very similar to
Outlook—a convenience for most users.
Another advantage is that feeds can be
kept for later referral. The individual feed
settings include a customisable refresh
time and also an automatic expiry or dele-
tion of feeds after a user-specified time
period.

Where to look
In order to receive updates and interest-
ing articles, you have to first locate Web
sites from where you can subscribe to
news feeds. Syndic8 (www.syndic8.com) is
one such site that hosts links to a variety
of news and information, as well as links
to popular blogs. Using Syndic8, you can
search for topics, blogs and news agencies
that offer you something of interest.
Another such site is Meerkat at
http://www.oreillynet.com/meerkat/, which
allows you to scan through the news
updates and blogs that were posted with-
in the last hour. You can also conduct a
regular search to find interesting infor-
mation. NewsIsFree.com (www.
newsisfree.com) allows you to build your
own Web pages, within which you can
include your choice of updates and news-
feeds. myRSS at www.myRSS.com, also
allows the creation of personal channels,
where a user can select the type of 
feeds that appear on his or her channel. A
highly comprehensive site called 
Moreover.com (http://w.moreover.com/
main_site/solutions/pub_feeds.html) offers
headlines from over 2,500 publications
across the globe.

Where to use
With aggregator software, basic news is just
the beginning. The true potential of user
groups, Web forums or e-mail forums can
be realised with aggregators. If you are part
of a forum or user group, you will under-
stand how frustrating it can be to keep vis-
iting a site to check for updates on a
message board, especially whilst waiting for
a reply to a comment you made. With
aggregators, as soon as
a reply is posted, you
are notified—you
don’t have refresh
pages or check your
inbox for alerts. 
All this obviously
depends on whether
the forum is based on
XML or not, as the
aggregator has to be
able to understand the
updates.

Also, while using
aggregators, you
don’t need to wait for
tiresome graphic-
intensive Web pages
to load. The aggrega-
tors run in the back-
ground and refresh
automatically, thus
saving time to leave
you free to attend to
other business. In a
world where time is
money, every second
saved is a penny
earned, and aggrega-
tors will do just that
for you. 

Being the Net junkies we are, we will
never give up using the Web, and its bil-
lions of pages, to search for the prover-
bial needle-in-a-haystack. In no way will
aggregation replace browsing or surfing
the net, but it certainly makes for a more
efficient way of keeping up with infor-
mation from our favourite and most fre-
quented sites.

ROBERT SOVEREIGN-SMITH

Mark-up language: A mark-up language
is a coding system that is used to describe,
structure and link documents. It is mainly
used for structuring Web-based documents. 
XML: XML, or eXtensible Mark-up Lan-
guage, is a meta-language—language used
to describe another language—that is used
to create a standardised mark-up language.
This is used to create highly structured doc-
uments for distribution over the Web. With
XML, documents can have useful data and
descriptions embedded in them, as all con-
tent is classified and tagged uniquely, thus
allowing Web browsers or XML readers to
easily recognise the document structure. 
RSS: RSS, short for Rich Site Summary is an

application of XML, which reads and sepa-
rates data from an XML document. RSS was
originally developed for Netscape’s My
Netscape Network (MNN), and is used by
aggregators to selectively choose content
from Web pages, based on changes or
updates. RSS is widely used by BBC, CNN,
CNET, ZDNet, Slashdot, Motley Fool, Dis-
ney, Forbes and many more to share news
and information.
Blog: A blog is a Web-based personal log,
which is regularly updated with new informa-
tion on the author’s choice of subjects. The
term Weblogging or blogging was coined in
1997 by Jorn Barger, who maintains a very
popular blog at www.robotwisdom.com.

Jargon Buster

Subscribing via Syndirella
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The eXtended Operating System
Loader (XOSL, available at
www.xosl.org) is a boot manager

that you can use to select between multi-
ple OSes and other boot devices during
system start-up. It is completely free to
use, has an easy to use, graphical inter-
face and can boot into practically any OS
on the planet. Although there are other
tools associated with it such as the Ranish
Partition Manager and SBM, the Smart
Boot Manager, this article will show you
how to setup and best use XOSL.

Remember to keep a bootable floppy
or a bootable CDROM handy. In case
things mess up after you install XOSL,
and you cannot boot into your OS, boot
into a DOS prompt and type FDISK /MBR.

XOSL can either sit on its own parti-
tion or on the Master Boot Record (MBR) of
your hard disk. If you wish to give it its own
partition, ensure that you tag it as an active
one. We will give it the MBR, since it is the
simpler of the two options. We will also
assume that you have Windows 98 as the
primary OS, with Windows 2000 or XP
forming the second OS. Note that you can
also boot into a Linux distribution using
XOSL. Right then, lets get our hands dirty.

Installation: Extract the ZIP file
found on the Mindware CD on to a tem-
porary directory. The package consists of
two directories: Manual and XOSL. You
can take it two ways from here: either
copy the contents of the XOSL directory
onto a bootable floppy; or reboot into
MSDOS mode and take it from there. We
will take the second option, so restart the
PC in MSDOS mode and head for the
XOSL directory.

Note that, in case your primary OS is
Windows 2000 or XP, you should go the

bootable floppy route, install from there
and keep the floppy in a safe place for
future use.

Setting it up: Type ‘install’ at the
command line to start the process up.
XOSL will analyse your system for the par-
titions available, your mouse type and the
maximum resolution that your monitor
can support. Click on the first option
(Install on a DOS drive), note that you can
change the Video mode and the drive you
wish to install to, amongst other things.
Make sure that there is a Yes for the Ranish
partition manager and the SMB. Choose
Start installation, press [Enter], press [Y]
and when it asks to install SBM, press
[Enter]. Press any key to install XOSL onto
your system, press the Reboot button.

POST it: After the POST, XOSL will
throw an initial screen at you. This is
where you configure it to boot your
OSes. Click on the Setup button to do
this, then hit the Add button to bring up
a menu of partitions that reside on your
hard disk(s). Since we are multi-booting
a Windows 98 and a Windows 2000 par-
tition, we will make the selections as
seen in the screenshot. Note that HD0 is

your first hard drive, HD1 the second,
and so on. Give appropriate names to
your boot partitions and click on Apply.
This will create two boot items.

Choose the partition that you wish to
boot from, here we select the Windows
2000 and the Windows 98 OSes located
on the first hard disk—HD0.

The Ranish Partition Manager can be
called from the XOSL screen by pressing
[Ctrl]+[P]. Proceed with extreme caution.

Make sure you have backed up your data
before you use Ranish.

Did you know: XOSL is very config-
urable. You can assign a password to a boot
item for greater security by clicking on the
Password tab. You can also assign each
boot item a Boot key from within the Keys
tab. Click on the Save button, then on
Close. This will take you to the main win-
dow. Here you can click on Preference to
change the resolution, to give Visual
effects (such as adding a wallpaper to the

boot menu), changing the UI colours,
assigning shortcut keys, etc. Change the
options as you see fit, click on Save and
then on Close. Select the OS of choice, and
then click on Boot to start the operating
system. That’s it, you are done!

The Graphics tab allows you to
change the resolution or use wallpaper
amongst other things. To password pro-
tect your boot-up, head for the Password
tab, shortcut keys to common tasks can
be found and changed from the Misc tab

The manual directory where you
unzipped XOSL contains additional help
and guidelines to get the best from XOSL.
We recommend reading the contents of
the CD ROM and the install sub-directo-
ries in particular.

AHMED SHAIKH

Choose the partition that you wish to boot
from, here we select Windows 2000 and 98
OSes located on the first hard disk, HD0

The Graphics tab lets you change the
resolution or wallpaper amongst other things

PC goes to Boot camp

Restart in MSDOS mode to install XOSL

XOSL
Find it on the Mindware CD 



93

insight ■
■ troubleshooting

MAY 2003

Under clocked processor
I have an AMD Athlon 2000+ proces-

sor on a MSI motherboard, with 256 MB
RAM and a 40 GB hard disk. The OS on
my machine is Windows XP. While boot-
ing, the machine shows the processor
speed as 1.25 GHz instead 1.65 GHz.
What is the problem?
Ajit Wakode

As your processor is working at a
lower frequency then normal, you need
to check the settings in your BIOS. On
POST press [Del] to enter the BIOS. Go
to Frequency/Voltage Control. Here you

need to check two values—CPU FSB
Clock and CPU Ratio. Since the AMD
Athlon processor series work on 133
MHz, the CPU FSB clock should be set to
the same. The Ratio value should be set
to Auto. If the CPU FSB Clock is not at
133 MHz, arrange the jumpers as per the

motherboard manual to set the frequen-
cy to 133 MHz.  Go back to BIOS and
ensure that the CPU FSB clock is set at
133 MHz. Restart your machine and
check the frequency at which your
processor is working. 

Cross your BIOS limitation
I have a Pentium III 450 MHz proces-

sor on a 440ZX motherboard, with 256
MB RAM and Windows XP Professional as
the operating system. Recently, I upgrad-
ed to a 40 GB hard disk, but the system
detects the hard disk as a 27.27 GB. What
is the problem?
Sreedharan

Most old motherboards have a limita-
tion for the largest capacity of hard drive
that they can detect. You have a mother-
board that does not support a 40 GB hard
disk, thus resulting in the improper detec-
tion. You should visit your motherboard
manufacturers Web site, and download
the latest BIOS update. A word of caution:
If the update process is interrupted while
updating your BIOS, your motherboard
may be rendered useless.

Visual ache
I run Windows Me and have Microsoft

Visual Studio 6 installed. I have developed
a small application in Visual Basic, but am
unable to execute it. I get an error mes-
sage saying, “Cannot find DAO350.DLL”.
How should I tackle this problem?
Navin

While installing Visual studio, you
may have unselected Data Objects. Rein-
stall Visual Studio using the ‘typical’
option or select Add/remove in the exist-
ing installation and install Data Objects.
You will be able to execute your applica-
tion now.

Days of Cobol
I wish to convert the existing data

from RM Cobol to any other database or
text format. I have the data files but I can’t
make out the file structure. How do I con-
vert it?
Uday Shetty

One way to convert your data to a
text file or a .csv file, is to write a small
program in COBOL that reads the data-
base file and writes it to a line sequential
file. One constraint in this approach is
that you must know the record layout.
You can find the record layout from 

Get your vaccinations here for bogus clock speeds, dirty fans, BIOS flashing, Linux problems, dual OS
installations and much more...

Setup options while installing Visual Studio

The Frequency and Voltage control inside 
the BIOS
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the COBOL source (.cob) files. 
Search for a file named recover2.cob.

When you execute this file (type
runcobol recover2.cob and press [Enter]), it
will dump the contents of an index file to
a binary sequential file. The new file will
be more understandable and you will be
able to extract the data easily.

If you still can’t get the data on your
own, you can also convert your data, at a
price. Data readers and converters auto-
mate the task of converting data to any
other database format.

One such software is available at
http://www.siber.org/sct/datafile/data-view-
er.html.

Clearing the MBR
I have a Pentium III 650 MHz with a

dual boot system, running both Windows
XP and Linux. Recently I manually deleted
both the partitions of Linux—swap and
ext3—but still get the initial dual boot
screen. How can I remove this?
Amit Aggarwal

The solution to your problem is to 
go to MSDOS prompt and type
C:\>fdisk/mbr. This will get rid of the initial
dual boot screen.

World of Linux 9
I have an AMD Athlon XP 2000+

processor on an ASUS A7N266-VM moth-
erboard, with 128 MB RAM, 40 GB hard
disk and onboard graphics (GeForce2
MX). I have GRUB as the boot loader.
When I try to install Red Hat Linux 8.0 on
my system, I get the following warning
message while creating a new partition:
“Warning: Boot partition/may not meet

Faster than the watch
My problem is that I can’t

change the time and date in my
machine. I have even changed the
CMOS battery, but still the prob-
lem remains. I observed that the
second counter was moving fast, as
if it were the microsecond counter. Is
the problem with my BIOS?
Gopi V

If you have not tried changing the
date or time through MSDOS then do
so. Sometimes, Windows causes the
problem leading to a belief that the
CMOS clock is not working.

If your observation about the second

counter is true, then the RTC (Real Time
Clock) in your machine is not working
normally. A number of applications and
games rely on the RTC for time. A faulty
RTC can cause these applications to per-
form abnormally. The only option is to
get the RTC chip replaced at one of the
service centres.

ILLUSTRATIONS: Mahesh benkar

Use GRUB to partition your Linux machine
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booting constraints for your architecture.
Creation of a boot disk is highly encour-
aged.” Below the warning message there
are two options, the first is ‘Modify
Partition’, while the second is ‘Add any-
way’. When I select ‘Add anyway’, the
setup continues and the installation is suc-
cessful. But when I reboot my system and
boot into Red Hat Linux, I get the follow-
ing error message, “Error 28: Selected
item cannot fit into memory. Press any key
to continue...” When I press a key, the
boot menu shows up again. What do i do?
Sanju B Nelli

It seems that you have created a swap
partition that is equal to the size of the
memory you have in your computer (i.e.
128 MB). You will have to create a new
256 MB swap partition. 

To do this, restart your machine and
boot via the Red Hat installation disk 1,
now select Linux rescue, and login as
root. Start the GRUB utility by typing grub
at the command prompt.

Once within GRUB, type root (hd0,0)
and press [Enter]. Check the file system
and partition type values—they should
have ext2fs and 0x83 values respectively.
If not then issue a root (hd0,1) command
and check again. Repeat the exercise till
you find the correct partition.

Once you have found the correct par-
tition type setup (hd0). This will install the
boot loader in the MBR of the hard disk.
Now exit GRUB and restart your comput-
er. You should not get the problem again,
if you still face the problem, then it would
be a good idea to use LILO as the boot
loader and try again.

Bad client service from Windows NT
During the Startup of my PC, I get an

error saying, “Windows Networking:
Unable to load the dynamic link library
msnp32.dll, the system cannot find the file
specified. Some or all, of the following fea-
ture is not available: Microsoft Network”. I
have tried at my best to resolve this but in
vain. I seek your advice to solve this error. 
Anand Jha

This is an error, which relates to a file
named ‘DSClient.exe’ (directory services
client) in Windows NT. This file forms a
part of the security functionality of Win-
dows NT, and automatically installs other
important driver files including
secur32.dll, vredir.vxd, vnsetup.vxd and
msnp32.dll. To reinstall it from your Win-
dows NT CD-ROM, follow this procedure.

Load the Windows NT CDROM and
look for the DSclient.exe file in the CD.
Run the application, which will reinstall
some other driver files apart from the one
you have specified. This will solve your
problem. 

High speed compatibility problem
I have recently upgraded from

Windows 98 to Windows XP Professional.
I installed NFS4: High Stakes. Whenever I
try to run the game, i get an error mes-
sage: “Nfs4 is not a valid Win32 applica-
tion”. Please help me. 
Arvind Madan

Certain applications do not run in
Windows XP, because they were not
designed for it. You can still execute such

applications by right clicking on the
application and selecting the Compati-
bility option. Here you can specify the OS
that needs to simulated. As you have
upgraded from Windows 98 to XP, you
should select Windows 98 in the combo
box. Now you won’t get the error and will
be able to execute the game normally. 
If the game still does not run, try 
reinstalling the software again and/or
updating the driver files. You can get the
latest drivers from the Web site of the 
manufacturer. The latest patch version is
4.50, which is available at http://www.
gamesdomain.com/patches/n/3237.html. 

Playing the graphics game
I have an assembled computer with

Pentium III 667 MHz, inbuilt 4 MB graph-
ics chip and Windows 98 SE loaded.
Recently, I purchased a DVD ROM drive,
but while watching movies, found that
the motion is not smooth. I have been led
to believe that I have to purchase a graph-
ics card. Please suggest a card suitable
only for watching DVD movies, as I don’t
require it for gaming purposes. Secondly,
will high-end graphic cards, such as
Ti4200 or Radeon 9700 pro, improve the
quality of the picture.
SK Biswas

Normally, a DVD movie runs quite
smoothly on the configuration you have
specified. Ensure that there are no mem-
ory or CPU-intensive applications run-
ning in the background. At the same
time, increasing the memory capacity
would be a good option.

For the second question, a high-end

Putting the cart before the horse
I have a Pentium 4 1.6 GHz processor with Windows Me. Whenever I try to install

Windows 98 it shows an error message “already has an upgraded version” and after
the error message the installation stops.
Isn’t it possible to install both
Windows 98 & Windows Me
on different partitions on
the same computer?
Partha Bhattacharyya

Yes, it's possible to install
Windows 98 and Windows Me
simultaneously. But for your multi-
boot system to work properly, you need to
install Windows 98 first, followed by Windows Me. 
Different partitions are not necessary as along as the folder names
are different. Install Windows 98 first and then Windows ME and your problem
will be solved.

Changing the compatibility mode for a
program under Windows XP
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graphics card will definitely boost the video quality in a big way.
Since you want one only for movies, a GeForce2 MX 16 MB card
is a good choice, as it will offer good value for money. What’s
more, you will also be able to play demanding games, such as
Quake III and Unreal Tournament, which may change your attitude
towards gaming.

Remove that Buzz
I recently bought a Toshiba Satellite laptop with a Pentium 4 1.8

GHz, 256 MB DDR RAM, 30 GB hard drive and an internal modem,
running Windows XP. I face with two problems. First, when I use the
modem to connect to the Net, it dials the number properly, but
makes an extra beep when activated. It occurs at regular intervals of
about 3 seconds and the laptop shows the message, “The phone line

is busy”. I have tried changing
the number, the telephone line
and also reinstalled the modem
driver, but to no avail.
I also want to connect this lap-
top to my home PC that has a
NIC and runs Windows XP. I
failed to connect using the NIC
and tried the wizard, as well as
manual  configuration. How can
I solve these problems? 
Jitesh M K

You might have configured
the dialing pattern as ‘Tone’ in
your Dialing Properties. Many
telephone connections still do
not have the facility for Tone

dial. To change the dialing mechanism go to Control Panel >
Modems > Dialing Properties. Now change the ‘Dial using’ to Pulse
dial.
To transfer files from your laptop to your PC, you need to connect
them via a network. You need to have network cards in both, the
laptop and the PC, and connect them with a cross-linked cable.
To create a cross cable, connect pin 1 and pin 2 at one end, to pin
3 and pin 6 at the other end, respectively. As you are connecting
only two computers, further configuration is not required, just
connect the cables and you will be up and running.

Transfer on the move
I have a Mobile with an IrDA port, which I want to connect to

my computer. The problem is, my computer doesn’t have an IrDA
port. Do I need an IrDA port, and what will it cost me? My com-
puter is an IBM Net vista, with four USB ports. 
Chaiatny Sharan

As you do not have an IrDA port on your computer, you need
to get an IrDA device. IrDA devices are external devices that con-
nect to the computer via the USB port or even the serial port. These
devices are available, but expensive and cost about Rs 5,000. If you
are serious about using IrDA, upgrade to one of the latest mother-
boards, which have the infra-red facility. 

Cassettes to MP3
I have many audio cassettes. Is there any way I can convert the

songs on them in to the MP3 format and store them on CD’s?
Rajat

Setting the phone line for Pulse
Dialing
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To do this, you will have to get a Line-
On/Line-Out cable. The cable is connect-
ed from the line-out of the audio player to
the Line-In port of the soundcard. To

record, you should use decent sound
recording software, such as SoundForge or
MusicMatch Jukebox. Once the songs are
on your computer, you can burn them
onto a CD. You can also refer to our Octo-
ber 2002 issue, where we conducted a
workshop on converting audio cassettes
into MP3s. There you will find step-by-
step instructions on how to transfer songs
from a cassette to a PC.

DirectX misbehaving
I have a P4 1.7 GHz computer, 128 MB

DDR RAM running Windows XP. I have a
problem running my games. I tried the
DirectX diagnostic troubleshooting tool,
and found that there is some sort of DirectX
error. When I ran the Direct3D test, a mes-
sage is displayed saying, “You cancelled the
test by pressing a key”, even though I never
touched any key. I installed DirectX 8.1
from one of the earlier Digit CDs, but even
that didn’t help. I tried to repair Windows
XP, which solved the problem, but only for

a few days. I have Windows XP and
Windows 2000, and the problem persists
with both the operating systems. Please
help me solve this problem. 
Suman

Everything depends on the graphics
card you have, and the games you wish
to play. An on-board graphics card is nor-
mally not recommended. As you have a
problem with DirectX, you should be try-
ing installing DirectX version 9 instead of
DirectX 8. You can download it from
h t t p : / / w w w . m i c r o s o f t . c o m / w i n d o w s /
directx/downloads/drx90.asp. 

Send your computing
problems to
sos@jasubhai.com 
or write to Digit, 

D-222/2, TTC Industrial Area, MIDC,
MIDC, Nerul, Navi Mumbai-400 706,
and we may answer it here!

Secure your Outlook Express 
I use Outlook Express to manage my

Hotmail account. As my computer is also
used by others, I want to know if there is
any way in which I can password protect
or hide my inbox from public view?
Sidhartha Mohapatra

Outlook Express does have a facility
to manage users, to access it go to File >
Identities > Manage Identities. Here, you
have two alternatives—you can create a
new identity or use the default identity.

If you create a new identity, you will
have to set up your Hotmail account
again. To secure your identity click on
Properties > Require a password. As soon as
you click the checkbox a window
appears for the new password. Enter
your password and your Outlook
Express is secure. It is important to

remember that instead of the normal
exit, you have to click Exit and Log Off
Identity in the File menu.

Tired fans
I have assembled my own PC, it

consists of a Pentium 4 processor on an
original Intel motherboard with 128
MB SD RAM and a 40 GB hard disk.
One day the computer just shut down
normally, but refused to start up again.
It started after an hour, but hung after
10 minutes. On opening the cabinet, I
observed that the fans (both the SMPS
and the processor fan), were not work-
ing properly. They were starting and
stopping unpredictably. What is the
problem and how do I solve it?
Vijay

You have done a good job of trou-
bleshooting. On first thought, dust seems
to be the culprit—quite often the fan’s
ball-bearings jam due to the dust. As a
result is that the fan doesn’t work prop-
erly and causes the machine to function
abnormally.

If dust isn’t the culprit, get the SMPS
checked by a professional engineer. Since
both fans are behaving unpredictably, the
SMPS might not be able to supply enough
power. If a fan doesn’t work properly, the
temperature in your machine rises, which

in turn causes the machine to act up.
Cleaning the fans and fixing the

SMPS, will solve your problems.

Hard disk: on/off?
I am running Windows Me and have

noticed the option of turning off the
hard disk in Power Management. What
exactly is the purpose of turning off the
hard disk? In what specific cases should
the hard disk not be turned off? What
happens if the hard disk turns off while
an MS Word window is open? Can it
cause any harm to the system?
Bharat Bhatnagar

The main purpose of power manage-
ment is to save power. This benefits us in
two ways—reduced electricity bills and
an increase in life expectancy for periph-
erals. There would be no data loss, even
if the hard disk shuts off automatically.
As soon as you use the system the hard
disk will pick up from where it left off.
One can set the power management to
STR (suspend to RAM) from the BIOS.
This option causes all the data to be
stored in the RAM, and switches off all
the peripherals in the system except the
RAM and the CPU fan. Power Manage-
ment does not harm the machine, in
fact it reduces the strain on the devices
and thereby increases their life. 

Manage identities
and set passwords
to secure your
account in Outlook

FAQs

Convert audio tapes into MP3s using
MusicMatch Jukebox
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Bypass read receipts
To skip read receipts you
need to know which e-mails
request them. To do this, you
need to change the look of
your Inbox. Select your
Inbox and click Field Choos-
er, in the combo box. Select
‘All Mail Fields’, and locate
the ‘Receipt Requested’ field.
Drag and drop this field to
the Inbox window. You will
see an additional column
with the values ‘Yes/Blank’.

Here ‘yes’ means a read
receipt is requested.

To bypass, you have two
alternatives—the first is to
click ‘No’ when such an e-
mail opens. You can make
Outlook remember your
answer for all e-mails that
request read receipt.

Another alternative is to
go to Tools > Options > E-
mail Options > Tracking
Options, and select any of
the three responses—
Always, Never or Ask—that
need to occur when e-mails
with read receipt arrive. 

Printing blank 
calendars
Sometimes you urgently
need a blank calendar for
the week/month. Outlook
lets you do so. It is as simple
as creating a folder and
printing it. Just click on the
Calendar icon and select
New Folder. Key in a name

for the folder and press OK.
Now select the newly creat-
ed folder and print it in the
desired print style.

Move fast
There are some shortcut keys
in Outlook, which are very
helpful while navigating.
Pressing [Ctrl] + [Shift] + [I]
moves you directly to the
Inbox folder and similarly
[Ctrl] + [Shift] + [O] moves
you to the Outbox folder.

Similarly, if you are
working with Calendars and
constantly need to switch
between the weekly and
monthly view, then you can
use the keys [Alt] + [-] and
[Alt] + [=] to do so.

Categorising e-mails
A lot of people do not write
subjects to their e-mails.
There are ways you can
insert the subject, making it
easier to categorise and
manage e-mails even after
receiving them. Just open
the e-mail, click on the sub-
ject line, modify the subject
and save it.

Abbreviated time
If you need to insert the
time anywhere in an e-mail,
Outlook has some simple
shortcuts. For example, to
type 5 pm, just type 5p,
while 6:45 am can be
entered as 645a.

Days at a glance
You can view 1 day, 5 days, 7
days or 31 days at a glance,
in the Outlook calender. It is
also possible to view 2 to 14
days at a glance—any 14
days irrespective of the
month or year.

While in the Calendar

view, press [Alt] + [0 to 9].
For example, if you press
[Alt] + [0], you get a view
that shows the next 10 days
from the current selected
day. Say you wish to plan all
Sundays of the month, click
the first Sunday, press [Ctrl]
and select all the Sundays of
the month.

Forward contact(s)
The simplest way to forward
contacts is to switch your
view to Phone list in Con-
tacts. Select the single or mul-
tiple entries that you wish to
forward, right-click and select
Forward Items. Now, type the

■ tips and tricks

Print a blank calendar by
creating a new folder

Choose to bypass Read Receipts
in the Tracking Options

You can choose to view any
selected date 

MICROSOFT OUTLOOK
Outlook users can tweak and tune to get what

they want, using these tips and add-ins 
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e-mail address of the intended
person and press Send.

Manage PST file size
All the e-mails in Microsoft
Outlook are saved in a single
file with a PST extension. If
you have used Outlook for a
long time, the size of the .pst
file will be large. Keeping the
file down to a manageable size
is a problem. One way to
reduce the file size is to archive
the old items. The archived
items are then moved to
another PST file. But the
archive file size will also
increase over a period of time.

Another way is to create
many data files—one for per-
sonal mail, one for depart-
ment mail, one for company
mail, one for external client
mail, and so on. In this way
the mails will be split over
different files, resulting in
smaller single files.

To make a new data file go
to File > Data File Management.
Press Add to add a new data
file, then select the ‘Types of
storage’ as Personal Folder File
(*.pst), name the new PST file
and press OK. You can now
view the new folder. By
default, it contains a Deleted
Items folder. Now you need to
add sub-folders to store e-
mails in, and create new sort-

ing rules that will redirect your
incoming mails to this folder. 

Add holidays
Marking the holidays on
your Outlook calender will
make it easier for you to plan
around them. Outlook does
have a way to add holidays,
but you will find no entry for
India. To personalise it to
Indian holidays, you need to
modify the Outlook.txt or
Outlook.hol file.

Locate the Outlook.txt or
Outlook.hol file and open
it using word pad. The file

contains a list of holidays—

one per line, grouped by the
country name. Go to the
bottom of the file and add a
new group name—‘India’ in
square brackets, followed by
a number, denoting the
totalnumbe of entries.
Finally add the names and
dates of the holidays you
want to mark.
It should look something 
like this:
[India] 3
Republic Day: 2003/01/26
Independence Day: 2003/8/15
Gandhi Jayanti: 2003/10/2

You can add as many hol-

idays as you want, as long as
you add the proper count
after the square brackets.
Now, go to Tools > Options >
Calendar Options > Add Holi-
days, search for the entry
‘India’, select it and press OK. 

Add-ins
Outlook has add-ins to facil-
itate and automate many fre-
quent tasks. These are easily
downloadable from the
Internet. Here are some of
the more popular ones.

Manage attachments
Attachment add-ins help in
extracting attachments from
e-mails into a folder. Most
add-ins remove the attach-
ments but add a link to the
file in the e-mail. An exam-
ple of one such add-in is
TODI. The add-in and infor-
mation on how to install
and use it is available at

http://www.aufgang.org/koch
/homepage/software/todi.htm

. Auto print
The print add-ins are for
offices that constantly
require to print e-mails. Add-
ins in this category print 
the e-mail as soon as it
arrives. One such add-in 

can be bought at http://www.
sperrysoftware.com

Always inform BOSS
Some organisations pass
about a large amount of cor-
respondence in the form of
e-mails. In such cases, it is
mostly mandatory to mark a
copy to the project or
department head, so that
the progress of the project
can be tracked. Certain add-
ins put in a default e-mail
address, that is added to
every e-mail that is sent,
without the knowledge of
the sender. One such add-in,
called ‘Always BCC’, can be
bought at www.sperrysoft-
ware.com

Time stamp
Sometimes your e-mails take
hours to reach the recievers,
even over an Intranet. There
are add-ins that time stamp
the exact time and date of
when you sent an e-mail. This
helps to keep an exact record
of important e-mails. These
add-ins can be enabled or dis-
abled with a mouse click. You
can get one such add-in from
http://www.sperrysoftware.com/jc
TimeDateSignature.asp 

Mass mail
Mass mailing has become the
new mantra of marketing
gurus, add-ins that enable
Mass mailing from Outlook
are available. The add-ins
vary in the features they pro-
vide—some just help you
send e-mails, while others
help you sort the responses as
well. PC iMail is available at
http://www.prosoftapps.com/
pcimail.htm. It can extract

You can add holidays using the
calender options

Automatically sort your
attachments in to specific folders

Control the PST file size with
Data Management
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addresses from your Outlook
address book. Depending on
your security settings, you
may get a pop up asking for
permission to carry out the
operation or stop it.

Auto zip attachments
This add-in helps to reduce
bandwidth requirements.
Whenever you attach a file
in a new e-mail, this add-in
converts your attachment
into a zip file reducing its
file size, in turn, reducing
the time taken to transfer
the e-mail. One of the add-

ins in this category is bxAu-
toZip from www.baxbex.com.
Before any e-mail is sent,
bxAutozip compresses and
zips attached files.

Reminders via e-mail
Some might wonder about the
uses of e-mail reminders. They
can be sent to yourself, your
colleagues, subordinates, boss-
es, or even friends. Another
advantage is that the
reminders aren’t limited to
Outlook users, as they can be
sent even to non Outlook
users. This add-in is available
at www.sperrysoftware.com.

Access files from home
This is a unique add-in and
perhaps the most exciting.

Once installed it lets you
access any file remotely from
your computer via e-mail.
You just write an e-mail spec-
ifying the path of the file and
you get a return e-mail with
the file as an attachment. It
takes care of the security issue
by allowing you to specify the
return address initially. Thus
whenever a request arrives
the file needed is sent to only
that e-mail addtess. Howev-
er, you should know the path
of the file in advance, as it
does not allow you to view
directory structures.

Auto redirect
Not all companies have a Web-
mail facility, they just provide
POP3 access from com puters,
within the organisation. You
won’t be allowed to access
your e-mail from outside the
company premises. In such a
situation, you need a tool that
redirects your e-mail to a 
Web-based e-mail account,
which will allow you to access
them from anywhere outside
office. One such add-in is
AutoRedirect from IvaSoft
(http://victori. hypermart.net/
autoredirect.html). This add-in

creates a folder within the
Inbox, called Redirect: xyz@
something.com. 

As  soon as you restart
Outlook, it will ask you for
the e-mail address to which
you wish to redirect your e-
mails to. If you drop any e-
mail into this new folder it
will automatically be for-
warded to the e-mail address
you have set. Next, create
some rules in Outlook that
would drop a copy of all your
mail to the redirect folder

created. You can now access
your e-mails through a Web-
mail service. 

If the e-mails are not for-
warded, you might be using
Outlook in Internet Mail
Only (IMO) mode. In this
case you will need another
add-in called redirector2002
to support AutoRedirect. This
add-in is also available at the
IvaSoft Web site http://vic-
tori.hypermart.net/redirec-
tor.html. To check what mode
Outlook is running in, go to
Help > About Microsoft Out-
look, the second line or text
string will tell you which
mode your Outlook is con-
figured in.

Whenever an e-mail is
sent Outlook might pop 

up a message box asking 
for permission to forward 
the e-mail. You can disable
this message box by adding
another add-in from IvaSoft
available at http://www.
express-soft.com/mailmate/
clickyes.html

Auto reply
Replying to each and every e-
mail in your mailbox can take
up a lot of time. Add-ins can
be used to send pre-formatted
responses, depending upon
the content of the e-mail
You can configure the add-in
to search for words such as
resume, bio-data, etc and
instruct it to send a precom-
piled e-mail to the sender.
The add-in is available at
http ://www.nextword.com/
autoReplyprod.htm

SMS
Typing an SMS on your cell
phone can cause eye strain.
With this new plug-in you
can SMS in the form of an 
e-mail, using a persons
mobile number as the e-mail

address. The plug-in is 
available at http://www.
tamingthebeast.net/ringtones/
sms-plugin.htm. However, there
is a fee applicable.

You can redirect company e-
mail to a Web mail account for
easy access away from work

You can automatically Zip
outgoing e-mail attachments

You can use e-mail reminders to
organise your daily schedule

Use the auto reply to answer
your mails when on vacation
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Insert recipients 
quickly
If you send frequent e-mails to
certain addresses, then you
can make use of the ‘Recipient
List’ in Eudora for quick access
to their e-mail addresses. To
add a user to this list, go to
Tools > Address Book. Click on
the desired user and you will
see the entire details for the
selected user. In the Recipient
List checkbox, select Yes. 

Once you have added the
desired users to the Recipient
List, sending e-mail to them
will be much easier. To do this,
right click in the To, Cc or Bcc
box, select ‘Insert Recipient’
and click on the desired user. 

Remove bar while reply
Those who are irritated by the
bar that appears while reply-
ing, there is some good news.
There are shortcut keys to
remove those bars. Select the
lines from which you wish to
remove the bar and press [Ctrl]
+ [.]. If you need to add those

bars again, select the lines and
press [Ctrl] + [Shift] + [.].

Sponsored mode 
problem
The free version of Eudora
available on the Internet is a
sponsored version. Hence,
sometimes you might get an
error message that says
Eudora could not download

ads. To tackle this problem, you
need to locate your Eudora
folder, and go to eudpriv > ads
folder. Delete all files within the
ads folder, and restart Eudora.
The problem will vanish.

Change mail arrival
sound
You can change the sound
played whenever a new mail
arrives by assigning a .wav file
within Tools > Options > Getting
Attention. Click the unnamed 
button, locate the .wav file,
and click Open. Now, when-
ever you receive a mail, your
choice of sound will be played.

Backing up all
Backing up your Eudora e-
mails is as simple as copy-past-

ing. Find the Eudora folder—
it’s location in Windows 98 is
c : \ w i n d o w s \ a p p l i c a t i o n
data\qualcomm\eudora— select
all the files with *.mbx, *.pce,
*.txt and *.fol extensions.
Copy the selected files to a
backup storage device. The
*.mbx, *.pce and *.fol files
relate to e-mails, while *.txt
files contain the address book.

Delete the entire e-mail
Eudora, by default, does not
delete attachments. To delete
both the attachments and the
e-mail, go to Tools > Options >

Attachments. Select the ‘Delete
attachments when emptying
trash’ option. From now on 
e-mails will be deleted in 
their entirety.

Drafts
Instead of typing similar e-
mail body text for commonly
formatted e-mails, such as
responses to standard infor-
mation requests, You can save
general layouts of the e-mails
you most commonly send.
These are saved as ‘Stationery’
in Eudora, and are all ready to
be sent later with minor last
minute changes. To create

new ‘Stationery’, go to Tools >
Stationery, a blank window
will open up. Right click in
this window and select New.
In the composition window,
fill as many fields as you wish,
and save the stationery. Send-
ing the e-mail is as simple as
double clicking a Stationery
item and making last minute
changes, if any.

Mail list
Sometimes, people have more
than one e-mail address. You
can send an e-mail to all a
persons addresses easily by
creating a Mail list. To do this,
when you create a user entry
in the address book, you see a
box stating ‘This nickname
will expand to the following
addresses’, just enter as many
e-mail addresses as you want
and your list is ready.

Hot chillies
Whenever you are composing
an e-mail, Eudora determines
your mood by checking for
specific words in the message.
Depending on the words and 
language used, it checks the
degree of offensive material.
Eudora gives a symbolic rep-
resentation to each e-mail—1
chilly, 2 chillies or 3 chillies—
to represent the type of lan-
guage. As the offensiveness of

You can delete e-mails in their
entirety when exiting Eudora

You can customise the tune that
plays when an e-mail is recieved

EUDORA

For all you Eudora fans out there, learn how to
enhance your e-mail experience

Eudora can gauge your mood
when you type an e-mail
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the language used increases,
so does the number of chill-
ies. To check or change the
settings, go to Tools > Options >
MoodWatch.

Work faster
The fastest way to send e-mail
is to press [Ctrl] + [E] to open
the send e-mail box. 

View all headers
Generally e-mail clients don’t
show all the header fields. To
view all header fields, open
the e-mail and click the ‘BLAH
BLAH BLAH’ button.

Filter on nick
Eudora provides a different
way to filter e-mails. Instead of
the normal filter, using the 
e-mail address, Eudora allows
you to filter using nicknames.
In this way even if the e-mail
address of the person changes,
the mail will still be consid-
ered recognisable. Though, if
both nick and mail Id change,
it would bypass the filter. To
setup a filter go to Tools > Filter
> New. Specify the condition,
and action, and you’re done.

Vacation reply
With the help of Filter and Sta-
tionery, you can configure
Eudora to reply to all e-mails
that arrive within a specified
period. The filter acts a
dummy controller—you can
draft a personalised reply and
whenever an e-mail arrives,
during this vacation period,
the personalised draft is sent
as a reply to the sender.

E-mail traffic report
One of the useful features of
Eudora is the graphical analy-

sis of the amount of e-mails
being handled. It shows a
graphical chart for e-mails
arrived, e-mails sent and
Eudora usage. It shows the
report for the current day and
the previous day. Similarly, it
also shows a weekly, monthly
and yearly report.

Add-ins
Eudora has add-ins to facili-
tate and automate many fre-
quent tasks. These are easily
downloadable from the
Internet. Here are some of
the more popular ones.

Mail alert
This add-in runs as a stand-
alone program, using Eudo-
ra’s e-mail settings to poll the
e-mail server at regular inter-
vals. If it detects new e-mail

at the server, then it pops up
a window indicating the
arrival. It also provides ways
to read, reply and delete the
e-mails directly from the 
server. The MailAlert add-in
can be downloaded from
http://www.diamondridge.com/so
ftware/mailalert/index.htm.

Address book to HTML
You may want to publish your
address book on your Web site
for others to refer to. This add-
in helps to export Eudora’s
address book to HTML format.
It consists of an executable
program, which needs to

know the folder location of
the address book. In Windows
98 the default folder is C:\Win-
dows\Application Data\qual-
comm\eudora. The add-in
needs ‘NNdbase.txt’, which
contains the entire address
book of Eudora. On clicking
the convert button an html
file is created in the same fold-
er by the name NNdbase.htm.
The add-in itself provides a
way to view the converted
file. This add-in is available at
http://www.mindspring.com/~aeg
reene/eudora/.

Mail to HTML
Similar to the address to
HTML, is the Mail to HTML.
Let’s say you subscribe to a
mailing list and have an inter-
esting e-mail in your inbox,
which you would like to share
with others. You can upload
this to a Web site, Intranet or
Internet based, with just a few
mouse clicks. The add-in effec-
tively converts the entire
mailbox into HTML pages. It
generally finds the source fold-
er, and you have to specify the
destination folder where the

HTML files will reside after
conversion. Apart from this
you can even convert the
mails into normal text files.
The plug-in is available at
http://users.erols.com/tgitlin/

Synchronise two PCs
If you have two computers,
both running Eudora, with
seperate address books. You
can use this plug-in to syn-
chronise the address book
between both machines. It has
an interface window where
you have to select the address
file, NNdbase.txt, from first
computer and then the
address file from second com-
puter. A destination file that
consists of a compiled address
book from both machines is
created. The plug-in is avail-
able at http://eudora.interweb.be/
addins.html

Backup
BackDora, an add-in from
ajsystems.com, helps to back-
up Eudora e-mails and the
address book. It combines
important files into a com-
pressed zip file. The add-in is
available as a free download at
http://eudora.interweb.be/addins.
html. The add-in works as a

standalone application, but
uses Eudora’s settings. When
you run BackDora for the first
time, you will be requested to
select the profile to backup.

This add-in alerts you as soon as
there is an e-mail on the server

You can convert your address
book to HTML, in order to
upload to a Web page

Convert your e-mails to HTML
and upload to Web pages

You can backup your important
e-mails and your address book

MAY 2003



105

39

Setting up LDAP
Many companies provide
LDAP (Lightweight Directory
Access Protocol) servers for
tracking people’s contact
information. To configure an
LDAP server in Evolution go
to Tools > Settings, select the
‘Directory Servers’ tab and
click Add. You will see the
LDAP configuration assistant.
Click on Next and enter the
server name, for example
ldap.somecompany.com, and
select the login type. Click
Next, select the port number
to use—by default it is 389—
and enter the search options,
if any. Select a display name,
click Next and click on Finish.

vFolders
vFolders are virtual folders,
which can be used to receive
mail using specific search cri-
teria. This is quite similar to
filters except that vFolders do
not contain any e-mail—
what appears in the virtual
folders are just links to actual
e-mails contained in the
inbox. Deleting mails in
vFolders does not delete them
from the inbox.

To create a new virtual
folder, select Tools > Virtual
Folder Editor. Click Add and
specify the rule name, for
instance, Huge Mails. Select
the If criteria, for example,
file size, and the vFolder
sources, and click Ok.

Emptying trash 
It is tiresome to delete mails
from the inbox and then again
from the Trash. A better option
is to let Evolution delete the

trash, when you exit. To set this
option, click on Tools > Settings,
and select the Mail Preferences
tab. Under deleting mail, check
Empty trash folders on exit.

Importing contacts
from Outlook
Using Outlook, export all your
contacts to a .csv file. A perl
script csv2vcard.pl is provided
in Evolution to convert .csv
files to VCard (.vcf) files. Use
the command: csv2vcard. pl file-
name.csv filename.vcf and import
the .vcf file into Evolution
using File > Import. Select
‘Import a single file’ and click
Next, then select the file type
as Vcard and type in the file-
name. Click on the Import
button and select a folder, to
which the file will be import-
ed, and click Ok to finish.

Managing recent mail
If you get annoyed by the
huge e-mails lined up in your
mailbox and only want
recent mail, then Evolution
has the perfect solution for
you. You can set it to display
recent mails by going to
Search > Advanced. Type in a

rule name, such as daily mail
or recent mail, select Date
received under the If criteria.
Click on ‘Click here to select
a date’, and select Compare
against ‘A time relative to the

current time’. Adjust the
number of minutes, hours,
days, etc., according to your
preferences and click Ok.

Prevent image loading
In order to prevent images
from loading in Evolution, go
to Tools > Settings, click on the
Mail Preferences tab. Here,
select HTML Mail and click

on ‘Never load images off the
Net’, and click Apply/OK.

Creating a new e-mail
account
To create a new account, go to
Tools >Settings and select Mail
Accounts. Click Add, fill in
the details, and select the
server type—generally POP.
Give the name of the POP
server, such as pop.jasub-

EVOLUTION
Using Evolution just got simpler. Learn how to

use the add-ins and tips to your advantage

You can prevent images from
loading in Evolution

You can use Evolution settings
to set up an LDAP server

Use vFolders in Evolution to sort
e-mails virtually

Letting only recent mail into the
mailbox

You can Empty the trash folder on
exit to save time
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hai.com, and your username.
Make sure that the Authenti-
cation type is Password, and
then click Next. Set the e-mail
checking and message storage
options as per your personal
preferences. Select the server
type (generally SMTP), type in
the host name and your user-
name. Click Next. Type the
name of the account (by

default it will be your e-mail
ID). Click Next and then 
Finish to complete the
account creation.

Using colour
Quoted text can be highlight-
ed using various colours in
Evolution, unlike the tradi-
tional methods of indenting
quotations. Go to Tools >Set-
tings and click on Mail Prefer-
ences. In the General tab,
select ‘Highlight quotations

with color’ and select the 
preferred colour. 

Enable spell checking
Go to Tools > Settings, select

Composer Preferences and
click on the Spell Checking
tab. In the option section,
select ‘Check spelling while I
type’. Adjust the colour of mis-
spelled words and click Ok.

Adding folders to 
Summary
In Evolution, the Summary
page displays your most
important folders. By default
it displays the inbox of the
default account. But what 
if one of your accounts is
equally important and
deserves a place in the 
Summary?  You can add
another folder by going to
Tools > Settings. Click on 
‘Summary Preferences’ and
select the required folders.

Adding news feeds 
The Summary page displays
news feeds from many Web
sites using RDF (Resource
Description Format). To add
news feeds, go to Tools > Set-
tings, click on Summary Pref-
erences and then the News
Feeds tab. Select from the
given list of Web sites, and
click on Add. To add a Web
site of your own choice, other

than those provided in the
default list, click on the ‘Add
news feed’ button, give the
name and address of the Web
site and click on Ok. The Web
site will now appear in the list
of available news feeds.

Adding emoticons 
To add emoticons or smileys
to messages, start composing
a message and place the cur-
sor at the required line. Then
select Insert > Smileys and insert
the emoticon you want. In
case the emoticons don’t
show, go to Tools > Settings, 

click on Composer Preferences >
General, uncheck ‘Automati-
cally insert smiley images’
and click Ok.

Open folders in a new 
window
Sometimes it is much better to
open many folders in multiple

windows so that you are not
restricted to doing one thing at
a time. To do this in Evolution,
just right click on the folder in
the folder bar and select Open
in a new window. If the folder
bar is not visible, select View >
Folder Bar from the menu.

Default forward style
Forwarding e-mail is one of
the most frequent e-mail
activities. Forwarding mail
can be done in a number of
ways—inline, quoted, or as
attachments. In Evolution,
you can specify a default
method. Go to Tools > Settings
and click on Composer Prefer-

ences > General. In the Default
behavior section, select the
Forward Style as Attachment,
Inline or Quoted.

Composing HTML mail 
Writing an e-mail in plain text
can be monotonous, which is
why users may prefer using
HTML. Evolution provides
facilities for formatting text in
a variety of ways using HTML.
To enable this, go to Tools > Set-
tings and click on Composer
Preferences. Select the General
tab and check ‘Format mes-
sages in HTML’.

You can add news feeds of your
choice in Evolution

Highlight quoted text with your
choice of colours

Subscribe to news feeds using
Evolution

Set the forwarding and reply
styles in Evolution settings

Select the Automatically insert
smiley option to customise your
e-mails

Configure new accounts easily
using the Account: Assistant
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You’ve killed just about all the monsters
there are, got all the keys that you can col-
lect and are proceeding towards the exit
door. Suddenly you’re on fire! Confused

and alarmed, you look around. You can see
nothing but an unfamiliar monster standing
very far off . BLAM! Your health suddenly nose-

dives and what’s
more, all the mon-
sters you’ve killed
so far come back to
life. If you've ever
been through this,
you know exactly
why ArchVile sim-
ply had to be on
the top of this list.

1
This is one monster who’s more a nuisance than terror. The
first time you saw the headcrab in Half-Life, you probably
said, “How cute”. That was before it jumped into your face.
A few well-aimed bullets could dispose them quickly

enough, but there are two problems
with headcrabs—they’re every-
where, and there are lots of them.
After you’re past the first level, all
you can think of when approach-
ing a corner, is to switch to the
handgun and look into dark cor-
ners for these vile chunks of pain.

2

One of the fastest monsters in the game, the Fiend
was the last monster in the demo levels. Lying
motionless like a
bat, it springs up to

rip you apart. What we
liked most was the in
your face attack—you can
see it tearing you apart as
you pump lead into it.
Once its beaten, all you
do is keep away from it.

3

Monsters
Not all monsters are created equal. Some are more equal than others… but that, as you all know, is just a platitude.
What you may not know however, is that the best monsters are not necessarily the bosses that you come 
across at the end of a level. Some smaller demons bother you more than enough to make you remember 
them. Most memorable villains are the ones which simply irritate. Be it their sheer numbers, their plain attitude,
or maybe just their striking looks. We’ve covered those monsters that gave us nightmares.

10

Fiend (Quake II)

The alien from the movie spits acid, has no respect
for gravity and is very fast—if that doesn’t get it
listed on our Top Ten list, nothing will. In the AVP
series, the alien does look a bit human, but only if

it stays still for a long time. Most of your experiences
against it boil down to lonely tense moments, watching
for dots on your motion sensor. Beep! A dot appears on
your display and this is fol-
lowed by intense moments,
as you shoot the black blur
above you. If you’re lucky,
the blur dies after inflicting
you with a few wounds.
The wounds heal quickly;
the fear stays.

4
Alien (Aliens v/s Predator)

ArchVile (DDOOOOMM  22) Headcrab (Half-Life)
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“Look at you, Hacker. A pathetic creature of meat and
bone, panting and sweating as you run through my cor-
ridors. How can you challenge a perfect, immortal
machine?” Shodan was an AI construct that you create

in System Shock, made to oversee and manage a space station.
She suddenly becomes a maniac, killing everyone onboard and
converting some into cyborgs. While she never actually fights

with you, Shodan controls the cyborgs
and the whole spaceship, which you
explore. There’s always a lingering
sense of her watching your every move,
closing in on you through all her crea-
tures. What builds your paranoia is that
she actually has a personality—strong,
malicious and intelligent, she hates the
fact that her creator is human. 

7

This was debatably the most irri-
tating character in the Quake
series. It hides in the dark and
does some

c h a m e l e o n - l i k e
tongue flicking
action from 15 feet
away… And it does-
n’t die easy. The
next time you see
this beast, use the
rocket launcher or
the rail gun. At least
that’s what we did!

5
Hound (Quake II)

You’re doing your bit—exorcised the demons, used TNT
liberally, and basically creating hell. Suddenly you
notice this hand scampering towards you. Before you
have time to react, it jumps at you and grips your

throat. Suddenly your screen goes black as you choke in its
vice like grip. Fortunately, you
can shake the creature off by
repeatedly pressing the space-
bar, but by the time you’ve
managed to do that amidst all
the fighting, you’re dead!
Very, very irritating!

6
Hand (Blood)

One of the weirdest monsters in the Duke
Nukem world, these octopus-like aliens use their
psi energy to attack you. While they’re easy to
kill when far off, up

close and personal com-
bat requires you to dodge their
psi-attacks. Get hit by one of
these, and your screen blanks out
for a moment. And it gets worse
when they get their friends along.
As the story goes, these aliens
might also be responsible for all
the cocooned damsels. And that
makes Duke angry!

10
Octabrain (Duke Nukem 3D)

These are amongst the most fun monsters in the
entire FPS genre, and  hear them long before you
can see them. These headless
zombies apparently had a pro-

lific career as Al Qaeda suicide
bombers. With two bombs in their
hands, these monsters simply run
into you and then blow you up.
While they're easy to ward off, a
dozen of them coming straight at you
from all sides might be slightly more
than you can handle.

9
Beheaded Kamikaze (Serious Sam)

Shodan (System Shock) This has got to be the only monster whose
absence scares you! They move in groups, bite
your head off and eat it. To add to that, they
howl. A lot. In fact, you hear them long before

you even come across them.
They’re not too tough, but
they move fast and attack in
packs, often from different
directions and at the same
time. After your first
encounter, every howl will
make you look around franti-
cally-with the biggest gun
you've got.

8
Howler (Clive Baker’s Undying)



Driving over Miss Daisy…
You can unlock all the Free Ride modes
without having to complete the game. To
do this, first play Free Ride in City, Small
Mode. Go to the south-west of the Works
Quarter, to a small parking lot that is
unmarked on the map opposite the last
tram station. Enter the alley and keep an
eye out for buildings with red bricks. Here
you will see four boxes stacked. Look to
the east from these boxes, to spot a yellow
door. Near the door and an icon will
appear; right-click on it and the all modes
of the Free Ride menu are unlocked!

MAY 2003
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The City Of Lost HeavenThe City Of Lost Heaven

Bad Carma
You can ride a few hidden cars from the
beginning of the Free Ride mode. These are
unlocked when the game begins.

Lassiter V16 Roadster
You can find this green car at Works Quarter.
It is located at the corner of the two-storey
parking lot, next to a small alley (at the bot-
tom left of the map).

Bruno Speedster 851
Found in Central Island beside the Star Hotel.
Look for the ‘Ferrara’ banner; there will be a
small alley next to the main road with a trol-
ley. The car is on the left side of the road,
when coming from Giuliano Bridge or the
China Town tunnel.

Lassiter V16 Appolyon
From Corleone’s hotel main doors, turn left,
cross the road, then left again. On the right of
the road there is an alley, where the Appoly-
on awaits.

Bolt Truck
Drive towards the Racing Circuit and enter
the last street on the left. Follow the road and
look on the right for a factory building at
Works Quarter. The Bolt Truck is parked on 
a ramp.

If you do a sideways roll

while loading any gun, 

it —regardless of the

reload time—will be

loaded when you come

out of the roll. Paired

with the sawed-off 

shotgun, this tactic

makes a killer combo

To unlock the Free Ride Extreme, you
have to finish all missions. The Extreme
mode allows you to get extra fancy cars
(like the super fast taxi). Also, there are no
cops in this mode. You can use this cheat
to get the extra cars. Unlock all the Free
Ride modes by either doing it the right
way or by cheating as described above.
Then in Free Ride Extreme, go to the
extreme North East point of Oakwood.
There walk southwards to see a phone box
on the ride side of the road, adjacent to a
house with a blue door. Near the door and
an icon will appear, right-click here to
unlock some hidden cars!

Play the bad guy,

the good way
…in case you missed her
the first time
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Games are getting more realistic these
days, AI is more intelligent and graph-

ics better. A well-designed game should
never get too real. Good designers make
games that never get so complex, that it’s
no longer fun to play them. Unfortunate-
ly, Steel Beasts is not one of them.

This game is a tank simulator. Which
means you’ll be put into a tank and either
run over, or blow away anyone who gets
in your way. Driving around a 60-ton steel
box can be tank-loads of fun. However, to
actually get into a battle with one of these,
you’ll have to sit through approximately
40 tutorials—20 for each tank i.e., the 
US M1A1 Abrams and the German Leop-
ard 2A4. If that isn’t enough to kill off
your interest in the game, there’s more 

to come. 
Certain aspects of the graphics are pre-

historic—your tank will ‘skim’ over the
surface of a wide river, though at reduced
speed. Though, In all other respects this
simulator comes close to the real thing.  

You’ll actually begin to appreciate the

game’s complexity, when you drive the
tank and fire a few rounds. The  chain of
command and the weapon systems are
very realistic. Which translates into sever-
al keys and combinations to remember.

If you choose to be the gunner, all you
have to do is fire, but opting for the Tank
Commander’s role lands you with the
responsibility of planning your platoon’s
strategys—which involves formations and
combat tactics.

The objectives are equivalent to actual
battle situations, so if you’re looking to
grab hold of a big gun and blow the stuff-
ing out of your opponents, this is the last
game on earth you should play. However,
if you plan on buying a tank in the future,
this is the perfect tool to get some lessons!

Steel Beasts 
Too much realism

Genre: Strategy First ■■  Developer: eSim Games ■■  Distributor: e-Xpress Interactive Pvt Ltd ■■  Phone: 022-28870017 ■■  Web site: www.esimgames.com 
Price: Rs 499 ■■  System requirements: 266 MHz CPU, 32 MB RAM, 2 MB video card, 250 MB hard disk space, CD-ROM drive, Windows
9x\Me\2000, DirectX 7 ■■ Rating: ★★ ✩✩ ✩✩

GI Combat Episode 1: Battle of Normandy
War-weary

GI Combat is a real-time strategy tactical
war-game set in the Normandy land-

ings during World War II. The objective of
the game is to control squads of infantry
and armour, and defend or capture posi-
tions—depending on which side you
choose to be, German or Allied.

GIC feels like an extremely watered-
down version of the tactical RTS sub-genre.
You only have a few tens of units at your
disposal at any given time, most of whom
just wait to be obliterated by the enemy.

The graphics are a sorry sight, with
incredibly tiny square maps that all look
alike, and only so many trees and building

types to go around. The only difference
between maps is the surrounding environ-
ment—grassy plains or coastlines. The awk-

ward camera angles make it impossible to
view the bottom corner of the map. 

The turorial does not prepare you for
the game, and somehow, units never seem
to function properly. The German sharp-
shooter is the first to die, command units
run away, and the enemy seems to have
better aim and ability. The only saving
grace are mortar teams, which kill squads
from several hundred metres away, until
they run out of ammunition. You have to
huddle together and hope to put up a fight. 

The lack of an in-game save feature is
painful, and only hardcore fans of the RTS
genre might find this game appealing.

Genre: Strategy First ■■  Developer: Freedom Games Inc ■■  Distributor: e-Xpress Interactive Pvt Ltd ■■  Phone: 022-28870017 
Web site: www.gicombat.com ■■  Price: Rs 699 ■■  System requirements: 600 MHz CPU, 128 MB RAM, Windows 98\2000\XP, 4x CD-ROM drive, 
16 MB video card. Rating: ★★ ✩✩       ✩✩ ✩✩

WATCH THE PIXELS BURN: Looking down,
things look pretty hot

CREATE AND RIDE: Create a locale, lay your
tracks and ride through the greens

✩✩
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This series of books is designed as
courseware for the Microsoft Office

User Specialist certification program.
Both the Word and Excel books that we
reviewed are Level 1 beginner books, but
the series goes up to Level 3. With nearly
230 pages starting from absolute basic
concepts, usage and practical examples,
these books are designed to bring you 
up to speed with the rest of the Office-
literate world.   

The course is divided into seven chap-
ters, each based on a case study used to
illustrate the various commands and fea-
tures explained in that chapter. A chapter
introduces the example scenario, and the
tasks to be performed to achieve the goal.
Then it begins a series of Concept
Overviews followed by a hands-on to
practice usage of the concept. The con-
cepts are brief and clearly illustrated, with
screenshots where appropriate. Each 

concept only deals with
one small feature, mak-
ing it short and easy to
follow. The immediate
follow up with a step-by-
step illustrated hands-on
is very useful to rein-
force the new concept.

All chapters end
with a series of revision
sections. A simple mul-
tiple choice Concepts
Review helps you identi-
fy what you forgot. A series of Skill
Builders provide further practical exercise.
Introducing multiple small, manageable
chunks of new information followed 
up by immediate practical application 
is an effective technique for learning 
new concepts. 

There is a liberal sprinkling of Quick
Reference spots throughout the book that

help highlight special interface
features such as the Tab and
Indent markers on the ruler or
procedures such as changing
the page orientation. The over-
all impression is that of a well
thought out course presented
in an easily understood and
practical manner.

As a Level 1 book, the
authors are quite considerate of

the fact that new computer users
may not be very comfortable with using
menus and icons, and attempt to show
rather than tell everywhere possible. The
information presentation is in a refresh-
ingly visual, easy to understand style.

If you are looking at alternatives 
to signing up for a computer class to 
get started with Microsoft Office, put
Labyrinth's Briefcase series on your 
shopping checklist.

Publisher: Shroff Publishers and Distributors Pvt Ltd ■■     Author: Brian Favro and Russel Stolins ■■     Distributor: Computer Bookshop Pvt Ltd 
■■  Phone: 022-2317922/ 23/ 24 ■■  Fax: 022-2623551 ■■  E-mail: orders@cb-india.com ■■  Web site: www.cb-india.com ■■  Price: Rs 250 (each)
Rating: ★★★★ ✩✩

Labyrinth’s Briefcase Microsoft Word and Excel 2002
Briefcase education

Grand Prix 4 aims at putting you on the
F1 arena once again. Like its predeces-

sors, the game offers vivid array of cars and
original locales to race in. Good graphics
and sound make the whole package quite
interesting. Options, such as the standard
Quick race, Non-championship race and
Full championship, are included. But
what’s really worth checking out is the
Quick Laps option. This mode lets up to 22
drivers take each other on for the fastest
qualifying time. 

The graphics are sensational, with very
realistic effects—you can almost feel the
water drops hitting the screen, and the
debris that falls when the cars crash is also
very realistic. It also sports true racing
sounds—you can hear the mud churn
when you miss bends, and the water pelt-
ing against your screen.

The AI can be pretty dumb or really
cool at times. If you move outside the rac-
ing lines, the other cars just stay behind
you instead of seizing the opportunity to
overtake; At other times the cars will do
almost anything to block your path. You

can also opt for AI assists to drive your 
car, though with all assists on, it is 
actually an effort to try and crash your 
car. Although, racing junkies will find these
assists tiresome, newbies will probably 
welcome them.

The replays are awesome, with perfect
camera angles and placement. Watch cars
overtake opponents and whiz by you. Even
the pit crew are rendered in full 3D, and a
sight to see when they are in full flow. The
wheel controller does add to the realism,
though the one we tested with didn’t work
well with this game.

The game is buggy, and crashes with-
out rhyme or reason. It can be exasperat-
ing, especially if you are about to make
Montoya eat your dust, and end up staring
at the drab Windows desktop. Apart from
this, it is a super gaming experience. 

NOW IN 3D: The animated pit crew are 
a treat in action

Genre: Sports simulation ■■  Developer: Micro Prose  ■■  Distributor: Milestone Interactive Software Ltd ■■  Phone: 022-28381614 ■■  Website: www.
grandprixgames.com■■  Price: Rs 699 ■■  System Requirements: 400 MHz, 64MB RAM, 16MB DirectX 8.1compatible video Card ■■  Rating: ★★★★ ✩✩

Geoff Crammond's Grand Prix 4
Welcome to race day
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For the last sifting step of the Talent Hunt, the aspirants were invited to visit the Jasubhai Digital Media head office in Nerul, 
Navi Mumbai. They spent a few days soaking in the eclectic JDM culture, sampling our canteen food (and living to tell the tale!),

and not to forget, giving tests and interviews. After 72 hours of induction, we decided to export the final 16 to Synapse, our not-for-
profit organisation for further training.

...and then get right to work: 
The aspirants fill in forms about their personal details.

Round 2: A battle of wits is fought in the group discussions

Prashant Narekuli, brand manager of CRN briefs the new-

comers on the company Round 3: One on one interviews with the various team leaders

Round 1: Everyone stretches their 
fingers to give the written test

New Kids on the Block 

The group of the finalists arrive and grin a
while in our lobby...



121 MAY 2003

Chow time! All that talking must make you hungry. The interviewees

gooble up some nourishment  before rushing for another lecture

All out on the Table: A friendly game 

(but not for the loser!) of Table Tennis 

between the new team members 

and the old ones ensues in 

our game room

All the Kings Men: 72 hours, three levels oftests, multiple lectures...and still smiling

Oh how fast they Grow! Ready, 
packed and raring to go. Goa forth!

A walk around the park: Everyone is given a tour of the premises. 

Seen here at the TC

Vikram Malik 
Delhi

Kaustubh Chaudhuri 
Mumbai

Ram Mohan Rao 
Mumbai

Rahul Singh
Madhya Pradesh

Gunjan Trivedi 
Lucknow

Garfield D’Souza
Mumbai

Viraj Ambetkar
Mumbai

Niketu Shah
Mumbai

Bhaskar Banik
Mumbai

Kaizad Vajifdar
Mumbai

DKM Raju
Bhubaneshwar

Saurabh Kumar
Lucknow

Upendra Singhai
Mumbai

Neeraj Raje
Mumbai

Shiju Thomas
Trivandrum

Siddharth 
Lucknow

Those who
made it
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Highlight the lighter side of computing. Mail your contributions to: Backbyte Digit, Plot 
D-222/2, TTC Industrial Area, MIDC, Shirvane, Nerul, Navi Mumbai 400 706 or e-mail us at
backbyte@jasubhai.com

Your chance to
bite back!

Taurus
April 20 - May 20
With Pluto entering your sign, you will experience a change in
emotional ties with that battered old box you call a computer.
You will realise that just willing it to work just does not com-
pute anymore. It’s time to stop being bull-headed and pull the
plug, and upgrade...

IIff AAOOLL wwaass aa cciittyy...... 
1. You’d live in a place where no two

people had the same name. 
2. The commute to work is just a

double-click away, but every
time you try to leave your door-
step, the flow of traffic knocks
you back into your yard. 

3. The local post office would tell
your mother that you’re not a
known resident. 

4. If you saw a crime and called 100,
they’d reply a week later with a
form letter saying how you “really
are important to us.” 

5. Whenever you travelled to other
cities, people would see your
license tag and laugh at you,
behind your back. 

6. You’d have no idea who your neigh-
bours are. Most new arrivals would
move in at night, stuff everyone’s
mailbox with garbage, and vacate
before sun-up. 

7. The administration would build a
huge, state of the art park, and
allow the kids to play there free,
then suddenly start demanding
money.

What’s O. J. Simpson's Internet address? 

Slash, slash, backslash, slash, slash, escape

EEEEEKS!

Taken from IBM PCs & Clones by 
B Govindaraju, 1991 
Contributed by: Kumarjit Ray

Windows on line one

Hello, can I have
a miracle please?
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